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About This 
Course

The goal of this course is to teach you how to use the SolidWorks 

mechanical design automation software to build parametric models of 

parts and assemblies and how to make simple drawings of those parts 

and assemblies.

The SolidWorks software is such a robust and feature rich application 

that it is impractical to cover every minute detail and aspect of the 

software and still have the course be a reasonable length. Therefore, the 

focus of this course is on the fundamental skills and concepts central to 

the successful use of The SolidWorks software. You should view the 

training course manual as a supplement to, not a replacement for, the 

system documentation and on-line help. Once you have developed a 

good foundation in basic skills, you can refer to the on-line help for 

information on less frequently used command options.

Prerequisites Students attending this course are expected to have the following:

� Mechanical design experience.

� Experience with the Windows™ operating system.

� Completed the online tutorials that are integrated in the SolidWorks 

software. You can access the online tutorials by clicking Help, 

Online Tutorial.

Course Length The recommended minimum length of this course is 4 days.

Course Design 
Philosophy

This course is designed around a process- or task-based approach to 

training. A process-based training course emphasizes the processes and 

procedures you follow to complete a particular task. By utilizing case 

studies to illustrate these processes, you learn the necessary commands, 

options and menus in the context of completing a task.

Using this Book This training manual is intended to be used in a classroom environment 

under the guidance of an experienced SolidWorks instructor. It is not 

intended to be a self-paced tutorial. The examples and case studies are 

designed to be demonstrated “live” by the instructor.

Laboratory 
Exercises

Laboratory exercises give you the opportunity to apply and practice the 

material covered during the lecture/demonstration portion of the 

course. They are designed to represent typical design and modeling 

situations while being modest enough to be completed during class 

time. You should note that many students work at different paces. 

Therefore, we have included more lab exercises than you can 

reasonably expect to complete during the course. This ensures that even 

the fastest student will not run out of exercises.
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A Note About 
Dimensions

The drawings and dimensions given in the lab exercises are not intended 

to reflect any particular drafting standard. In fact, sometimes dimensions 

are given in a fashion that would never be considered acceptable in 

industry. The reason for this is the labs are designed to encourage you to 

apply the information covered in class and to employ and reinforce 

certain techniques in modeling. As a result, the drawings and dimensions 

in the exercises are done in a way that complements this objective.

About the 
Training Files 

A complete set of the various files used throughout this course can be 

downloaded from the SolidWorks website, www.solidworks.com. 

Click on the link for Support, then Training, then Training Files, then 

SolidWorks Training Files. Select the link for the desired file set. 

There may be more than one version of each file set available.

Direct URL: 

www.solidworks.com/trainingfilessolidworks

The files are supplied in signed, self-extracting executable packages. 

The files are organized by lesson number. The Case Study folder 
within each lesson contains the files your instructor uses while 

presenting the lessons. The Exercises folder contains any files that are 
required for doing the laboratory exercises.

Conventions Used 
in this Book

This manual uses the following typographic conventions:

Windows® XP The screen shots in this manual were made using the SolidWorks 

software running on Windows® XP. You may notice differences in the 

appearance of the menus and windows. These differences do not affect 

the performance of the software.

Convention Meaning

Bold Sans Serif SolidWorks commands and options appear in 

this style. For example, Insert, Boss means 

choose the Boss option from the Insert menu.

Typewriter Feature names and file names appear in this 

style. For example, Sketch1.

17 Do this step

Double lines precede and follow sections of 

the procedures. This provides separation 

between the steps of the procedure and large 

blocks of explanatory text. The steps 

themselves are numbered in sans serif bold.
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Use of Color The SolidWorks user interface makes extensive use of color to 

highlight selected geometry and to provide you with visual feedback. 

This greatly increases the intuitiveness and ease of use of the 

SolidWorks software. To take maximum advantage of this, the training 

manuals are printed in full color.

Also, in many cases, we have used 

additional color in the illustrations to 

communicate concepts, identify 

features, and otherwise convey 

important information. For example, 

we might show the result of a filleting 

operation with the fillets in a different 

color even though, by default, the 

SolidWorks software would not display the results in that way.

Graphics and 
Graphics Cards

 The SolidWorks software sets a new 

standard with best-in-class graphics. 

The combination of a highly 

reflective material and the realism of 

RealView Graphics is an effective 

tool for evaluating the quality of 

advanced part models and surfaces.

RealView Graphics is hardware 

(graphics card) support of advanced 

shading in real time. For example, if 

you rotate a part, it retains its 

rendered appearance throughout the 

rotation.

Color Schemes Out of the box, the SolidWorks software provides several predefined 

color schemes that control, among other things, the colors used for 

highlighted items, selected items, sketch relation symbols, and shaded 

previews of features.

We have not used the same color scheme for every case study and 

exercise because some colors are more visible and clear than others 

when used with different colored parts. 

In addition, we have changed the viewport background to plain white 

so that the illustrations reproduce better on white paper.

As a result, because the color settings on your computer may be 

different than the ones used by the authors of this book, the images you 

see on your screen may not exactly match those in the book.
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Lesson 1
SolidWorks Basics and the

User Interface

Upon successful completion of this lesson, you will be able to:

� Describe the key characteristics of a feature-based, parametric solid 

modeler.

� Distinguish between sketched and applied features.

� Identify the principal components of the SolidWorks user interface.

� Explain how different dimensioning methodologies convey 

different design intents.
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What is the 
SolidWorks 
Software?

SolidWorks mechanical design automation software is a feature-based, 

parametric solid modeling design tool which takes advantage of the 

easy to learn Windows™ graphical user interface. You can create fully 

associative 3-D solid models with or without constraints while 

utilizing automatic or user defined relations to capture design intent.

The italicized terms in the previous paragraph mean:

� Feature-based

Just as an assembly is made up of a number of individual piece parts, a 

SolidWorks model is also made up of individual constituent elements. 

These elements are called features.

When you create a model using the SolidWorks software, you work 

with intelligent, easy to understand geometric features such as bosses, 

cuts, holes, ribs, fillets, chamfers, and drafts. As the features are created 

they are applied directly to the work piece.

Features can be classified as either sketched or applied.

� Sketched Features: Based upon a 2-D sketch. Generally that sketch 

is transformed into a solid by extrusion, rotation, sweeping or 

lofting.

� Applied Features: Created directly on the solid model. Fillets and 

chamfers are examples of this type of feature.

The SolidWorks software graphically shows you the feature-based 

structure of your model in a special window called the 

FeatureManager® design tree. The FeatureManager design tree not only 

shows you the sequence in which the features were created, it gives you 

easy access to all the underlying associated information. You will learn 

more about the FeatureManager design tree throughout this course.

To illustrate the concept of feature-

based modeling, consider the part 

shown at the right:

This part can be visualized as a 

collection of several different 

features – some of which add 

material, like the cylindrical boss, 

and some which remove material, 

like the blind hole.
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If we were to map the individual features to their corresponding listing 

in the FeatureManager design tree, it would look like this:

� Parametric
The dimensions and relations used to create a feature are captured and 

stored in the model. This not only enables you to capture your design 

intent, it also enables you to quickly and easily make changes to the 

model.

� Driving Dimensions: These are the dimensions used when creating 

a feature. They include the dimensions associated with the sketch 

geometry, as well as those associated with the feature itself. A 

simple example of this would be a feature like a cylindrical boss. 

The diameter of the boss is controlled by the diameter of the 

sketched circle. The height of the boss is controlled by the depth to 

which that circle was extruded when the feature was made.

� Relations: These include such information as parallelism, tangency, 

and concentricity. Historically, this type of information has been 

communicated on drawings via feature control symbols. By 

capturing this in the sketch, SolidWorks enables you to fully 

capture your design intent up front, in the model.

� Solid Modeling

A solid model is the most complete type of geometric model used in 

CAD systems. It contains all the wire frame and surface geometry 

necessary to fully describe the edges and faces of the model. In addition 

to the geometric information, it has the information called topology that 

relates the geometry together. An example of topology would be which 

faces (surfaces) meet at which edge (curve). This intelligence makes 

operations such a filleting as easy as selecting an edge and specifying a 

radius.
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� Fully Associative

A SolidWorks model is fully associative to the drawings and 

assemblies that reference it. Changes to the model are automatically 

reflected in the associated drawings and assemblies. Likewise, you can 

make changes in the context of the drawing or assembly and know that 

those changes will be reflected back in the model.

� Constraints

Geometric relationships such as parallel, perpendicular, horizontal, 

vertical, concentric, and coincident are just some of the constraints 

supported in SolidWorks. In addition, equations can be used to 

establish mathematical relationships among parameters. By using 

constraints and equations, you can guarantee that design concepts such 

as through holes or equal radii are captured and maintained.

� Design Intent

Design intent is your plan as to how the model should behave when it is 

changed. For example, if you model a boss with a blind hole in it, the 

hole should move when the boss is moved. Likewise, if you model a 

circular hole pattern of six equally spaced holes, the angle between the 

holes should change automatically if you change the number of holes to 

eight. The techniques you use to create the model determine how and 

what type of design intent you capture.

Design Intent In order to use a parametric modeler like SolidWorks efficiently, you 

must consider the design intent before modeling. Design intent is your 

plan as to how the model should behave when it is changed. The way in 

which the model is created governs how it will be changed. Several 

factors contribute to how you capture design intent:

� Automatic (sketch) Relations

Based on how geometry is sketched, these relations can provide 

common geometric relationships between objects such as parallel, 

perpendicular, horizontal, and vertical.

� Equations

Used to relate dimensions algebraically, they provide an external way 

to force changes.

� Added Relations

Added to the model as it is created, relations provide another way to 

connect related geometry. Some common relations are concentric, 

tangent, coincident, and collinear.

� Dimensioning

The way in which a sketch is dimensioned will have an impact upon its 

design intent. Add dimensions in a way that reflects how you would 

like to change them.
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Examples of 
Design Intent

Some examples of different design intent in a sketch are shown below.

A sketch dimensioned like this will keep 

the holes 20mm from each end regardless 

of how the overall plate width, 100mm, 

is changed.

Baseline dimensions like this will keep 

the holes positioned relative to the left 

edge of the plate. The positions of the 

holes are not affected by changes in the 

overall width of the plate.

Dimensioning from the edge and from 

center to center will maintain the distance 

between the hole centers and allow it to 

be changed that way. 

How Features 
Affect Design 
Intent

Design intent is affected by more than just 

how a sketch is dimensioned. The choice of 

features and the modeling methodology are 

also important. For example, consider the 

case of a simple stepped shaft as shown at 

the right. There are several ways a part like 

this could be built.

The “Layer Cake” 
Approach

The layer cake approach builds the part one piece at a time, adding each 

layer, or feature, onto the previous one, like this:

Changing the thickness of one layer has a ripple effect, changing the 

position of all the other layers that were created after it.
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The “Potter’s 
Wheel” Approach

The potter’s wheel approach builds the part as 

a single, revolved feature. A single sketch 

representing the cross section includes all the 

information and dimensions necessary to make 

the part as one feature. While this approach 

may seem very efficient, having all the design 

information contained within a single feature 

limits flexibility and can make changes awkward.

The Manufacturing 
Approach

The manufacturing approach to modeling mimics the way the part 

would be manufactured. For example, if this stepped shaft was turned 

on a lathe, you would start with a piece of bar stock and remove 

material using a series of cuts.

File References SolidWorks creates files that are compound documents that contain 

elements from other files. File references are created by linking files 

rather than duplicating information in multiple files.

Referenced files do not have to be stored with the document that 

references them. In most practical applications, the referenced 

documents are stored in multiple locations on the computer or network. 

SolidWorks provides several tools to determine the references that exist 

and their location.

Object Linking and 
Embedding (OLE)

In the Windows environment, information sharing between files can be 

handled either by linking or embedding the information.

The main differences between linked objects and embedded objects are 

where the data is stored and how you update the data after you place it 

in the destination file.

Linked Objects When an object is linked, information is updated only if the source file 

is modified. Linked data is stored in the source file. The destination file 

stores only the location of the source file (an external reference), and it 

displays a representation of the linked data. 

Linking is also useful when you want to include information that is 

maintained independently, such as data collected by a different 

department.

Embedded Objects When you embed an object, information in the destination file doesn't 

change if you modify the source file. Embedded objects become part of 

the destination file and, once inserted, are no longer part of the source 

file.
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File Reference 
Example

The many different types of external references created by SolidWorks 

are shown in the following graphic. Some of the references can be 

linked or embedded. 
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Opening Files SolidWorks is a RAM-resident CAD system. Whenever a file is 

opened, it is copied from its storage location to the computer’s Random 

Access Memory or RAM. All changes to the file are made to the copy 

in RAM and only written back to the original files during a Save 

operation.

Computer Memory To better understand where files are stored and which copy of the file 

we are working on, it is important to differentiate between the two main 

types of computer memory.

Random Access 
Memory

Random Access Memory (RAM) is the volatile memory of the 

computer. This memory only stores information when the computer is 

operating. When the computer is turned off, any information in RAM is 

lost.

Fixed Memory Fixed memory is all the non-volatile memory. This includes the 

computer hard drive, floppy disks, zip disks and CDs. Fixed memory 

holds its information even when the computer is not running.

Save

Open

Fixed Disk
RAM
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The SolidWorks 
User Interface

The SolidWorks user interface is a native Windows interface, and as 

such behaves in the same manner as other Windows applications. Some 

of the more important aspects of the interface are identified below.

Unselectable Icons At times you will notice commands, icons, and menu options that are 

grayed out and unselectable. This is because you may not be working in 

the proper environment to access those options. For example, if you are 

working in a sketch (Edit Sketch mode), you have full access to all the 

sketch tools. However, you cannot select the icons such as fillet or 

chamfer on the Features toolbar. Likewise, when you are not working 

in a sketch, you can access these icons but the sketch tools are grayed 

out and unselectable. This design helps the inexperienced user by 

limiting the choices to only those that are appropriate, graying out the 

inappropriate ones.

To Pre-select or 
Not?

As a rule, the SolidWorks software does not require you to pre-select 

objects before opening a menu or dialog box. For example, if you want 

to add some fillets to the edges of your model, you have complete 

freedom – you can select the edges first and then click the Fillet tool or 

you can click the Fillet tool and then select the edges. The choice is 

yours.

Menu Bar

Graphics Area

Document Window

Reference Triad

Toolbars

FeatureManager

design tree

Status Bar

Task Pane

Heads-up View Toolbar

Menu Bar pull-downs
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Heads-up View 
Toolbar

The Heads-up View toolbar is a 

transparent toolbar that contains many 

common view manipulation commands. 

Many of the icons (such as the Hide/

Show Items icon shown) are Flyout Tool 

buttons that contain other options. These 

flyouts contain a small down arrow  to 

access the other commands.

Pull-down Menus The Pull-down menus provide access to many of the commands that 

the SolidWorks software offers. Float over the right facing arrow to 

access the menus. Click the pushpin to keep the menus open. 

When a menu item has a right-pointing arrow 

like this: , it means that there is a 

sub-menu associated with that choice.

When a menu item is followed by ellipses like 

this: , it means that the option 

opens a dialog box with additional choices or 

information.
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When the Customize Menu item is selected, 

each item appears with a check box. Clearing 

the check box removes the associated item 

from the menu.

Keyboard 
Shortcuts

Some menu items indicate a keyboard shortcut like this:  

SolidWorks conforms to standard Windows conventions for such 

shortcuts as Ctrl+O for File, Open; Ctrl+S for File, Save; Ctrl+Z for 

Edit, Undo and so on. In addition, you can customize SolidWorks by 

creating your own shortcuts.

Toolbars The toolbars provide icon shortcuts enabling you to quickly access the 

most frequently used commands. The toolbars are organized according 

to function and you can customize them, removing or rearranging the 

icons according to your preferences. The individual options on them 

will be covered in detail throughout this course.

Example of a 
Toolbar

An example of a toolbar, in this case the Standard 

toolbar, is shown at right. This toolbar contains 

commonly used functions.

Flyouts Many toolbars can be replaced with a single icon that contains all the 

toolbar icons. These flyout icons (Rectangle shown here)  have 

both an icon image and a pull-down to access other similar icons. The 

last used icon appears in the flyout. 
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Making Toolbars 
Visible

You can turn toolbars on or off using one of three methods:

� Click Tools, Customize. 

On the Toolbars page, click the check boxes to select each toolbar you 

want to display. Clear the check boxes of the toolbars you want to hide.

Note In order to access Tools, Customize, you must have a document open. 

Also the Commands tab can be used to add or remove icons from 

toolbars.
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� Right-click in the toolbar area of the 
SolidWorks window.
Pressed icons indicate which toolbars are 

currently visible. Click the toolbars you want to 

see.

� Click View, Toolbars.

This displays the same list of toolbars.

Work flow 
Customization

Toolbars can be turned on and off by industry 

using Work flow customization on the Options 

tab. Several industries are available.
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Arranging the 
Toolbars

The toolbars can be arranged in many ways. They can be docked 

around all four borders of the SolidWorks window or dragged onto the 

graphics or FeatureManager areas. These positions are “remembered” 

when you exit SolidWorks so the next time you start SolidWorks, the 

toolbars will be where you left them. One such arrangement, including 

the CommandManager, is shown below.

Quick Tips Quick Tips are part of the on-line 

help system. They ask “What would 

you like to do?” and provide typical 

answers based on the current task. 

Clicking an answer highlights the 

toolbar and icon required to 

perform that task.

Toolbars

Command
Manager

Toggle Quick Tips
On/Off
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FeatureManager 
Design Tree

The FeatureManager design tree is a unique part of the SolidWorks 

software that visually displays all the features in a part or assembly. As 

features are created they are added to the FeatureManager design tree. 

As a result, the FeatureManager design tree represents the 

chronological sequence of modeling operations. The FeatureManager 

design tree also allows access to the editing of the features (objects) 

that it contains.

Show and Hide 
FeatureManager 
Items

Many FeatureManager items (icons and folders) are hidden by default. 

In the image above, only two folders (Sensors and Annotations) are 
shown. 

Click Tools, Options, System Options, and FeatureManager to 

control their visibility using one of the three settings explained below. 

� Automatic - Hides the item when it is empty. 

� Hide - Hide the item at all times. 

� Show - Show the item at all times. 

FeatureManager Design Tree
PropertyManager

ConfigurationManager

Hide/
Show
FM

DimXpertManager
Hide/
Show
Display
Pane
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PropertyManager Many SolidWorks commands are executed through the 

PropertyManager. The PropertyManager occupies the same screen 

position as the FeatureManager design tree and replaces it when it is in 

use.

The top row of buttons contains the standard OK, Cancel and Preview 

buttons. 

Below the top row of buttons are one or more Group Boxes that 

contain related options. They can be opened (expanded) or closed 

(collapsed) and in many cases made active or inactive.

Group Box

Open and active

Group Box

Closed and inactive

Open and

Close icon

Cancel

Preview

OK
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The Command 
Manager

The Command Manager is a set of toolbars geared towards helping 

the novice user, working alone, to perform specific tasks. For example, 

the part version of the toolbar has several tabs to access commands 

related to Features, Sketches and so on.

It can be displayed with or without text on the buttons. 

Moving the 
PropertyManager 
and 
CommandManager

The CommandManager or PropertyManager can be dragged and 

docked on the top, side or outside of the SolidWorks window. Outside 

the SolidWorks window can be a different monitor. 

CommandManager

PropertyManager
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Task Pane The Task Pane window is used to house the SolidWorks Resources 

, Design Library , File Explorer , Search , View Palette 

, Appearances/Scenes  and Custom Properties  options. 

The window appears on the right by default but it can be moved and 

resized. It can be opened/closed, tacked or moved from its default 

position on the right side of the interface.
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Opening Labs with 
the Design Library

You can open parts and assemblies required 

for lab exercises using the design library. 

Add the class files to the design library 

using this procedure.

� Open the Task Pane and the Design 

Library.

� Click Add File Location .

� Select the Essentials folder used for 
the class files. It should be found under 

the SolidWorks Training Files folder.
� Click OK.

Double-click the icon of the part or assembly in the Design Library to 

open it.

SolidWorks 
Search

The SolidWorks Search option can be used to find files by searching 

for any part of the name. The Windows Desktop Search engine must be 

installed to use this feature. Search using this procedure.

� Type a name or partial name into the 

SolidWorks Search box and click the icon. 

� The Search tab  of the Task Pane is 

used to display the results. 

� Open a file by clicking on the image and 

clicking Open File in SolidWorks .

� Click on the pathname text to open a 

search of that folder.
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Mouse Buttons The left, right and middle mouse buttons have distinct meanings in 

SolidWorks.

� Left
Select objects such as geometry, menus buttons, and objects in the 

FeatureManager design tree.

� Right

Activates a context sensitive shortcut menu. The contents of the menu 

differ depending on what object the cursor is over. These menus also 

represent shortcuts to frequently used commands. 

Note At the top of the context sensitive shortcut menu is 

the Context Toolbar. It contains some of the most 

commonly used commands in icon form. 

Below it is the pull-down menu. It contains other 

commands that are available in the context of the 

selection. 

� Middle

Dynamically rotates, pans or zooms a part or assembly. Pans a drawing.

System Feedback Feedback is provided by a symbol attached to the 

cursor arrow indicating what you are selecting or 

what the system is expecting you to select. As the 

cursor floats across the model, feedback will come 

in the form of symbols, riding next to the cursor. 

The illustration at the right shows some of the 

symbols: vertex, edge, face and dimension. 

Vertex

Edge

Face

Dimension
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Options Located on the Tools menu, the Options dialog box enables you to 

customize the SolidWorks software to reflect such things as your 

company’s drafting standards as well as your individual preferences 

and work environment.
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Customization You have several levels of customization. They are:

� System options

The options grouped under the heading System Options are saved on 

your system and affect every document you open in your SolidWorks 

session. System settings allow you to control and customize your work 

environment. For example, you might like working with colored 

viewport background. I don’t. Since this is a system setting, parts or 

assemblies opened on your system would have a colored viewport. The 

same files opened on my system would not.

� Document properties

These settings are applied to the individual document. For example, 

units, drafting standards, and material properties (density) are all 

document settings. They are saved with the document and do not 

change, regardless of whose system the document is opened on.

For more information about the options settings that are used in this 

course, refer to Options Settings on page 482 in the Appendix.

� Document templates

Document templates are pre-defined documents that were set up with 

certain specific settings. For example, you might want two different 

templates for parts. One with English settings such as ANSI drafting 

standards and inch units, and one with metric settings such as 

millimeters units and ISO drafting standards. You can set up as many 

different document templates as you need. They can be organized into 

different folders for easy access when opening new documents. You 

can create document templates for parts, assemblies, and drawings.

For more detailed instructions on how to create document templates, 

refer to Document Templates on page 482 in the Appendix.

� Object

Many times the properties of an individual object can be changed or 

edited. For example, you can change the default display of a dimension 

to suppress one or both extension lines, or you can change the color of a 

feature.
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Lesson 2
Introduction to Sketching

Upon successful completion of this lesson, you will be able to:

� Create a new part.

� Insert a new sketch.

� Add sketch geometry.

� Establish sketch relations between pieces of geometry.

� Understand the state of the sketch.

� Extrude the sketch into a solid.
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2D Sketching This lesson introduces 2D sketching, the basis of modeling in 

SolidWorks.

Sketches are used for all sketched features in SolidWorks including:

� Extrusions � Revolves

� Sweeps � Lofts

The illustration below shows how a given sketch can form the basis of 

several different types of features.

In this lesson, only extruded features will be covered. The others will 

be covered in detail in later lessons or courses.

Stages in the 
Process

Every sketch has several characteristics that contribute to its shape, size 

and orientation.

� New part
New parts can be created in inch, millimeter or other units. Parts are 

used to create and hold the solid model.

� Sketches

Sketches are collections of 2D geometry that are used to create solid 

features.

� Sketch geometry

Types of 2D geometry such as lines, circles and rectangles that make up 

the sketch.

� Sketch relations

Geometric relationships such as horizontal and vertical are applied to 

the sketch geometry. The relations restrict the movement of the entities.

Extrude Revolve Sweep Loft
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� State of the sketch

Each sketch has a status that determines whether it is ready to be used 

or not. The state can be fully-, under- or over defined.

� Sketch tools

Tools can be used to modify the sketch geometry that has been created. 

This often involves the trimming or extending of the entities.

� Extruding the sketch

Extruding uses the 2D sketch to create a 3D solid feature.

Procedure The process in this lesson includes sketching and extrusions. To begin 

with, a new part file is created.

Introducing: 
New Part

The New tool creates a new SolidWorks document from a selection of 

part, assembly or drawing templates. There are several training 

templates in addition to the default ones. 

Where to Find It � From the File menu, select New.

� Or, on the Standard toolbar, click New .

1 New part.

Click New , or click File, New. Click the Part_MM template from 

the Training Templates tab on the New SolidWorks Document 

dialog box, and click OK.

The part is created with the settings of the template. One key setting is 

the part’s units. As the name implies, this part template uses 

millimeters as the units. You can create and save any number of 

different templates, all with different settings.



Lesson 2 SolidWorks 2011
Introduction to Sketching

30

Saving Files Saving files writes the file information in RAM to a location on a fixed 

disk. SolidWorks provides three options for saving files. Each has a 

different effect on file references.

Save Copy the file in RAM to the fixed disk, leaving the copy in RAM open. 

If this file is being referenced by any open SolidWorks files, there are 

no changes to the reference.

Where to Find It � Click File, Save....

� Click Save  on the Standard toolbar.

Save As Copy the file in RAM to the fixed disk under a new name or file type, 
replacing the file in RAM with the new file. The old file in RAM is 
closed without saving. If this file is being referenced by any open 
SolidWorks files, you should update the references to this new file.

Save As Copy Copy the file in RAM to the fixed disk under a new name or file type, 
leaving the copy in RAM open. If this file is being referenced by any 
open SolidWorks files, you should not update the references to this new 
file.

2 Filing a part.
Using the Save option from the File menu or selecting the Save button 

 on the Standard toolbar, file the part under the name Plate. The 
extension, *.sldprt, is added automatically. Click Save.
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What are We 
Going to 
Sketch?

The first feature of a part will be created in this section. That initial 
feature is just the first of many features needed to complete the part.

Sketching Sketching is the act of creating a 2-D profile comprised of wireframe 
geometry. Typical geometry types are lines, arcs, circles and ellipses. 
Sketching is dynamic, with feedback from the cursor to make it easier.

Default Planes To create a sketch, you must choose a plane on which to sketch. The 

system provides three initial planes by default. They are Front Plane, 
Top Plane, and Right Plane.

Introducing: 
Insert Sketch

When creating a new sketch, Insert Sketch opens the sketcher on the 

currently selected plane or planar face. You also use Insert Sketch to 

edit an existing sketch.

You must select a plane or a planar face of the model after clicking 

Insert, Sketch. The cursor  appears indicating that you should 

select a face or plane.

Where to Find It You can access the Insert Sketch command in several ways.

� On the Sketch toolbar click the  tool.

� Or, on the Insert menu, click Sketch.

� Or, with the cursor positioned over a planar face or plane of the 

model, click or right-click and choose Insert Sketch  from 

shortcut menu.
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3 Open a new sketch. 

Open the sketch by either 

clicking  or choosing 

Sketch from the Insert menu. 

This will show all three default 

planes for selection in a 

Trimetric orientation. A 
Trimetric orientation is a 
pictorial view that is oriented 

so the three mutually 

perpendicular planes appear 

unequally foreshortened.

From the screen, choose the Front Plane. The plane will highlight and 
rotate.

Note The Reference Triad (lower left corner) shows the orientation 

of the model coordinate axes (red-X, green-Y and blue-Z) at all 
times. It can help show how the view orientation has been 

changed relative to the Front Plane.

4 Sketch active.

The selected Front Plane 
rotates so it is parallel to the 

screen. This only happens 

for the first sketch in a part.

The  symbol represents 

the sketch origin. It is dis-

played in the color red, indi-

cating that it is active.

Introducing: 
Confirmation Corner

When many SolidWorks commands are active, a symbol or a set of 

symbols appears in the upper right corner of the graphics area. This 

area is called the Confirmation Corner.

Sketch Indicator When a sketch is active, or open, the Confirmation Corner 

(upper right of the graphics window) displays two symbols. 

One looks like a sketch. The other is a red X. These symbols 

provide a visual reminder that you are active in a sketch. 

Clicking the sketch symbol exits the sketch and saves any changes. 

Clicking the red X exits the sketch and discards any changes.

When other commands are active, the confirmation corner 

displays a check mark and an X. The check mark executes 

the current command. The X cancels the command.
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Sketch Entities SolidWorks offers a rich variety of sketch tools for creating profile 

geometry. In this lesson, only one of the most basic shapes will be used: 

Lines.

Sketch Geometry The following chart lists some of the sketch entities that are available 

on the Sketch toolbar.

Sketch Entity Toolbar Button Geometry Example

Line

Circle

Perimeter Circle

Centerpoint Arc

Tangent Arc

3 Point Arc

Ellipse

Partial Ellipse

Parabola

Spline

Straight Slot

Centerpoint 

Straight Slot

3 Point Arc Slot

Centerpoint Arc 

Slot
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Basic Sketching The best way to begin sketching is by using the most fundamental 

shape, the Line.

The Mechanics of 
Sketching

To sketch geometry, there are two techniques that can be used:

� Click-Click

Position the cursor where you want the line to start. Click (press 

and release) the left mouse button. Move the cursor to where you 

want the line to end. A preview of the sketch entity will follow the 

cursor like a rubber band. Click the left mouse button a second 

time. Additional clicks create a series of connected lines. 

� Click-Drag
Position the cursor where you want the line to start. Press and hold 

the left mouse button. Drag the cursor to where you want the sketch 

entity to end. A preview of the sketch entity will follow the cursor 

like a rubber band. Release the left mouse button.

Polygon

Corner Rectangle

Center Rectangle

3 Point Corner 

Rectangle

3 Point Center 

Rectangle

Parallelogram

Point

Centerline

Sketch Entity Toolbar Button Geometry Example
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Introducing: 
Insert Line

The Line tool creates single line segments in a sketch. Horizontal and 

vertical lines can be created while sketching by watching for the 

feedback symbols on the cursor. 

Where to Find It � From the Tools menu, select Sketch Entities, Line.

� Or, with the cursor in the graphics area, right-click and select Line 

from the shortcut menu.

� Or, on the Sketch toolbar, click Line .

Introducing: Sketch 
Relations

Sketch Relations are used to force a behavior on a sketch element 

thereby capturing design intent. They will be discussed in detail in 

Sketch Relations on page 42.

5 Sketch a line.

Click the Line tool  and sketch a horizontal 

line from the origin. The “ ” symbol appears 

at the cursor, indicating that a Horizontal relation is automatically 

added to the line. The number indicates the length of the line. Click 

again to end the line. 

Important! Do not be too concerned with making the line the exact length. 

SolidWorks software is dimension driven – the dimensions control the 

size of the geometry, not the other way around. Make the sketch 

approximately the right size and shape and then use dimensions to 

make it exact.

6 Line at angle.

Starting at the end of the first line, 

sketch a line at an angle.
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Inference Lines 
(Automatic 
Relations)

In addition to the “ ” and “ ” symbols, dashed inference lines will 

also appear to help you “line up” with existing geometry. These lines 

include existing line vectors, normals, horizontals, verticals, tangents 

and centers.

Note that some lines capture actual 

geometric relations, while others 

simply act as a guide or reference when 

sketching. A difference in the color of 

the inference lines will distinguish 

them. In the picture at the right, the 

lines labeled “A” are olive-green and if 

the sketch line snaps to them, will 

capture either a tangent or 

perpendicular relationship. The line 

labeled “B” is blue. It only provides a reference, in this case vertical, to 

the other endpoint. If the sketch line is ended at this point, no vertical 

relation will be captured.

Note The display of Sketch Relations that appear automatically can be 

toggled on and off using View, Sketch Relations. They will remain on 

during the initial phase of sketching.

7 Inference lines.

Create a line moving in a direction perpen-

dicular to the previous line. This causes 

inference lines to be displayed while 

sketching. A Perpendicular relation is 

created between this line and the last one.

The cursor symbol indicates that you are 

capturing a perpendicular relation. Note 

that the line cursor is not shown for clarity.

8 Perpendicular.

Another perpendicular line is created from 

the last endpoint. Again, a perpendicular 

relation is automatically captured.

A

B
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9 Reference.

Create a horizontal line from the last 

endpoint. Some inferences are strictly for 

reference and do not create relations. They 

are displayed in blue. This reference is 

used to align the endpoint vertically with 

the origin.

Sketch Feedback The sketcher has many feedback 

features. The cursor will change 

to show what type of entity is 

being created. It will also 

indicate what selections on the 

existing geometry, such as end, coincident (on) or midpoint, are 

available using a red dot when the cursor is on it. 

Three of the most common feedback symbols are:

10 Close.
Close the sketch with a final line connected 

to the starting point of the first line. 

Symbol Icon Description

Endpoint Yellow concentric 

circles appear at the 

Endpoint when the 

cursor is over it.

Midpoint The Midpoint appears 

as a square. It changes 

to red when the cursor 

is over the line.

Coincident (On 

Edge)

The quadrant points of 

the circle appear with a 

concentric circle over 

the centerpoint.
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Turning Off Tools Turn off the active tool using one of these techniques:

� Press the Esc key on the keyboard.

� Or, click the active tool (in this example Line ) a second time.

� Or, click the Select  tool.

� Or, right-click in the graphics area, and choose Select from the 

shortcut menu.

11 Turn off the tool.
Press the Esc key on the keyboard to turn off the line tool. 

Status of a Sketch Sketches can be in one of five definition states at any time. The status 

of a sketch depends on geometric relations between geometry and the 

dimensions that define it. The three most common states are:

Under Defined There is inadequate definition of the sketch, but the sketch can still be 

used to create features. This is good because many times in the early 

stages of the design process, there isn’t sufficient information to fully 

define the sketch. When more information becomes available, the 

remaining definition can be added at a later time. Under defined sketch 

geometry is blue (by default).

Fully Defined The sketch has complete information. Fully defined geometry is Black 

(by default). As a general rule, when a part is released to 

manufacturing, the sketches within it should be fully defined.

Over Defined The sketch has duplicate dimensions or conflicting relations and it 

should not be used until repaired. Extraneous dimensions and relations 

should be deleted. Over defined geometry is red (by default).

Note The two other states are No Solution Found and Invalid Solution 

Found. They both indicate that there are errors that must be repaired. 

For more information on repairs, see Lesson 8: Editing: Repairs. 
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Rules That 
Govern 
Sketches

Different types of sketches will yield different results. Several different 

types are summarized in the table below. It is important to note that 

some of the techniques shown in the table below are advanced 

techniques that are covered either later in this course, or in other 

advanced courses.

Sketch Type Description Special Considerations

A typical “standard” 

sketch that is a neatly 

closed contour.

None required.

Multiple nested 

contours creates a boss 

with an internal cut.

None required.

Open contour creates a 

thin feature with 

constant thickness.

None required. For more information, see 

Thin Features on page 254.

Corners are not neatly 

closed. They should be.

Use the Contour Select Tool. For more 

information, see Sketch Contours on 

page 319.

Although this sketch will work, it 

represents poor technique and sloppy 

work habits. Do not do it.

Sketch contains a self-

intersecting contour.

Use the Contour Select Tool. For more 

information, see Sketch Contours on 

page 319. If both contours are selected, 

this type of sketch will create a Multibody 

Solid. See Multibody Solids in the 

Advanced Part Modeling course.

Although this will work, multibodies are 

an advanced modeling technique that you 

should not use until you have more 

experience.

The sketch contains 

disjoint contours.

This type of sketch can create a Multibody 

Solid. See Multibody Solids in the 

Advanced Part Modeling course.

Although this will work, multibodies are 

an advanced modeling technique that you 

should not use until you have more 

experience.
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12 Current sketch status.

The sketch is Under Defined because 

some of the geometry is blue. Note that 

endpoints of a line can be a different color 

and different state than the line itself. For 

example, the vertical line at the origin is 

black because it is (a) vertical, and (b) 

attached to the origin. However, the 

uppermost endpoint is blue because the 

length of the line is under defined.

13 Dragging.

Under defined geometry (blue) can be 

dragged to new locations. Fully defined 

geometry cannot. Drag the uppermost 

endpoint to change the shape of the sketch. 

The dragged endpoint appears as a green 

dot.

14 Undo the change.

Undo the last command by clicking the 

Undo  option. You can see (and select from) a list of the last few 

commands by clicking the down arrow menu. The keyboard shortcut 

for Undo is Ctrl+Z.

Tip You can also Redo  a change, which reverts it back to the state 

prior to undo. The shortcut for redo is Ctrl+Y.

Design Intent The design intent, as discussed earlier, governs how the part is built and 

how it will change. In this example, the sketch shape must be allowed 

to change in these ways:
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What Controls 
Design Intent?

Design intent in a sketch is captured and controlled by a combination of 

two things:

� Sketch relations
Create geometric relationships such as parallel, collinear, 

perpendicular, or coincident between sketch elements.
� Dimensions

Dimensions are used to define the size and location of the sketch 

geometry. Linear, radial, diameter and angular dimensions can be 

added.

To fully define a sketch and capture the desired design intent requires 

understanding and applying a combination of relations and dimensions.

Desired Design 
Intent

In order for the sketch to change properly, the correct relations and 

dimensions are required. The required design intent is listed below:

Horizontal and vertical 

lines.

Angle value.

Parallel Distance value.

Right-angle corners, or 

perpendicular lines.

Overall length value.
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Sketch 
Relations

Sketch Relations are used to force a behavior on a sketch element 

thereby capturing design intent. Some are automatic, others can be 

added as needed. In this example, we will look at the relations on one 

of the lines and examine how they affect the design intent of the sketch.

Automatic Sketch 
Relations

Automatic relations are added as geometry is sketched. We saw this as 

we sketched the outline in the pervious steps. Sketch feedback tells you 

when automatic relations are being created.

Added Sketch 
Relations

For those relations that cannot be added automatically, tools exist to 

create relations based on selected geometry.

Introducing: Display 
Relations

Display Relations shows and optionally enables you to remove 

geometric relationships between sketch elements.

Where to Find It � Click the entity.

Symbols appear indicating what relations are 

associated with that entity. In this example, the arc has 

three relations: two tangent and one equal.

� The PropertyManager.

Select the sketch entity and the 

PropertyManager shows the relations associated 

with that entity.

� Click Display/Delete Relations  on the 

Dimensions/Relations toolbar.

The PropertyManager will show a list of all the 

relations in the sketch. 
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15 Display the relations 
associated with a line.
Click the uppermost angled line 

and the PropertyManager opens. 

The Existing Relations box in 

the PropertyManager also lists 

the geometric relations that are 

associated with the selected line.

Tip The relations are visible because View, Sketch Relations is turned on. 

If it is turned off, double-clicking the geometry will show the relations 

and open the PropertyManager.

16 Remove the relation.

Remove the uppermost relation by clicking 

the relation, either the symbol or in the 

PropertyManager, and pressing the Delete 

key. If the symbol is selected, it changes color 

and displays the entitie(s) it controls.

17 Drag the endpoint.

Because the line is no longer constrained to be 

perpendicular, the sketch will behave 

differently when you drag it. Compare this to 

how the sketch behaved when you dragged it 

in step 13.
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Examples of 
Sketch Relations

There are many types of Sketch Relations. Which ones are valid 

depends on the combination of geometry that you select. Selections can 

be the entity itself, endpoints or a combination. Depending on the 

selection, a limited set of options is made available. The following 

chart shows some examples of sketch relations. This is not a complete 

list of all geometric relations. Additional examples will be introduced 

throughout this course.

Relation Before After

Coincident between 

a line and an 

endpoint.

Merge between two 

endpoints.

Parallel between 

two or more lines.

Perpendicular 

between two lines.
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Collinear between 

two or more lines.

Horizontal applied 

to one or more lines.

Horizontal between 

two or more 

endpoints.

Vertical applied to 

one or more lines.

Vertical between 

two or more 

endpoints.

Relation Before After
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Introducing: Add 
Relations

Add Relations is used to create a geometric relationship such as 

parallel or collinear between sketch elements.

Where to Find It � Select the sketch entity or entities, and select 

the appropriate relation from the Add 

Relations section of the PropertyManager.

� Or, right-click the entity or entities, and select 

Add Relation from the shortcut menu.

� Or, click Tools, Relations, Add. 

� Or, on the Sketch toolbar, click Add Relation .

Selecting Multiple 
Objects

As you learned in Lesson 1, you select objects with the left mouse 

button. What about when you need to select more than one object at a 

time? When selecting multiple objects, SolidWorks follows standard 

Microsoft® Windows conventions: Ctrl-select. Hold down the Ctrl key 

while selecting the objects.

Equal between two 

or more lines.

Equal between two 

or more arcs or 

circles.

Midpoint between a 

line and an endpoint.

Relation Before After
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18 Add a relation.

Hold down Ctrl and select the two lines. The 

PropertyManager shows only those relations that 

are valid for the geometry selected.

Click Perpendicular, and click OK or click in a 

blank area of the graphics window. 

19 Drag the sketch.

Drag the sketch back into approximately its 

original shape.
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Dimensions Dimensions are another way to define geometry and capture design 

intent in the SolidWorks system. The advantage of using a dimension is 

that it is used to both display the current value and change it.

Introducing:
Smart Dimensions

The Smart Dimension tool determines the proper type of dimension 

based on the geometry chosen, previewing the dimension before 

creating it. For example, if you pick an arc the system will create a 

radial dimension. If you pick a circle, you will get a diameter 

dimension, while selecting two parallel lines will create a linear 

dimension between them. In cases where the Smart Dimension tool 

isn’t quite smart enough, you have the option of selecting endpoints 

and moving the dimension to different measurement positions.

Where to Find It � From the Tools menu, select Dimensions, Smart.

� Or, right-click off the geometry and select Smart Dimension from 

the shortcut menu.

� Or, on the Dimensions/Relations toolbar, pick the Smart 

Dimension  tool.

Dimensioning: 
Selection and 
Preview

As you select sketch geometry with the dimension tool, the system 

creates a preview of the dimension. The preview enables you to see all 

the possible options by simply moving the mouse after making the 

selections. Clicking the left mouse button places the dimension in its 

current position and orientation. Clicking the right mouse button  

locks only the orientation, allowing you to move the text before final 

placement by clicking the left mouse button.

With the dimension tool and two endpoints selected, below are three 

possible orientations for a linear dimension. The value is derived from 

the initial point to point distance and may change based on the 

orientation selected.

Endpoints
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Sketching with On 
Screen Numeric 
Input

An option to sketch and create dimensions at the same time is on screen 

numeric input. It requires these steps:

1. Click Tools, Options, System Options, Sketch, Enable on 

screen numeric input on entity creation. 

2. Add dimensions on the PropertyManager of the selected sketch 

tool.

3. Use the sketch tool and type in values as they highlight. 

Tip At this early stage, it is inadvisable to use this option because it can 

inadvertently create an overdefined sketch (see Status of a Sketch on 

page 38). 

20 Adding a linear dimension.

Choose the dimension tool from any 

source and click the line shown. 

Click a second time to place the text 

of the dimension above and to the 

right of the line. The dimension 

appears with a Modify tool 

displaying the current length of the 

line. The thumbwheel is used to 

incrementally increase/decrease the 

value using the middle mouse 

button. Or with the text highlighted, 

you can type a new value to change it directly.

The Modify Tool The modify tool that appears when you create or 

edit a dimension (parameter) has several options. 

The options available to you are:

 Dial the value up or down by a preset amount.

 Save the current value and exit the dialog box.

 Restore the original value and exit the dialog box.

 Rebuild the model with the current value.

 Reverse the sense of the dimension.

 Change the thumbwheel increment value.

 Mark the dimension for drawing import.
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21 Set the value. 

Change the value to 20 and click the 

Save  option. The dimension forces 

the length of the line to be 20mm.

Tip Pressing Enter has the same effect as clicking the Save  button.

22 Linear dimensions.

Add additional linear dimensions 

to the sketch as shown.

Dimensioning Tip When you dimension a sketch, 

start with the smallest dimension 

first, and work your way to the 

largest. 
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Angular 
Dimensions

Angular dimensions can be created using the same dimension tool used 

to create linear, diameter and radial dimensions. Select either two lines 

that are both non-collinear and non-parallel, or select three non-

collinear endpoints.

Depending on where you place the angular dimension, you can get the 

interior or exterior angle, the acute angle, or the oblique angle. Possible 

placement options:

23 Angular dimension.
Using the dimension tool, create 

the angular dimension shown 

and set the value to 125°.

The sketch is fully defined.
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Extrude Once the sketch is completed, it can be extruded to create the first 
feature. There are many options for extruding a sketch including the 
start and end conditions, draft and depth of extrusion, which will be 
discussed in more detail in later lessons. Typically, extrusions take 
place in a direction normal to the sketch plane, in this case the Front 
plane.

Where to Find It � From the menu: Insert, Boss/Base, Extrude....

� Or, on the Features toolbar, choose: .

24 Extrude menu. 

Click Insert, Boss/Base, 

Extrude or the  tool on the 
Features toolbar to access the 
command.

On the Insert menu, the 
options for other methods of 
creating features are listed 
along with Extrude and 
Revolve. They are unavailable 
because this sketch does not 
meet the conditions necessary 
for creating these types of 
features. For example, a Sweep feature requires both profile and path 
sketches. Since there is only one sketch at this time, the Sweep option 
is unavailable.

The view orientation automatically changes to Trimetric and a 
preview of the feature is shown at the default depth. 

Drag Handles and 
Rulers

Handles  appear that can be 

used to drag the preview to the 

desired depth. The handles are 

colored for the active direction 

and gray for inactive direction. 

A callout shows the current 

depth value and a Ruler is 

displayed to guide the drag. 

Moving closer to the ruler 

gradients allows you to snap to 

them. 

Tip Color settings in SolidWorks can be modified using Tools, Options.
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25 Extrude Feature settings.

Change the settings as shown.

� End Condition = Blind

�  (Depth) = 6mm 

Click OK  to create the feature.

Tip The OK button  is just one way to accept and 

complete the process. A second is to press the 

Enter key. 

A third method is the set of OK/Cancel buttons in the 

Confirmation Corner of the graphics area.

A fourth method is to right-click and select OK from 

the shortcut menu.

26 Completed feature.

The completed feature is the first 

solid, or feature of the part. The 

sketch is absorbed into the 

Extrude1 feature.

Note Click the  preceding the feature name to expand the 

feature, showing the absorbed feature, the sketch. 

27 Save and close.

Click Save  to save your work and click File, Close to close the 

part.
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Exercise 1:
Sketch and 
Extrude 1 

Create this part using the information and 

dimensions provided. Sketch and extrude 

profiles to create this part. 

This lab reinforces the following skills:

� Introducing: New Part on page 29.

� Sketching on page 31.

� Inference Lines (Automatic 

Relations) on page 36.

� Dimensions on page 48.

� Extrude on page 52.

Units: millimeters 

1 New part. 

Open a new part using the Part_MM template.

2 Sketch. 

Create this sketch on the Front Plane using lines, automatic relations 

and dimensions. 

3 Extrude. 

Extrude the sketch 50mm in 

depth. 

4 Save and close the part. 
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Exercise 2:
Sketch and 
Extrude 2 

Create this part using the information and 

dimensions provided. Sketch and extrude 

profiles to create this part. 

This lab reinforces the following skills:

� Introducing: New Part on page 29.

� Sketching on page 31.

� Inference Lines (Automatic 

Relations) on page 36.

� Dimensions on page 48.

� Extrude on page 52.

Units: millimeters 

1 New part. 

Open a new part using the Part_MM template.

2 Sketch. 

Create this sketch on the Front Plane using lines, automatic relations 

and dimensions. 

3 Extrude. 

Extrude the sketch 50mm in 

depth. 

4 Save and close the part. 
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Exercise 3:
Sketch and 
Extrude 3

Create this part using the information 

and dimensions provided. Sketch and 

extrude profiles to create this part. 

This lab reinforces the following skills:

� Introducing: New Part on page 29.

� Sketching on page 31.

� Inference Lines (Automatic 

Relations) on page 36.

� Dimensions on page 48.

� Extrude on page 52.

Units: millimeters 

1 New part. 

Open a new part using the Part_MM template.

2 Sketch. 

Create this sketch on the Front Plane using lines, automatic relations 

and dimensions. 

3 Extrude. 

Extrude the sketch 25mm in depth. 

4 Save and close the part. 
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Exercise 4:
Sketch and 
Extrude 4

Create this part using the information 

and dimensions provided. Sketch and 

extrude profiles to create this part. 

This lab reinforces the following skills:

� Introducing: New Part on page 29.

� Sketching on page 31.

� Inference Lines (Automatic 

Relations) on page 36.

� Dimensions on page 48.

� Extrude on page 52.

Units: millimeters 

1 New part. 

Open a new part using the Part_MM template.

2 Sketch. 

Create this sketch on the Front Plane 
using lines, automatic relations and 

dimensions. 

3 Extrude. 

Extrude the sketch 100mm in depth. 

4 Save and close the part. 
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Exercise 5:
Sketch and 
Extrude 5

Create this part using the information and 

dimensions provided. Sketch and extrude 

profiles to create the part.

This lab reinforces the following skills:

� Introducing: New Part on page 29.

� Sketching on page 31.

� Inference Lines (Automatic Relations) on 

page 36.

� Dimensions on page 48.

� Extrude on page 52.

Units: millimeters

1 New part.

Open a new part using the Part_MM template.

2 Sketch.

Create this sketch on the 

Front Plane using lines, 
automatic relations and 

dimensions.

Fully define the sketch.

3 Extrude.

Extrude the sketch 25mm in 

depth.

4 Save and close the part.
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Exercise 6:
Sketch and 
Extrude 6

Create this part using the information and 

dimensions provided. Sketch and extrude 

profiles to create the part.

This lab reinforces the following skills:

� Introducing: New Part on page 29.

� Sketching on page 31.

� Inference Lines (Automatic Relations) 

on page 36.

� Dimensions on page 48.

� Extrude on page 52.

Units: millimeters

1 New part.

Open a new part using the Part_MM template.

2 Automatic relations.

Create this sketch on the Front Plane using lines and automatic 

relations. Show the Perpendicular and Vertical relations.

3 Dimensions.

Add dimensions to fully define 

the sketch.

4 Extrude.

Extrude the sketch 12mm.

5 Save and close the part.
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Lesson 3
Basic Part Modeling

Upon successful completion of this lesson, you will be able to:

� Choose the best profile for sketching.

� Choose the proper sketch plane.

� Extrude a sketch as a cut.

� Create Hole Wizard holes.

� Insert fillets on a solid.

� Use the editing tools edit sketch, edit feature and rollback. 

� Make a basic drawing of a part.

� Make a change to a dimension.

� Demonstrate the associativity between the model and its drawings.
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Basic Modeling This lesson discusses the 

considerations that you make 

before creating a part, and shows 

the process of creating a simple 

one.

Stages in the 
Process

The steps in planning and executing the creation of this part are listed 

below.

� Terminology
What are the terms commonly used when talking about modeling and 

using the SolidWorks software?

� Profile choice

Which profile is the best one to choose when starting the modeling 

process?

� Sketch plane choice

Once you’ve chosen the best profile, how does this affect your choice 

of sketch plane?

� Design intent

What is design intent and how does it affect the modeling process?

� New part

Opening the new part is the first step.

� First feature

What is the first feature?

� Bosses, cuts and hole features

How do you modify the first feature by adding bosses, cuts and holes?

� Fillets

Rounding off the sharp corners – filleting.

� Editing tools

Use three of the most common editing tools. 

� Drawings

Creating a drawing sheet and drawing views of the model.

� Dimension changes

Making a change to a dimension changes the model’s geometry. How 

does this happen?
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Terminology Moving to 3D requires some new terminology. The SolidWorks 

software employs many terms that you will become familiar with 

through using the product. Many are terms that you will recognize from 

design and manufacturing such as cuts and bosses.

Feature All cuts, bosses, planes and sketches that you create are considered 

Features. Sketched features are those based on sketches (boss and cut), 

and applied features are based on edges or faces (fillet).

Plane Planes are flat and infinite. They are represented on the screen with 

visible edges. They are used as the primary sketch surface for creating 

boss and cut features.

Extrusion Although there are many ways 

to create features and shape the 

solid, for this lesson, only 

extrusions will be discussed. 

An extrusion will extend a 

profile along a path typically 

normal to the profile plane for 

some distance. The movement 

along that path becomes the solid model. 

Sketch In the SolidWorks system, the name used to describe 

a 2D profile is sketch. Sketches are created on flat 

faces and planes within the model. They are generally 

used as the basis for bosses and cuts, although they 

can exist independently.

Boss Bosses are used to add material to the model. The critical initial feature 

is always a boss. After the first feature, you may add as many bosses as 

needed to complete the design. As with the base, all bosses begin with a 

sketch.

Cut A Cut is used to remove material from the model. This is the opposite 

of the boss. Like the boss, cuts begin as 2D sketches and remove 

material by extrusion, revolution, or other methods you will learn 

about.

Fillets and Rounds Fillets and rounds are generally added to the solid, not the sketch. By 

nature of the faces adjacent to the selected edge, the system knows 

whether to create a round (removing material) or a fillet (adding 

material).

Design Intent How the model should be created and changed, is considered the design 

intent. Relationships between features and the sequence of their 

creation all contribute to design intent.
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Choosing the 
Best Profile

Choose the “best” profile. This profile, when extruded, will generate 

more of the model than any other. Look at these models as examples. 

Part Best Profile Extruded
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Choosing the 
Sketch Plane

Once the best profile is determined, the next step is to decide which 

view to use and select the plane with the same name for sketching it. 

The SolidWorks software provides three planes; they are described 

below.

Planes There are three default planes, labeled Front Plane, Top Plane and 
Right Plane. Each plane is infinite, but has screen borders for viewing 
and selection. Also, each plane passes through the origin and is 

mutually perpendicular to the others.

The planes can be renamed. In this course the names Front Plane, Top 
Plane and Right Plane replace the default names respectively. This 

naming convention is used in other CAD systems and is comfortable to 

many users.

Although the planes 

are infinite, it may be 

easier to think of them 

as forming an open 

box, connecting at the 

origin. Using this 

analogy, the inner 

faces of the box are the 

potential sketch 

planes.

Placement of the 
Model

The part will be placed into the box three times. Each time the best 

profile will contact or be parallel to one of the three planes. Although 

there are many combinations, the choices are limited to three for this 

exercise.

There are several things to consider when choosing the sketch plane. 

Two are appearance and the part's orientation in an assembly. The 

appearance dictates how the part will be oriented in standard views 

such as the Isometric. This also determines how you will spend most 

of your time looking at the model as you create it.

The part's orientation in an assembly dictates how it is to be positioned 

with respect to other, mating parts.

Orient the Model for 
the Drawing

Another consideration when deciding which sketch plane to use is how 

you want the model to appear on the drawing when you detail it. You 

should build the model so that the Front view is the same as the Front 

view will be in the final drawing. This saves time during the detailing 

process because you can use predefined views.
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In the first example, the best 

profile is in contact with the Top 
plane.

In the second example, it is 

contacting the Front plane.

The last example shows the best 

profile in contact with the Right 
plane.

Chosen Plane The Top plane orientation seems 

to be the best. This indicates that 

the best profile should be 

sketched on the Top plane of the 
model.

How it Looks on the 
Drawing

By giving careful thought to 

which plane is used to 

sketch the profile, the 

proper views are easily 

generated on the detail 

drawing.

Right Plane Front Plane

Top Plane

Right Plane Front Plane

Top Plane

Right Plane Front Plane

Top Plane
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Details of the 
Part

The part we will be creating is shown below. There are two main boss 

features, some cuts, and fillets.

Standard Views The part is shown here in four standard views.

Main Bosses The two main bosses have 

distinct profiles in different 

planes. They are connected as 

shown in the exploded view at 

right.
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Best Profile The first feature of the model 

is created from the rectangular 

sketch shown overlaid on the 

model. This is the best profile 

to begin the model. 

The rectangle will then be 

extruded as a boss to create the 

solid feature.

Sketch Plane Placing the model “in the box” determines which plane should be used 

to sketch on. In this case it will be the Top plane. 

Design Intent The design intent of this part describes how the part’s relationships 

should or should not be created. As changes to the model are made, the 

model will behave as intended.

� All holes are through holes.

� Holes in base are symmetrical.

� Slot is aligned with tab.

Sketch Plane
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Procedure The modeling process includes sketching and creating bosses, cuts and 

fillets. To begin with, a new part file is created.

1 New part.

Click New , or click File, New. Create a new part using the 

Part_MM template and Save it as Basic.

2 Annotations setting.

Right-click the Annotations folder and clear the Automatically 

Place into Annotation Views option. This will prevent dimensions 

from being inserted with drawing views later in the lesson. 

3 Select the sketch plane.

Insert a new sketch and choose 

the Top Plane.

Tip A plane doesn’t have to be shown in order to be used; it can be selected 

from the FeatureManager.

Sketching the First 
Feature

Create the first feature by extruding a sketch into a boss. The first 

feature is always a boss, and it is the first solid feature created in any 

part. Begin with the sketch geometry, a rectangle.

Introducing: 
Corner Rectangle

Corner Rectangle is used to create a rectangle in a sketch. The 

rectangle is comprised of four lines (two horizontal and two vertical) 

connected at the corners. It is sketched by indicating the locations of 

two diagonal corners. There are several other rectangle/parallelogram 

tools available:

� Center Rectangle  - Uses a center point and corner to create a 

rectangle with horizontal and vertical lines. 

� 3 Point Center Rectangle  - Creates a rectangle based on a 

center point, midpoint of edge and corner. Lines are perpendicular 

at corners. 

� 3 Point Corner Rectangle  - Uses three corners to define a 

rectangle. Lines are perpendicular at corners. 

� Parallelogram  - Uses three corners to define a parallelogram 

(corners are not perpendicular). 

Where to Find It � On the Sketch toolbar, click Corner Rectangle .

� Or, on the Tools menu, select Sketch Entities, Corner Rectangle.
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4 Sketch a rectangle.

Click the Corner Rectangle tool 

 and begin the rectangle at the 

origin.

Make sure the rectangle is locked to the origin by looking for the 

vertex cursor as you begin sketching. Do not worry about the size 

of the rectangle. Dimensioning it will take care of that in the next 

step.

5 Fully defined sketch.

Add dimensions to the sketch. 

The sketch is fully defined.

Extrude Options An explanation of some of the more frequently used Extrude options is 

given below. Other options will be discussed in later lessons.

� End Condition Type

A sketch can be extruded in one or two directions. Either or both 

directions can terminate at some blind depth, up to some geometry in 

the model, or extend through the whole model.

� Depth
The distance for a blind or mid-plane extrusion. For mid-plane, it refers 

to the total depth of the extrusion. That would mean that a depth of 

50mm for a mid-plane extrusion would result in 25mm on each side of 

the sketch plane.

� Draft
Applies draft to the extrusion. Draft on the extrusion can be inwards 

(the profile gets smaller as it extrudes) or outward.

6 Extrude.

Click Extrude  

and extrude the 

rectangle 10mm 

upwards. 

Click OK. 
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The completed feature is shown 

at the right.

Renaming 
Features

Any feature that appears in the FeatureManager design tree (aside from 

the part itself) can be renamed using the procedure below. Renaming 

features is a useful technique for finding and editing features in later 

stages of the model. Well chosen, logical names help you to organize 

your work and make it easier when someone else has to edit or modify 

your model.

7 Rename the feature.

It is good practice to rename the features that you create with some 

meaningful name. In the FeatureManager design tree, use a very slow 

double-click to edit the feature Extrude1. When the name is 

highlighted and editable, type BasePlate as the new feature name. All 

features in the SolidWorks system can be edited in the same way.

Tip Instead of using a slow double-click to edit the name, you can select the 

name and press F2.

Boss Feature The next feature will be the boss 

with a curved top. The sketch 

plane for this feature is not an 

existing plane, but a planar face of 

the model. The required sketch 

geometry is shown overlaid on the 

finished model. 

Tip Cut features are created in the same way as bosses – with a sketch and 

extrusion. They remove material rather than add it.
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Sketching on a 
Planar Face

Any planar (flat) face of the model can be used as a sketch plane. 

Simply select the face and choose the Sketch tool. Where faces are 

difficult to select because they are on the rear of the model or are 

obscured by other faces, the Select Other tool can be used to choose a 

face without reorienting the view. In this case, the planar face on the 

front of the BasePlate is used.

8 Insert new sketch.

Create a new sketch using 

Insert, Sketch or by clicking 

the Sketch tool . Select the 

indicated face. 

Note Make sure that Instant 3D  (Features toolbar) is turned off. Leaving 

it on will cause several handles and axes that we are not currently using 

to appear on the face. 

Sketching SolidWorks offers a rich variety of sketch tools for creating profile 

geometry. In this example, Tangent Arc is used to create an arc that 

begins tangent to a selected endpoint on the sketch. Its other endpoint 

can be placed in space or on another sketch entity.

Introducing: 
Insert Tangent Arc

Insert Tangent Arc is used to create tangent arcs in a sketch. The arc 

must be tangent to some other entity, line or arc, at its start.

Where to Find It � From the Tools menu, select Sketch Entities, Tangent Arc.

� Or, with the cursor in the graphics window, right-click and select 

Tangent Arc.

� Or, on the Sketch toolbar click Tangent Arc .

Tangent Arc Intent 
Zones

When you sketch a tangent arc, the 

SolidWorks software infers from 

the motion of the cursor whether 

you want a tangent or normal arc. 

There are four intent zones, with 

eight possible results as shown.

You can start sketching a tangent 

arc from the end point of any 

existing sketch entity (line, arc, spline, and so on). Move the cursor 

away from the end point.

� Moving the cursor in a tangent direction creates one of the four 

tangent arc possibilities.

� Moving the cursor in a normal direction creates on of the four 

normal arc possibilities.

Sketch Plane



SolidWorks 2011 Lesson 3
Basic Part Modeling

73

� A preview shows what type of arc you are sketching.

� You can change from one to the other by returning the cursor to the 

endpoint and moving away in a different direction.

Autotransitioning 
Between Lines and 
Arcs

When using the Line tool , you can switch from sketching a line to 

sketching a tangent arc, and back again, without selecting the Tangent 

Arc tool. You can do this by returning the cursor to the endpoint and 

moving away in a different direction or by pressing the A key on the 

keyboard.

9 Vertical line.

Click the line tool  and 

start the vertical line at the 

lower edge capturing a 

Coincident  relation at 

the lower edge and Vertical 

relation .

10 Autotransition.
Press the letter A on the keyboard.

You are now in tangent arc mode.

11 Tangent arc.

Sketch a 180° arc tangent to 

the vertical line. Look for 

the inference line indicating 

that the end point of the arc 

is aligned horizontally with 

the arc’s center.

When you finish sketching 

the tangent arc, the sketch 

tool automatically switches 

back to the line tool.

12 Finishing lines.

Create a vertical line from 

the arc end to the base, and 

one more line connecting 

the bottom ends of the two 

vertical lines.

Note that the horizontal line 

is black, but its endpoints 

are not.
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13 Add dimensions.

Add linear and radial 

dimensions to the 

sketch.

As you add the 

dimensions, move the 

cursor around to view 

different possible 

orientations.

Always dimension an arc by selecting on its circumference, rather than 

center. This makes other dimensioning options (min and max) avail-

able.

14 Extrude direction.

Click Insert, Boss, 

Extrude and set the 

Depth to 10mm. Note 

that the preview shows 

the extrusion going into 

the base, in the proper 

direction.

If the direction of the preview is away from the base, click the Reverse 

direction  button.

15 Completed boss.

The boss merges with the 

previous base to form a 

single solid.

Rename the feature 

VertBoss. 



SolidWorks 2011 Lesson 3
Basic Part Modeling

75

Cut Feature Once the two main boss features are completed, it is time to create a cut 

to represent the removal of material. Cut features are created in the 

same way as bosses - in this case with a sketch and extrusion.

Introducing: 

Cut Extrude

The menu for creating a cut feature by extruding is identical to that of 

creating a boss. The only difference is that a cut removes material while 

a boss adds it. Other than that distinction, the commands are the same. 

This cut represents a slot.

Where to Find It � From the Insert menu, select Cut, Extrude....

� Or, on the Features toolbar, choose Extruded Cut .

16 Rectangle.

Press the spacebar and double-

click *Front. Start a sketch on 
this large face and add a 

rectangle Coincident with the 

bottom model edge.

Turn off the rectangle tool.

Selecting Multiple 
Objects

As you learned in Lesson 2  on page 27, when selecting multiple 

objects, hold down the Ctrl key and then select the objects.

17 Relations. 
Add a dimension as shown. 

Change the view orientation to 

Isometric. 

Note The sketch is under defined. See Status of a Sketch on page 38

18 Through All Cut.
Click Insert, Cut, Extrude or 

pick the Extruded Cut  tool 

on the Features toolbar. Choose 

Through All and click OK. This 

type of end condition always 

cuts through the entire model no 

matter how far. No depth setting 

was needed. Rename the feature 

BottomSlot.
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Using the Hole 
Wizard

The Hole Wizard is used to create specialized holes in a solid. It can 

create simple, tapered, counterbored and countersunk holes using a step 

by step procedure. In this example, the Hole Wizard will be used to 

create a standard hole.

Creating a 
Standard Hole

You can choose the face to insert the hole onto, define the hole’s 

dimensions and locate the hole using the Hole Wizard. One of the most 

intuitive aspects of the Hole Wizard is that you specify the size of the 

hole by the fastener that goes into it.

Tip You can also place holes on planes and non-planar faces. For example, 

you can create a hole on a cylindrical face.

Introducing: 
The Hole Wizard

The Hole Wizard creates shaped holes, such as countersunk and 

counterbore types. The process creates two sketches. One defines the 

shape of the hole. The other, a point, locates the center.

Note The Hole Wizard requires a face or sketch to be selected or pre-

selected.

Where to Find It � From the Insert menu, choose Features, Hole, Wizard....

� Or, choose the Hole Wizard  tool on the Features toolbar.

Counterbore Hole A counterbore hole is required in this model. Using the front face of the 

model and a relation, the hole can be positioned.

19 Hole position.

Select the face indicated and 
Insert, Features, Hole, 

Wizard....

Select this face
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20 Click Counterbore.

Set the properties of the hole as follows:

Type: Counterbore

Standard: Ansi Metric

Type: Hex Bolt

Size: M8

End Condition: Through All

Click the Positions tab.

21 Wake up the centerpoint.

Turn off the Point tool. Drag the 

point onto the circumference of 

the large arc. Do not drop it.

When the Coincident symbol 

appears , the center point of the 

large arc has been “woken up” 

and is now a point you can snap 

to.

Drop the point onto the arc’s centerpoint. Look for the feedback that 

tells you that you are snapping to the arc’s center, a coincident relation. 

Click OK to add the relation and again to complete the dialog.
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View Options SolidWorks gives you the option of representing your solid models in 

one of several different ways. They are listed below, with their icons:

� Shaded

� Shaded with Edges

� Hidden Lines Removed

� Hidden Lines Visible

� Wireframe

Examples of each are shown in the illustration below. You will learn 

more about view display and manipulation in Lesson 4: Modeling a 

Casting or Forging.

Filleting Filleting refers to both fillets (adding volume) and rounds (removing 

volume). The distinction is made by the geometric conditions, not the 

command itself. Fillets are created on selected edges. Those edges can 

be selected in several ways. Options exist for fixed or variable radius 

fillets and tangent edge propagation.

Filleting Rules Some general filleting rules are:

1. Leave cosmetic fillets until the end.

2. Create multiple fillets that will have the same radius in the same 

command.

3. When you need fillets of different radii, generally you should make 

the larger fillets first.

4. Fillet order is important. Fillets create faces and edges that can be 

used to generate more fillets.

Tip The FeatureXpert on page 280 can be used to automate the sizing and 

ordering of fillets. It will be discussed in Lesson 8: Basic Part 

Modeling. 

Where to Find It � From the Insert menu, select Features, Fillet/Round....

� Click the Fillet  tool on the Features toolbar.

Shaded Hidden Lines Hidden Lines WireframeShaded with
Removed VisibleEdges
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22 Insert Fillet.

Select the Fillet option in one of the ways 

mentioned above. The Fillet options appear in the 

PropertyManager. Click Manual and set the radius 

value.

�  (Radius) = 8mm

Preview You have a choice between Full preview, Partial 

preview and No preview of the fillet. Full 

preview, as shown below, generates a mesh 

preview on each selected edge. Partial preview 

only generates the preview on the first edge you 

select. As you gain experience with filleting, you 

will probably want to use Partial or No preview 

because they are faster.

Tip The display can be changed to Hidden Lines Visible to make it easier 

to select the edges. The edges can be selected “through” the shaded 

model as displayed below (for Fillet and Chamfer only).

23 Edge selection.

The edges will highlight as 

the cursor moves over them 

and then appear blue as they 

are selected. Edges are 

automatically filtered by the 

Fillet command.

A callout  appears on 

the first edge you select. 

Select six edges total and 

click OK.

A Note About Color You can customize the colors of the SolidWorks user interface. This is 

done through Tools, Options, System Options, Colors. You can 

select predefined color schemes, or create your own. In some cases, we 

have altered colors from their default settings to improve clarity and 

reproduction quality. As a result, the colors on your system may not 

match the colors used in this book.
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Tip You can also select edges using a window. Using the left mouse button, 

drag a window surrounding one or more edges. Edges that are entirely 

inside the window are selected.

24 Completed fillets.

All six fillets are controlled by the 

same dimension value. The 

creation of these fillets has 

generated new edges suitable for 

the next series of fillets.

Return to the Isometric  view. 

Recent 
Commands Menu

SolidWorks provides a “just used” 

buffer that lists the last few commands 

for easy reuse.

25 Recent Command.

Right-click in the graphics area and select Recent Commands and the 

Fillet command from the drop-down list to use it again.
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Fillet Propagation A selected edge that connects to others in a smooth fashion (through 

tangent curves) can propagate a single selection into many. 

26 Preview and propogate.
Add another fillet, radius 3mm, 

using Full preview.

Select the edges indicated to see 

the selected edges and preview. 

Editing Tools Three of the most useful editing tools are introduced in this lesson: Edit 

Sketch, Edit Feature and Rollback. They can be used to edit and 

repair sketches and features as well as specify where, in the 

FeatureManager design tree, the features are to be created. 

Tip The other editing tools are found later in this lesson: Editing Features 

on page 82 and Rollback on page 83. 

Editing a Sketch Once created, sketches can be changed using Edit Sketch. This opens 

the selected sketch so that you can change anything: the dimension 

values, the dimensions themselves, the geometry or geometric 

relations. 

Introducing: 
Edit Sketch

Edit Sketch enables you to access a sketch and make changes to any 

aspect of it. During editing, the model is “rolled back” to its state at the 

time the sketch was created. The model will be rebuilt when the sketch 

is exited. 

Where to Find It � From the Edit menu, choose Sketch.

� Or, click or right-click the feature whose sketch you want to edit 

and select Edit Sketch . 

27 Edit the sketch. 

Right-click the BottomSlot feature and select Edit Sketch . The 

existing sketch will be opened for editing. 
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28 Relations. 

Select the endpoint and edge as shown and add a Coincident relation. 

Repeat the procedure for the set on the opposite side as shown. The 

addition of these relations will fully define the sketch. 

Note For more information about relations, see Sketch Relations on page 42. 

29 Exit the sketch. 

Click Exit Sketch  in the upper right (confirmation) corner to exit 

the sketch and rebuild the part. 

Editing Features The second fillet should propagate into the larger diameter fillet. To do 

this we will edit the definition of the last fillet feature.

Introducing: 
Edit Feature

Edit Feature changes how a feature is applied to the model. Each 

feature has specific information that can be changed or added to, 

depending on the type of feature it is. As a general rule, the same dialog 

box used to create a feature is used to edit it.

Where to Find It � Click or right-click the feature to edit – either in the 

FeatureManager design tree or the graphics area, and select the Edit 

Feature  icon.

30 Edit the feature. 

Right-click the Fillet2 feature and select Edit Feature . The existing 

feature will be opened for editing using the same PropertyManager that 

was used to create the feature. 



SolidWorks 2011 Lesson 3
Basic Part Modeling

83

31 Select additional edge. 

Select the additional edge as shown and the propagation will create the 

fillets as shown. Click OK. 

Rollback The Rollback bar is the blue horizontal 

bar located at the bottom of the 

FeatureManager design tree. 

It is a tool that has many uses. It can be used to “walk through” a model 

showing the steps that were followed to build it or to add features at a 

specific point in the part’s history. In this example, it will be used to 

add a hole feature between the existing fillet features. 

Introducing: The 
Rollback Bar

You can roll back a part using the Rollback Bar in the FeatureManager 

design tree. The rollback bar is a line which highlights when selected. 

Drag the bar up or down the FeatureManager design tree to step 

forward or backward through the regeneration sequence.

Where to Find It � Drag the rollback bar in the FeatureManager design tree.

� Or, right-click a feature, and select Rollback from the shortcut 

menu. This places the bar before the selected feature.

� Or, right-click in the FeatureManager and select Roll to Previous 

to move to the previous position of the rollback bar. Select Roll to 

End to move the bar to after the last feature in the tree.

� Or, click Tools, Options, System Options, FeatureManager and 

click Arrow key navigation. This allows the arrow keys to move 

the rollback bar. 

Tip The focus must be set to the rollback bar by clicking on it. If the focus 

is set to the graphics area, the arrow keys will rotate the model.
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Note The Rollback tool is also useful when editing large parts to limit 

rebuilding. Roll back to the position just after the feature that you are 

editing. When the editing is completed, the part is rebuilt only up to the 

rollback bar. This prevents the entire part from being rebuilt. The part 

can be saved in a rollback state.

32 Rollback. 
Click on the Rollback bar and drag it upwards. Drop it between the 

fillet features as shown. 

33 Hole wizard. 

Click the Hole Wizard  tool and click the 

Positions tab. 

34 Select face.

Select the top, flat face of the base feature near 

the location shown.

Tip Multiple instances of the hole can be created in one command by 

inserting additional points at other locations. 

Select this face
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35 A second hole.

Float over the arc edge to “wake 

up” the centerpoint. Place the 

point at the centerpoint. 

For more information, see step 21 

on page 77. 

36 Move first hole. 

Using the same procedure, drag the 

first point to the centerpoint on the 

opposite side. 

37 Type.
Click the Type tab. Set the properties of the hole 

as follows:

Type: Hole

Standard: Ansi Metric

Type: Drill sizes

Size: 7.0

End Condition: Through All

Click OK.

38 Change the view orientation.

Click Isometric  to change 

view orientation. 
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39 Roll to end. 

Click on the rollback bar and 

right-click Roll To End. 

Introducing: 
Appearances

Use Appearances to change the color and optical properties of 

graphics. Color Swatches can also be created for user defined colors. 

Where to Find It � Right-click the top level feature (part name) and choose 

Appearances and the part name. 

� Or, click the part and choose Appearances  followed by face, 

feature, body, or the part. 

40 Appearance.

Right-click the top level 

feature and choose 

Appearances  and the 

part name  Basic. 
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41 Select Swatch.

Under the Color selection, select the standard 
swatch and one of the colors as shown.

Click OK.

42 Display appearances. 

Click the Display Manager  tab to see the color 

listed. Click the FeatureManager design tree  

tab. 

Tip The Display Manager can also be used to view decals, scenes, lights 

and cameras. 

43 Save the results. 

Click Save  on the Standard toolbar, or click File, Save to save your 

work.
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Detailing Basics SolidWorks enables you to easily create drawings from parts or 

assemblies. These drawings are fully associative with the parts and 

assemblies they reference. If you change the model, the drawing will 

update.

Various topics related to making drawings are integrated into several 

lessons throughout this book. The material presented here is just the 

beginning. Specifically:

� Creating a new drawing file and sheet. 

� Creating drawing views using the View Palette.

� Using dimension assist tools. 

A comprehensive treatment of detailing is offered in the course 

SolidWorks Drawings. 
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Settings Used in 
the Template

The drawing template used in this section has been designed to include 

the Document Properties shown in the chart below. Settings are 

accessed through Tools, Options. The settings that will be used in this 

lesson are:

Toolbars There are toolbars that are specific to the process of detailing and 

making drawings. They are:

� Drawing

� Annotation

New Drawing Drawing files (*.SLDDRW) are SolidWorks files that contain drawing 

sheets. Each sheet is the equivalent of a single sheet of paper.

Introducing: Make 
Drawing from Part

Make Drawing from Part takes the current part and steps through the 

creation of a drawing file, sheet format and initial drawing views using 

that part.

Where to Find It � Click Make Drawing from Part/Assembly  on the Standard 

toolbar.

� Or, click File, Make Drawing from Part.

System Options
Document Properties

(Set using drawing template)

Drawings, Display Style:
• Display style for new views = 

Hidden lines visible

• Tangent edges in new views = 

Removed 

Drafting Standard:
• Overall drafting standard = 

ANSI 

Tables:
Bill of Materials, Automatic 

update of BOM = Selected 

Colors:
• Drawings, Hidden Model Edges 

= Black

Dimensions:
• Font = Century Gothic

• Primary precision = .123

• Add parentheses by default = 

Selected

Detailing, Auto insert on view 

creation:
• All options = cleared

Units
• Unit system =MMGS
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1 Create Drawing.

Click File, Make Drawing from Part/Assembly icon and choose 

B_Size_ANSI_MM from the Training Templates tab.

The sheet format creates a B-size drawing (11” x 17”) arranged with its 

long edge horizontal. The sheet format includes a border, title block, 

and other graphics.

Tip Double-clicking the template will automatically open it, eliminating the 

need to click OK.

Drawing Views The initial task of detailing is the creation of views. Using the Make 

Drawing from Part/Assembly tool leads you through the selection of 

the drawing sheet to the View Palette. This option generates drawing 

views that match the orientations in the part using a drag and drop 

procedure. Additional views can be projected or folded directly from 

the dropped view. 

These options are discussed in detail in the SolidWorks Drawings course.

2 View Palette.
Clear Import Annotations. Drag the Front view from the View 

Palette and drop it onto the drawing as shown. It will be removed from 

the palette. 
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3 Projected views.

Add the Top view by moving the cursor above the view and clicking. 

Return the cursor to the Front view and move to the right to create the 

Right view.

Click OK.

4 Drawing views.
Add the *Isometric view by dragging and dropping from the palette. 

Place it in the upper right corner.

Tip The part document is still open. You can press Ctrl+Tab to switch 

between the drawing and part document windows.
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5 Display. 

Click the Isometric view and click the Shaded button.

Moving Views Drawing views can be repositioned by dragging them around the 

drawing. In the standard 3 view arrangement, the Front view is the 
source view. This means that moving the front view moves all three 

views. The Top and Right views are aligned to the Front. They can 
only move along their axis of alignment.

6 Move Aligned Views.
Select and move the Front view. It can be moved in any direction and 

the other views remain aligned.
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Tip Moving one of the projected views is limited by the 

alignment.

Note Use Alt-drag to select anywhere in the view. Use Shift-drag to 

maintain the spacing between the views while dragging.

Tip Once the drawing view has been selected, it can be dragged with the 

mouse or moved with the arrow keys. The distance moved for each 

press of an arrow key is set under Tools, Options, System Options, 

Drawings, Keyboard movement increment. 

Center Marks Center Marks are attached to circle and arc centers in the drawing 

view.

Center marks were not inserted into 

the drawing views automatically. You 

can turn this option on or off. Set 

your preference using the Tools, 
Options, Document Properties, 

Detailing menu.

Where to Find It � Click Center Mark  on the Annotation toolbar.

� Or, click Insert, Annotations, Center Mark.

7 Center Mark.

Click the Center Mark 

icon and select the large 

arc in the front view. 

Clear Use document 

defaults, check the 

Extended lines option 

and set the Mark size to 

2mm as shown. 

Repeat for selection of 

the two holes in the Top 
view.

Click OK.
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Dimensioning Dimensions can be created in drawing views using several tools. These 

dimensions are not related to the dimensions generated in model 

sketches and features. They are:

� Smart dimensioning - Uses the standard Smart Dimension tool 

to manually add dimensions like those in a sketch. 

� DimXpert - Automates dimensioning by working from a datum 

position. 

Driven 
Dimensions

These dimensions are considered to be driven dimensions. Driven 

dimensions always display the proper values but cannot be used to 

change the model. 

Note By default, dimensions of this type are displayed differently:

� They are displayed in a different color.

� The value is enclosed in parentheses (smart dimensioning).

Introducing: 
Dimension Assist 
Tool DimXpert 

The DimXpert Dimension Assist Tool assists in dimensioning a view 

based on the selection of a datum and model geometry. Options for 

polar, linear, baseline, and chain styles are available. 

Where to Find It � Click Smart Dimension  and DimXpert . 

8 Datum setup.

Click Smart Dimension  and the DimXpert  

option.

Select Linear dimensioning  as the Pattern 

Scheme. 

Select Baseline  as the Dimensioning 

Scheme. 

Select By vertex/hole center for the Datum. 

For the Datum, click the lower left vertex in the 

Front view as shown. 

The datum selection can also be a hole center. 
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9 Edge selections. 

Select the edges, linear and circular, as shown. The dimensions are 

added based on the position in reference to the datum. 

10 Hole selection.
Select an edge of the hole feature as shown. The geometry is read as a 

counterbore and an appropriate dimension is added. 

Tip Once the dimensions are inserted, they are associated to that view and 

will move with it unless you deliberately move them to another view or 

delete them.

Click OK to complete the addition of dimensions to this view. 
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Manipulating 
Dimensions

Once dimensions have been added to a view, there are several options 

as to how they can be manipulated: 

11 Repositioning 
dimensions.

Drag dimensions 

within the view to 

reposition them as 

shown. 

12 Add to another view. 

Using the same procedure, position the datum as 

shown and generate these dimensions.

Drag them into 
position.

Drag dimensions by their text to new locations. Use 

the inference lines to align and position them.

Hide them. Right-click the dimension text and select Hide from 

the shortcut menu. 

Move or Copy 
them to other 
views.

To move a dimension hold down Shift and drag the 

dimension to another view. To copy the dimension, 

hold down Ctrl and drag it into another view and drop 

it.

Delete them. Unwanted dimensions can be deleted from the 

drawing using the Delete key. 
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Datum by selection The Datum by selection option is used where a virtual sharp edge is 

required as the datum. Two edges and an optional angle can be used to 

define it. 

13 Datum by selection. 

Click Smart Dimension  and the DimXpert  option. Select 

Linear dimensioning  and Baseline  as in the previous 

procedure. 

Select By selection for the Datum. For the Datum, click the lower line 

in the Top view as X and the left vertical line as Y. 

14 Dimension. 

Select edges to create the dimensions as shown. Click OK. 

Note Features of the same type and size are collected into single dimensions 

as seen for the hole and fillet dimensions. 

15 Palette. 

Click the 92mm dimension and move the cursor 

onto the dimension palette icon  that appears. 

In the dialog, click Add Parenthesis . Repeat 

for the 32mm and 8mm dimensions that locate 

the holes. 

Tip The blank areas left, right, above and below the 

numeric text can be used to add text relative the 

numeric text. A common use would be to append 

a dimension with TYP as shown. 

X

Y
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Dimension Assist 
Tool - Smart 
Dimensioning

Use the Smart dimensioning option of the dimension assist tool to 

manually add dimensions not created by the DimXpert. 

For more information, see Introducing: Dimension Assist Tool 

DimXpert on page 94. 

16 Dimensioning.

Click Smart Dimension  and the Smart 

dimensioning  option. Select vertices at the 

top and bottom. Click the left (orange) 

hemisphere to place the dimension to the left of 

the view. 

Click OK. 

17 Display options.

Move to the palette and clear the Add Parentheses option. 

Associativity 
Between the Model 
and the Drawing

In the SolidWorks software, everything is associative. If you make a 

change to an individual part, that change will propagate to any and all 

drawings and assemblies that reference it.

Procedure To change the size of the BasePlate feature follow this procedure:

18 Switch windows. 

Press Ctrl+Tab and place the 

cursor over the part file to switch 

back to the part document 

window.
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Changing 
Parameters

SolidWorks makes it very easy to make changes to the dimensions of 

your part. This ease of editing is one of the principal benefits of 

parametric modeling. It is also why it is so important to properly 

capture your design intent. If you don’t properly capture the design 

intent, changes to dimensions may cause quite unexpected results in 

your part.

Rebuilding the 
Model

After you make changes to the dimensions, you must rebuild the model 

to cause those changes to take affect.

Rebuild Symbol If you make changes to a sketch or part that require the part to be 

rebuilt, a rebuild symbol  is displayed beside the part’s name as well 

as superimposed on the icon of the feature that requires rebuilding 

. Look for the rebuild icon on the Status Bar, also.

The rebuild symbol also is displayed when you edit a sketch. When you 

exit the sketch, the part rebuilds automatically.

Introducing: Rebuild Rebuild regenerates the model with any changes you have made.

Where to Find It � Click Rebuild  on the Standard toolbar.

� Or, on the Edit menu, click Rebuild.

� Or, use the keyboard shortcut Ctrl+B.

Refreshing the 
Screen

If you simply want to refresh the screen display, removing any graphic 

artifacts that might remain from previous operations, you should use 

Redraw, not Rebuild.

Introducing: Redraw Refreshes the screen, but does not rebuild the part.

Where to Find It � From the View menu, click Redraw.

� Or, use the keyboard shortcut Ctrl+R.

Rebuild vs. Redraw Redraw will not cause changes to dimensions to take effect. Therefore, 

it is very fast. Rebuild regenerates the model. Depending on the 

complexity of the model, this can take more time.
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19 Double-click on the feature.

You can double-click on the BasePlate feature either in the 
FeatureManager design tree or the graphics area. When you do this, the 

parameters associated with the feature will appear. 

Double-click on the 100mm dimension indicated. The Modify dialog 

box will appear. Enter a new value either by typing it directly or by 

using the spin box arrows. Enter 150mm. 

20 Rebuild the part to see the results.

You can Rebuild the part either by clicking on the Rebuild tool  on 

the Modify box or on the Standard toolbar. If you use the one on the 

Modify dialog box, the dialog box will stay open so you can make 

another change. This makes exploring “what if” scenarios easy. 



SolidWorks 2011 Lesson 3
Basic Part Modeling

101

21 Update the drawing.

Switch back to the drawing sheet. The drawing will update 

automatically to reflect the changes in the model. Dimensions may 

move during the rebuilding process and require clean up. 

22 Close the drawing. 

Click File, Close to close the drawing. Click Save All to save both the 

drawing and part files. Save the file in the same folder as the part. 
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Exercise 7:
Plate

Create this part using the information 

and dimensions provided. Sketch and 

extrude profiles to create the part. This 

lab reinforces the following skills:

� Choosing the Best Profile on 

page 64.

� Introducing: Corner Rectangle on 

page 69.

� Sketching on a Planar Face on page 72.

� Boss Feature on page 71.

� Using the Hole Wizard on page 76.

Units: millimeters

Procedure Create a new mm part and name it Plate. Create the geometry as 

shown in the following steps. 

1 Sketch base feature. 

Create a new sketch on the Top plane. 

Add the geometry and dimensions as 

shown. 

2 Extrude base feature. 

Extrude to the sketch 5mm as shown. 
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3 Boss. 

Create a new sketch on the top face of the solid. Add the geometry and 

dimensions as shown. 

Extrude a boss 25mm. 

4 Hole wizard. 
Click the Hole Wizard and select the face shown. 

Click the Positions tab. Place the points as shown. 

Click the Type tab. Set the properties of the hole as follows:

Type: Hole 

Standard: Ansi Metric 

Type: Drill sizes 

Size: 25mm

End Condition: Through All 

5 Save and close the part. 
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Exercise 8:
Cuts

Use rectangles, tangent arcs and 

cut features to create the part. 

This lab reinforces the following 

skills: 

� Introducing: 

Corner Rectangle on 

page 69.

� Tangent Arc Intent Zones on 

page 72.

� Cut Feature on page 75. 

� Filleting on page 78.

Units: millimeters 

Procedure Create a new mm part and name it Cuts. Create the geometry as shown 

in the following steps. 

1 Sketch base feature. 

Create a new sketch on the Top plane. Add the geometry and 

dimensions as shown. 

2 Extrude base feature. 

Extrude to the sketch 5mm as shown. 
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3 Cut slot. 

Create a new sketch on the top 

face of the solid. Add the 

geometry and dimensions as 

shown. 

Extrude a cut using Through 

All. 

4 Cut another slot. 

Create a new sketch using the 

same face. Add the geometry 

and dimensions as shown. 

Extrude another cut using 

Through All.

5 Cut rectangle. 
Create a new sketch using the same face. Add the geometry and 

dimensions as shown. 

Extrude another cut using Through All.
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6 Fillets. 

Add fillets of R10mm and R8mm to the edges as shown. 

7 Save and close the part. 
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Exercise 9:
Basic-Changes

Make changes to the part 

created in the previous 

lesson.

This exercise uses the 

following skills:

� Changing 

Parameters on 

page 99.

� Rebuilding the Model 

on page 99.

Procedure Open an existing part in the Lesson03\Exercises folder.

1 Open the part
Basic-Changes.
Several changes will be 

performed on the model to resize 

it and check the design intent.

2 Overall dimension.

Double-click the first feature (Base Plate) in the FeatureManager or 

on the screen to access the dimensions. Change the length dimension to 

150mm (shown bold and underlined below) and rebuild the model.
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3 Boss.

Double-click the Vert boss feature and change the height dimension as 

shown. Rebuild the part.

4 Hole locations.
Double-click the 7mm hole feature and change the position 

dimensions to 20mm each (only one is shown). Rebuild the model.

5 Center the Vert Boss.
Determine the proper value and change the dimension that centers the 

Vert Boss on the base.

6 Save and close the part. 
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Exercise 10:
Base Bracket

This lab reinforces the 

following skills:

� Choosing the Best 

Profile on page 64.

� Boss Feature on 

page 71.

� Using the Hole 

Wizard on page 76.

� Filleting on page 78.

Units: millimeters

Procedure Create a new mm part and name it Base_Bracket. Create the geometry 

as shown in the following steps. 

1 Sketch base feature. 
Create a new sketch on the Top plane. Add the geometry and 

dimensions as shown. 

2 Extrude base feature. 

Extrude the sketch 20mm to create the base feature as shown. 
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3 Sketch on rear face. 

Change to the Rear view orientation, select the face indicated and 
create a new sketch. Add the geometry and dimensions as shown.

4 Extrude boss. 

Extrude to the sketch 20mm as shown. 

Select Face
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5 Fillets. 

Add fillets to the edges as shown. 

R20mm

R25mm

R12mm
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6 Hole wizard. 

Click the Hole Wizard and select the face shown. 

Click the Positions tab. Use the centerpoints of the arcs to place the 

points as shown. 

Click the Type tab. Set the properties of the hole as follows:

Type: Hole 

Standard: Ansi Metric 

Type: Drill sizes 

Size: 20mm

End Condition: Through All 

7 Second hole. 

Repeat the procedure to create an 18mm hole on a different face as 

shown. 

8 Save and close the part. 

Select Face

Select Face
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Exercise 11:
Part Drawings

Create this part drawing using the 

information provided. 

This lab reinforces the following skills:

� New Drawing on page 89.

� Drawing Views on page 90.

� Center Marks on page 93.

� Dimensioning on page 94.

Use the B_Size_ANSI_MM template and the built part Basic-
Changes-Done.

Dimensioned View Use the following graphics to create the drawing. 
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Lesson 4
Modeling a Casting

or Forging

Upon successful completion of this lesson, you will be able to:

� Use the view display and modification commands.

� Copy and paste features.

� Edit the definition and parameters of a feature and regenerate the 

model.

� Use Up To Next and Mid Plane end conditions to capture design 

intent.

� Use symmetry in the sketch.
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Case Study: 
Ratchet 

The Ratchet contains many of the 

features and procedures that you 

will use frequently. It contains 

bosses, cuts, sketch geometry, 

fillets and draft.

Stages in the 
Process

Some key stages in the modeling process of this part are shown in the 

following list. Each of these topics comprises a section in the lesson.

� Design intent

The overall design intent for the part is discussed. 

� Boss feature with draft

The first portion of the model to be created is the Handle. The Handle 
uses sketched lines and is extruded in two directions with draft forming 

a solid. It is the initial feature of the part and demonstrates the use of 

mirroring in the sketch.

� Up To Next end condition

The second portion of the model is the Transition. It uses the 
Up To Next end condition to connect to the Handle’s faces.

� Sketching inside the part

The third boss created is the Head. It is sketched within the solid 
created by the Transition.

� Cut using existing edges

The Recess is the first cut type feature created. It uses an offset from 

the existing edges of the model to create the sketch. It is extruded as a 

offset cut to a specific depth.

� Cut with trimmed sketch geometry

The Pocket is another cut feature, this time using circles that are 

trimmed to the proper shape.

� Cut using copy and paste

The Wheel Hole feature will be copied and pasted.

� Filleting

Fillets and rounds are added to the solid using several different 

techniques. 

� Editing a feature’s definition

Features that already exist can be changed using Edit Feature. Fillets 

will be edited in this way. 
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Design Intent The general design intent of the Ratchet is summarized in the 

illustration and list below. Specific design intent for each portion of the 

part is discussed separately. 

� Centering: The Head, Handle and Transition features are 
centered along an axis. 

� Symmetry: The part is symmetrical, both with respect to a 

longitudinal centerline and with respect to the parting plane.

Head

Handle

Transition

Pocket Recess

Thru Holes 
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Boss Feature 
with Draft

The first part of the Ratchet we will model is the Handle. The first 
feature in any model is sometimes referred to as the base feature. All 

other features are built onto the first feature. 

Building the 
Handle

The Handle has a 
rectangular cross 

section. It is extruded 

with draft an equal 

distance in opposite 

directions from the 

sketch plane. 

Design Intent of 
the Handle 

The Handle is a sketched feature that uses lines 
and mirroring to form the basic outline or profile, 

a rectangular cross section. 

� Draft: The draft angle is equal on both sides 

of the parting plane.

� Symmetry: Feature is symmetrical with respect to parting plane 

and the centerline axis of the Handle.

A centerline, a piece of reference geometry, will be used to 

position and sketch the Handle sketch.

The centerline represents distance from the end of the handle to 

the center of the furthest hole and is also used in mirroring 

sketch geometry.

Procedure Begin by following this procedure:

1 New Part.

Open a new part using the Part_MM template on the Training 
Templates tab. Save the part and name it Ratchet.

2 Sketch plane.
Select the plane Top as the sketch plane. 

Handle Section
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Introducing: Insert 
Centerline

Insert Centerline is used to create a reference line in a sketch. The 

centerline can be vertical, horizontal, or an arbitrary angle depending 

on how the inferences are used. Because the centerline is considered 

reference geometry, it does not have to be fully defined in the sketch.

Where to Find It � Click Tools, Sketch Entity, Centerline.

� Or, on the Sketch toolbar, click Centerline .

Note Any piece of sketch geometry can be converted into construction 

geometry or vice-versa. Select the geometry and click the 

Construction Geometry  tool on the Sketch toolbar.

The PropertyManager can also be used to change 

sketch geometry into construction geometry. Select 

the geometry and click For construction.

3 Sketch a centerline.

Sketch a centerline running vertically from the origin. 

The length is not important.

4 Display off.
Toggle the display of relations off using View, Sketch Relations.

Note Further lessons will assume that View, Sketch Relations is toggled off.

Symmetry in 
the Sketch

Symmetrical geometry in a sketch can be created easily using the 

Mirror option. You can mirror as you sketch – real time mirroring. Or, 

you can select already sketched geometry and mirror it – after the fact 

mirroring. Also, Symmetric relations can be added to geometry after 

sketching.

In any case, mirroring creates copies that are related to the originals by 

the Symmetric relation. In the case of lines, the symmetric relation is 

applied to the endpoints of the lines. In the case of arcs and circles, the 

symmetric relation is applied to the entity itself. 

Introducing: 
Dynamic Mirror

Mirroring requires a line, linear edge or centerline. The line is activated 

before sketching the geometry to be mirrored.

Where to Find It � From the Tools menu choose: Sketch Tools, Dynamic Mirror.

� Or, on the Sketch toolbar, click Dynamic Mirror .
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Symmetry While 
Sketching

Symmetric geometry can be created in real time as you sketch. The 

Dynamic Mirror method enables mirroring before sketching.

Symmetry after 
Sketching

Symmetry can be created by sketching one half of the geometry and 

using mirroring to create the other. The symmetry is applied after 

sketching.

Introducing: Mirror 
Entities

Mirroring requires a line, linear edge or centerline. This line defines the 

mirror plane which is always normal to the sketch plane and passes 

through the selected centerline.

Where to Find It � From the Tools menu choose: Sketch Tools, Mirror.

� Or, on the Sketch toolbar, click Mirror Entities .

5 Dynamic mirror.

Select the centerline and click the Dynamic Mirror tool. The 

Dynamic Mirror symbol  appears at both ends of the centerline.

6 Sketch line.

Sketch a line from the upper end of the centerline moving to 

the right. A mirror image of the line is created on the opposite 

side of the centerline.

7 Complete the sketch.

Add a line in the vertical direction and then horizontal, 

stopping at the centerline. Turn off the mirror tool.

Tip Do not cross the centerline while sketching in the Dynamic 

Mirror mode. If you do, duplicate geometry can be created. 

Stopping at the centerline caused the symmetrical lines to be 

merged into a single line.



SolidWorks 2011 Lesson 4
Modeling a Casting or Forging

121

8 Dimensions.

Fully dimension the sketch.

Mid Plane 
Extrusion

In this part, the first feature created is a Mid Plane extrusion. The Mid 

Plane option extrudes the profile equally in opposite directions. The 

depth is the total extruded distance, split evenly in each direction.

Draft Toggle The Draft  toggle can be selected to draft the faces normal to the 

extrusion direction. The Draft angle and Draft outward toggles can be 

used to set the value and direction of the angle.

9 Base/Boss Extrusion.

Click the Extruded Boss/Base tool  on the Features toolbar or click 

Boss/Base Extrude from the Insert menu.

10 Extrusion.

Choose the Mid Plane 

option from the list and 

enter a depth of 15mm. 

Click Draft  and set the 

angle to 8°. The Draft 

outward check box should 

be cleared.

Click OK to create the 

feature.
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11 Completed feature.

The completed feature is shown at the right. 

Name the feature Handle.

Sketching 
Inside the 
Model

The second feature in the part is the Transition, another boss that will 
connect to the Handle feature. The sketch for this feature is created on 
a standard plane. 

Design Intent of 
the Transition

The Transition feature is a simple 

circular profile that is extruded up to 

the existing Handle feature.

� Centering: The circular profile 

is centered on the Handle 
feature.

� Length: The length of the 

section is determined using 

existing locations.

Transition Section
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12 Showing the Front plane.
Switch to an Isometric view and select 
the Front plane from the 

FeatureManager design tree. It will be 

highlighted on the screen.

To make sure the plane stays visible, 

right-click the Front plane in the 
FeatureManager design tree, and select 

Show . The plane will appear shaded and transparent.

13 Plane settings and changes.

There are settings to determine how planes will appear on the screen. 

For shaded planes, click Tools, Options, System Options, Display/

Selection and select the Display shaded planes check box. Set the 

color of the plane using Tools, Options, Document Properties, 

Plane Display.

Any plane, system or user generated, can be resized 

by dragging its handles. Resize this plane so that its 

borders lie closer to the boundaries of the feature. 

The planes can also be automatically sized to the 

model. Right-click the plane and choose AutoSize.

Circular Profile The sketch for the Transition feature has very simple geometry and 

relations. A circle is sketched and related to a position on the previous 

feature to define it. This relation will keep the Transition centered on 
the Handle feature.

14 Open a new sketch.

With the Front plane still selected, click the Sketch tool . 

Introducing: View 
Normal To

The View Normal To option is used to change the view orientation to a 

direction normal to a selected planar geometry. The geometry can be a 

plane, sketch, planar face or feature that contains a sketch.

Tip Clicking the Normal To icon a second time will flip the orientation 

around to the opposite side of the plane.

Where to Find It � Click Normal To  on the Standard Views toolbar.

� Or, press the Spacebar and double-click Normal To.
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15 Normal To view orientation.

Using the View Orientation dialog box, 

change to the Normal To orientation by 

double-clicking Normal To. 

This orients the view so you can see the 

plane’s true size and shape and makes 

sketching easier.

Tip You can also select the plane and click the Normal To tool  on the 

Standard Views toolbar.

Introducing: 
Sketched Circles

The circle tool is used to create circles for cuts and bosses in a sketch. 

The circle is defined by either Center or Perimeter creation. Center 

requires two locations: the center, and a location on its circumference. 

Perimeter requires locations that represent two (or optionally three) 

locations on the perimeter.

Where to Find It � From the Tools menu, select Sketch Entities, Circle or Perimeter 

Circle.

� Or, on the Sketch toolbar, click Circle  or Perimeter Circle .

Sketching the 
Circle

Many inference points can be used to locate circles. You can use the 

center of previously created circles, the origin and other point locations 

to locate the circle’s center. In this example, we will automatically 

capture a coincident relation to the origin by sketching the center of the 

circle on it.

16 Add a circle and dimension it.

Using the Circle tool, add the circle at 

the origin.

Add the diameter dimension to fully 

define the sketch. Set the value to be 

12mm. The sketch is fully defined.
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Changing the 
Appearance of 
Dimensions

With the dimensioning standard currently in use, diameter dimensions 

are displayed with one arrow outside the circle. You can change the 

display so that two arrows are inside of the circle. 

17 Click the dimension.

Two small dots will appear on the 

arrowheads of the dimension.

Note The highlighted geometry can appear in any color. The color depends 

on the Selected Item 1 color setting. 

18 Toggle the arrows.

Click one of the green dots to toggle the 

arrows to the inside of the circle. This 

works on all dimensions, not just 

diameter dimensions.

Click again to place the arrows outside.

19 Change to Isometric view.
Unlike when you created the 

first feature, the system will 

not switch view orientations 

automatically for any other 

bosses or cuts. Change to an 

Isometric view. 
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Extruding Up To 
Next

The sketch will be extruded up to the next face(s) it encounters along 

its path. It is important to watch the preview graphics to determine that 

the boss is going in the proper direction, reversing the direction if 

necessary.

20 Up To Next extrusion.

Click Insert, Boss/Base, 

Extrude... and watch the 

preview display. Change the 

direction so that the preview 

shows the extrusion running 

towards the Handle.

Change the end condition to 

Up To Next.

Click OK.

Rename the feature to 

Transition.

21 Hide plane.

Right-click the Front plane and click Hide . 

Up To Next vs. Up To 
Surface

The end conditions Up To Next and Up To Surface generate different 

results in many cases. The image on the left is for Up To Surface when 

the angled (red) face is selected. The extrusion is shaped by the selected 

surface. Only one surface selection is allowed. The image on the right 

is for Up To Next. All faces in the path of the extrusion are used to 

shape the extrusion.
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Design Intent of 
the Head

The Head is a sketched feature that uses lines and tangent arcs to form 

the basic outline or profile. The profile is extruded in opposite 

directions, equally, with draft. This feature is the key feature of the part. 

It will contain pockets and holes used for the location of other parts.

The design intent of the Head is listed below:

� Arc Centers: The 

centers of the two 

arcs in the outline 

(profile) line up 

vertically in a Top 
view orientation. 

The radii are not 

equal, and can 

change to any 

value.

� Profile Location: 

The sketch geometry is located on the parting plane of the solid 

with the larger arc centered with respect to the model origin.

� Draft: The applied draft is equal on both sides of the parting plane.

� Thickness: The thickness of the part is equal on both sides of the 

parting line.

Parting Line

Head Section
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22 Centerline.

Select the plane Top as the sketch plane. Orient the view to the 
same direction. Start off the sketch with a centerline as shown.

23 Lines and arcs.

Create a line and transition 

directly into a tangent arc 

using Autotransitioning. 

For more information, see 

Autotransitioning Between 

Lines and Arcs on page 73. 

24 Return to a line.

After the arc is complete, the line tool 

again becomes active. Sketch a line 

using the tangent inference line. End 

the line at the end of the first line.

25 Tangent arc. 

Use autotransitioning again to close the 

profile starting with a tangent arc from 

the last endpoint. 
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26 Add relations.

Add relations to attach the arc 

centerpoints to the ends of the centerline 

as shown.

27 Dimensions.

Add dimensions as shown to fully define 

the sketch.

28 The extrusion.

Change to an Isometric view and 
click Insert, Boss/Base, Extrude... 

from the menu. Set the type to Mid 

Plane, depth to 20mm and draft to 

8°. Rename the latest feature to 

Head.

The three main features that make up 

the overall shape of the part are now complete. 



Lesson 4 SolidWorks 2011
Modeling a Casting or Forging

130

View Options The SolidWorks software provides you with many options for 

controlling and manipulating how models are displayed on your screen. 

In general, these view options can be divided into two groups. These 

groups correspond to the two sub-menus that are available on the View 

menu and the two groups of tools on the view toolbar.

� Display Options

� Modify Options

Note The lower portions of these menus have been truncated. 
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Display Options The following illustrations of the Ratchet illustrate the different types 
of display options.

Note The Perspective and Section view options can be applied to any type 

of view – wireframe, hidden line, or shaded. The Draft Quality HLR/

HLV tool  can be active with all view types but affects only the 

Hidden Lines Removed and Hidden Lines Visible options by making 

the display faceted and faster to manipulate.

Modify Options The modify options are listed below next to their corresponding tools.

Note It is notoriously difficult to illustrate something as dynamic as view 

rotation via a medium as static as a printed manual. Therefore, the 

different view options are only listed and summarized here. Your 

instructor will demonstrate them for you in class. 

Wireframe Hidden Lines Visible Hidden Lines Removed

Shaded Perspective Section

Shadows in Shaded ModeZebra Stripes Shaded With Edges

Zoom to Fit: Zooms in or out so the entire model is visible.

Zoom to Area: Zooms in on a portion of the view that you select 

by dragging a bounding box. the center of the box is marked with 

a plus (+) sign.

Zoom In/Out: Zooms in as you press and hold the left mouse 

button and drag the mouse up. Zooms out as you drag the mouse 

down.

Zoom to Selection: Zooms to the size of a selected entity.
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Middle Mouse 
Button Functions

The middle or wheel mouse button on a three button mouse can be used 

to dynamically manipulate the display. Using the middle or wheel 

mouse button you can: 

Rotate View: Rotates the view as you press and hold the left 

mouse button and drag the mouse around the screen.

Roll View: Rotates the view about an axis normal to the screen as 

you press and hold the left mouse button and drag the mouse 

around the screen.

Pan View: Scrolls the view so the model moves as you drag the 

mouse.

Function Button Wheel

Rotate

Press and hold the middle 

mouse button. As you move 

the mouse, the view rotates 

freely.

Press and hold the wheel 

mouse button. As you move 

the mouse, the view rotates 

freely.

Rotate 

about 

geometry

Click the middle mouse 

button on the geometry. As 

you move the mouse, the 

view rotates about that 

selected geometry.

The geometry can be a 

vertex, edge, axis, or 

temporary axis. 

Click the wheel mouse 

button on the geometry. As 

you move the mouse, the 

view rotates about that 

selected geometry.

Pan or 

Scroll

Press and hold the Ctrl key 

together with the middle 

mouse button. The view 

will scroll as you drag the 

mouse.

Press and hold the Ctrl key 

together with the wheel 

mouse button. The view 

will scroll as you drag the 

mouse

Zoom

Press and hold the Shift key 

together with the middle 

mouse button. The view 

will zoom larger as you 

drag the mouse upward; 

smaller as you drag the 

mouse downward.

Spin the wheel mouse 

button. The view will zoom 

larger as you spin the wheel 

downward; smaller as you 

spin the wheel upward.

Zoom to 

Selection

Double-click the middle 

mouse button to zoom the 

entire model to fit. 

Double-click the middle 

mouse button to zoom the 

entire model to fit. 
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Tip In a drawing, only the Zoom and Pan functions can be used.

Reference Triad 
Functions

The Reference Triad can be used to change the view 

orientation. Selecting an axis, with or without additional keys, 

can be used to control rotations. 

Keyboard 
Shortcuts

Listed below are the predefined keyboard shortcuts for view options: 

Selection Result

Select axis not normal to screen Axis direction is normal to the 

screen. 

Select axis normal to screen Rotate view 180° clockwise.

Shift + select axis Rotate view 180° counterclockwise.

Alt + select axis Rotate view using Arrow key 

increments. 

Arrow Keys Rotate the view

Shift+Arrow Keys Rotate the view in 90° increments

Alt+Left or Right Arrow Keys Rotate about normal to the screen

Ctrl+Arrow Keys Move the view

Shift+z Zoom In

z Zoom Out

f Zoom to Fit

g Magnifying Glass

Ctrl+1 Front Orientation

Ctrl+2 Back Orientation

Ctrl+3 Left Orientation

Ctrl+4 Right Orientation

Ctrl+5 Top Orientation

Ctrl+6 Bottom Orientation

Ctrl+7 Isometric Orientation

Ctrl+8 View Normal To 

Spacebar View Orientation dialog
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Tip Clear Zoom to fit when changing to standard views to prevent 

fitting the model to the graphics area on an orientation change. 

Note Click Tools, Customize and the Keyboard tab to see assigned 

shortcuts. Use the same dialog to add shortcuts of your own.

Using Model 
Edges in a 
Sketch

The first cut feature to be added is the Recess, a pocket that is extruded 
down from the top face of the Head. This feature allows for the 
placement of a cover plate over the ratchet gears. Since the cover is the 

same general shape as the top face, it would be helpful to take 

advantage of the edges of the Head when sketching the profile for the 
Recess cut. We will do this by making an Offset of the edges of the 

Head.

Zoom to Selection The Zoom to Selection option zooms in on a selected entity, making it 

fill the screen. 

Where to Find It � Select geometry and from the View menu, select Modify, Zoom to 

Selection. 

� Or, right-click geometry and select Zoom to Selection . 

Note Multiple geometry selections can also be used. 
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29 Select face and zoom.

Select the top face of the Head 

and click Zoom to Selection . 

That face will fill the graphics 

window.

Sketching an 
Offset

Offsets in a sketch rely on existing model edges or sketch entities in 

another sketch. In this example we will utilize the model edges of the 

Head. These edges can be chosen singly, or as the boundary of an 
entire face.When possible, it is a good idea to pick the face because the 

sketch will regenerate better if subsequent changes add or remove 

edges from the face.

The edges are projected onto the plane of the sketch, regardless 

whether they lie on that plane or not.

Introducing: 
Offset Entities

Offset Entities is used to create copies of model edges in a sketch. 

These copies are offset from the original by some specified amount.

Where to Find It � From the Tools menu, select Sketch Tools, Offset Entities....

� Or, on the Sketch toolbar, click Offset Entities .

30 Offset the face boundaries.

Select the top face and click the 

Sketch tool. With the face still 

selected click the Offset tool on 

the toolbar. Set the distance 

value to 2mm and Reverse the 

direction if necessary, moving 

the offset to the inside and click 

OK.
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31 Resulting Offset.

The offset creates two lines and two arcs. This 

geometry is dependent on the solid face it came 

from and will change with the solid. The sketch 

is automatically fully defined and ready to 

extrude as a cut. 

32 Settings for the cut.

Choose a Blind cut with 2mm for the depth value 

and click OK.

33 Rename the feature.

Change the name of the feature to Recess. 

Creating 
Trimmed Sketch 
Geometry

The Pocket is another extruded cut feature. This sketch uses 
overlapping circles that are trimmed to create a single contour. The 

centers of the circles are related to existing circular centerpoints.

34 Sketch circles.

Select the top, inner face created by the last feature 

as the sketch plane. Using the Circle tool , 

create a circle using the existing centerpoint 

location as the circle’s origin. Snapping to this 

location will relate the circle to it automatically. 

Create a second circle off to the side of the model.

35 Relate the centers.

Click Add Relation  to open the Add 

Relations PropertyManager. Select the second 

circle and the edge of the cut. Choose the 

Concentric option and click OK. Concentric 

forces the two arcs (the circle and the circular 

edge) to share a common center. This will pull 

the circle into position.

Trim and Extend Sketch entities can be trimmed shorter using the Trim option. In this 

example, the overlapping portions of the circles will be removed. There 

are several trimming options: Power Trim, Corner, Trim away inside, 

Trim away outside and Trim to closest. They can also be lengthened 

using Extend. They are discussed below.
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Introducing: Trim Trim can be used to shorten sketch geometry.

Where to Find It � From the Tools menu, select Sketch Tools, Trim.

� Or, on the Sketch toolbar, click Trim Entities .

Power trim  

removes the portion of 

an entity that you drag 

over between 

intersections or to an 

endpoint.

The Corner  

option is used to trim 

by keeping the 

geometry selected to a 

common intersection.

Use the Trim away 

outside  to keep 

the inside portions of 

geometry is against a 

boundary. Select the 

two boundaries (B) 

first then the pieces of 

geometry to trim (T).

Use Trim away inside 

 to keep the 

outside portions of 

geometry against a 

boundary. Select the 

two boundaries (B) 

first then the pieces of 

geometry to trim (T).

B

B

T

T

B

B

T

T
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Introducing: 
Extend

Extend can be used to lengthen sketch geometry.

Where to Find It � From the Tools menu, select Sketch Tools, Extend.

� Or, on the Sketch toolbar, click Extend Entities .

36 Trim the circles.

Click on the Trim Entities tool and 

select the Power trim option. 

Rule Drag across the portions of the sketch 

entities that you want to remove.

The system will find the intersections 

between the circles and remove the 

excess.

Use Trim to closest 

 to trim selected 

geometry to the nearest 

intersection or remove 

a portion of the 

geometry between 

boundaries.

T

Select nearest the end 

to extend and click to 

extend to the next 

intersection.

Drag the nearest 

endpoint and drop it on 

the intersecting entity 

to extend.



SolidWorks 2011 Lesson 4
Modeling a Casting or Forging

139

37 Add dimensions.

Add dimensions to the arcs. This will fully define 

the sketch.

38 Turn off the dimension tool.

An easy way to turn off the dimension tool is to 

simply press the Esc key on the keyboard.

Modifying 
Dimensions

Since the sketch entities are arcs, the system automatically created 

radial dimensions. If you prefer diameter dimensions, you can quickly 

change the display options. For more in-depth dimension changes, 

right-click the dimension, and select Properties.

39 Diameter dimensions.

Select the dimensions, right-click and choose 

Display Options, Display As Diameter.

Introducing: Offset 
From Surface

The Offset From Surface end 

condition is used to locate the end of 

an extrusion as a measurement from a 

plane, face or surface rather than the 

sketch plane of the feature.

In this example the end of the 

extrusion is measured from the 

bottom face of the part.

The Translate Surface option can be 

checked or cleared. Its meaning is 

explained below.
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What the Translate 
Surface option 
does:

The Translate Surface option of the 

Offset From Surface end condition is off 

by default.

In the illustration at the right, both 

columns are positioned below two 

identical semi-circular reference surfaces. 

Both columns are extruded such that the 

top of each is 1.4” below the reference 

surfaces. The column on the left was 

extruded with the Translate Surface 

option on. The column on the right was 

extruded with the option off.

The Offset from Surface option in 

the Translate Surface option defines 

the end condition by linearly 

translating a copy of the surface in the 

direction of the extrusion. Without it, 

the copied surface is created by 

projection normal to the original 

surface. Hence the two different 

results.

Note In this example, the position of the planar face selected means that both 

options reach the same result.

40 Offset From Surface.
Click the Extruded Cut icon and choose the Offset From Surface end 

condition. Set the Offset Distance to 5mm. 

Introducing: Select 
Other

Select Other is used to select hidden faces of the model without 

reorienting it. 

Where to Find It � Right-click on a face and select Select Other .

Select Other 
Procedure

To select faces that are hidden or obscured, you use the Select Other 

option. When you position the cursor in the area of a face and press the 

right mouse button, Select Other is available as an option on the 

shortcut menu. The face closest to the cursor is hidden. Moving over 

faces listed in the dialog highlights them on the screen.

The reason the system hides the closest face is since that one was 

visible, if you wanted to select it you would have simply picked it with 

the left mouse button.
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41 Face selection.

Right-click over the hidden bottom face and choose Select Other. If 

there are multiple selections, slide the cursor up and down the Select 

Other list to highlight possible face selections. Use the left mouse 

button to select the face directly or select the choice Face from the list. 

Rename the feature Pocket.

Tip Other faces can be hidden during the selection. Right-click a face to 

hide it. Press Shift and right-click to unhide it and remove it from the 

list.

Measuring The Measure option can be used for many measurement tasks 

including measuring a single entity or between two entities. The 

measurement appears in the default units of the part. 

In this example it will be used to measure the shortest distance between 

an edge and a plane. 
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Introducing:

Measure

The Measure command can calculate distances, lengths, surface areas, 

angles, circles and X, Y, Z locations of selected vertices. For circles and 

arcs, the center, minimum and maximum dimensions are available as 

shown below.

Where to Find It � On the Tools toolbar, click the Measure tool .

� Or from the Tools menu, choose Measure....
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42 Measure between face 
and vertex.
Click the Measure tool 

 and select the face 

(from step 41) and vertex 

as shown.

The Normal Distance and 

Delta Y are both 5mm. 

Information for the 

combined selections is 

displayed.

Tip The Status Bar at the bottom of the SolidWorks window displays some 

similar information when the Measure tool is off. If a circular edge 

was selected, the status bar would show the Radius and Center.

Using Copy and 
Paste

The Ratchet requires two through holes of different diameters. We will 

create one hole and copy and paste it to make the second.

Sketching the Hole Circular holes are very simple to create. A sketch circle, related to the 

model and dimensioned, is all you need. The Hole Wizard could also be 

used to create this hole.

43 Open a sketch.

Click on the inner bottom “figure eight” face and 

open a new sketch. 
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44 Create a circular hole.

Sketch a circle concentric to the upper circular edge 

as shown. Add a dimension, set the diameter to 

9mm and create a Through All cut.

Name the feature Wheel Hole.

Copy and Paste 
Features

Simple sketched features and some applied features can be copied and 

then pasted onto a planar face. Multi-sketch features such as sweeps 

and lofts cannot be copied. Likewise, certain applied features such as 

draft cannot be copied, although fillets and chamfers can.

Once pasted, the copy has no ties or associativity to the original. Both 

the feature and its sketch can be changed independently.

Copying a Feature Copy features by selecting them and using the standard Windows 

shortcut Ctrl+C or picking the Copy  tool on the Standard toolbar. 

You can also select Copy from the Edit menu. Finally, you can employ 

the standard Windows “drag and drop” technique while holding down 

the Ctrl key.

45 Identify the feature to copy.
The feature to be copied must be identified either 

in the FeatureManager design tree or on the 

model. For this example, select the feature Wheel 
Hole by picking it in the FeatureManager design 

tree. Next, copy it to the clipboard using the 

Copy  option on the Standard toolbar.

Note You may also use Ctrl+C or Edit, Copy to create a copy on the 

clipboard.

46 Select the face on which to paste. 

The copied feature must be pasted onto a planar 

face. Select the bottom inner face, the same one used 

for the sketch plane of the Wheel Hole.

47 Paste the feature.

Paste the copy using the Paste  tool, the shortcut 

Ctrl+V, or Edit, Paste.

48 Copy confirmation.

The Wheel Hole was Concentric to the smaller end of the “figure 

eight” face. The copy carries that Concentric relation with it, except 

the system now has a bit of a problem. It doesn’t know what edge to 

make it concentric to. Therefore, we are given three choices:
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� Delete the relationship.

� Keep it even though it is unresolved (dangling).

� Cancel the copy operation altogether.

49 Click Delete.

Dangling 
Relations

Dimensions and relations are said to be dangling when they reference 

something that has been deleted or that is otherwise unresolved. 

Dangling relations can usually be repaired through one or more 

techniques. We will discuss repairing dangling relations later in the 

course in Lesson 8: Editing: Repairs.

50 Feature pasted.

The feature and its sketch are added to the 

FeatureManager design tree and the model. Note 

that the feature is not centered. That is because its 

sketch is, in fact, under defined.

51 Find the sketch. 

Click the  sign preceding the pasted feature in the 

FeatureManager design tree.

Relate and Change 
the Sketch

Since the copy has no relations to the model geometry or the origin, the 

sketch is under defined and should be brought up to a fully defined 

state. Use geometric relations to do this.

52 Edit the sketch of the copied feature.

The copied feature includes both the feature itself and its sketch. The 

sketch defines the shape and size of the profile as well as the location. 

Right-click the feature or its sketch, and select Edit Sketch.
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53 Relation and dimension.

The circle and the diameter dimension are in 

the sketch. No other relations or dimensions 

exist to locate the circle. Delete the 

dimension.

Click Add Relation . Select the edge of the 

circle and the edge of the solid and use 

Concentric. Or, use Coincident to align the 

origin and circle centerpoint.

Add a concentric circle dimension by 

dimensioning the circle and edge. The sketch 

is now fully defined.

54 Rebuild the model.

To cause the changes to the sketch to take effect, 

Rebuild the model by clicking the Rebuild  tool.

Rename the feature Ratchet Hole.
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55 Fillets.

Add fillets on edges and faces as shown below.

Editing the Fillet 
Feature

The last fillet to create is around the upper and lower edges of the 

Head. Since this fillet has the same radius as the fillet on the ends of 

the Handle, we will edit this existing fillet to include the edges on the 
Head. This is a better technique than creating a new fillet and trying to 
figure out how to keep their radii equal. To do this we will edit the 

definition of the H End Fillets.

R = 3mm

Name = Handle Fillets

R = 1mm

Name = H End Fillets

R = 2mm

Name = T-H Fillets
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56 Select and edit the fillet.

Right-click the feature H End Fillets, 
and select Edit Feature. Select the 

additional edges around the upper and 

lower edges of the Head. The 
selection list should now indicate a 

total of 6 edges selected.

57 Save and close the part. 
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Exercise 12:
Tool Holder

This lab reinforces the following skills:

� Symmetry in the Sketch on page 119.

� Mid Plane Extrusion on page 121.

� Introducing: Sketched Circles on 

page 124.

� Trim and Extend on page 136.

� Copy and Paste Features on 

page 144.

Units: millimeters

Design Intent Some aspects of the design intent for this part are:

1. All fillets and rounds are R2mm unless otherwise noted.

2. Circular edges of equal radii/diameter should remain equal.

Dimensioned 
Views

Use the following graphics with the design intent to create the part.
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Exercise 13:
Symmetry and 
Offsets 1

Use offsets and symmetry to complete 

the part.

This lab reinforces the following skills:

� Introducing: Insert Centerline on 

page 119. 

� Symmetry after Sketching on 

page 120.

� Sketching an Offset on page 135.

Units: millimeters

Dimensioned 
Views

Use the following graphics with the design intent to create the part.
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Exercise 14:
Ratchet Handle 
Changes

Make changes to the part created in 

the previous lesson.

This exercise uses the following 

skills:

� Trim and Extend on page 136. 

Design Intent Some aspects of the design intent for this part are:

1. The part must remain 

symmetrical about the Right 
plane.

2. The Transition requires 
flats that are driven by the 

distance between them.

Procedure Open an existing part.

1 Open the part Ratchet 
Handle Changes.
The change will take place 

in the shape of the 

Transition feature.

Transition
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2 Edit the sketch.

Right-click the Transition feature from the screen and choose Edit 

Sketch. Modify the sketch to add the equally spaced horizontal flats 

8mm apart. Exit the sketch.

3 Edit Feature.

Edit the H End Fillets feature to 
add more edges. Select the four 

new edges created by the flats. 

Click OK.

4 Resulting fillets.

The new edges become part of the 

fillet feature, causing the shape of 

the next fillet feature to update.

5 Save and close the part.
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Exercise 15:
Symmetry and 
Offsets 2

Use offsets and symmetry to 

complete the part.

This lab reinforces the following 

skills:

� Introducing: Insert Centerline 

on page 119. 

� Symmetry after Sketching on 

page 120.

� Introducing: View Normal To 

on page 123.

� Sketching an Offset on 

page 135.

� Introducing: Offset From 

Surface on page 139.

� Measuring on page 141.

Procedure Open the existing part Offset_Entities and create the geometry as 

shown in the following steps.

1 Offset entities. 

Use Offset Entities to create the sketch geometry shown.
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2 Offset from surface. 

Use a Cut Extrude with an Offset From Surface of 10mm. Select the 

hidden face using Select Other. 

This cutaway shows the results of the offset from surface option. The 

Measure tool can be used to check this value. 



SolidWorks 2011 Exercise 15
Symmetry and Offsets 2

155

3 Offset. 

Create a new sketch and offset the face 2mm. 

4 Offsets with symmetry. 
Use View Normal To to orient the part. Use Offset Entities, Center 

lines and Mirror Entities to create and mirror sketch geometry as 

shown. Use a Cut Extrude Through All. 

5 Save and close the part.
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Exercise 16:
Up To Surface

Use symmetry and an up to surface end 

condition to complete the part.

This lab reinforces the following skills:

� Introducing: Dynamic Mirror on 

page 119. 

� Up To Next vs. Up To Surface on 

page 126. 

Units: millimeters

Procedure Open an existing part named Up_To_Surface.

1 Sketch. 

Using Plane2, create the geometry below using lines and symmetry. 
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2 Extrude with direction.

Extrude the sketch. Click in the Direction of Extrusion field and select 

the blue sketch line as shown. Set the Depth to 28mm. 

3 Up to surface. 

Sketch on Plane1 and create the circle dimensioned as shown. Extrude 

the sketch Up To Surface and select the pink face to terminate the 

extrusion. 
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4 Fillets.

Add fillets as shown below. 

5 Save and close the part.

R12mm

R3mm

R3mm
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Exercise 17:
Idler Arm

Create this part using the dimensions provided. Use 

relations where applicable to maintain the design 

intent. Give careful thought to the best location for 

the origin. 

The only reference planes required for this part are 

Top, Front and Right.

This lab uses the following skills:

� Symmetry in the Sketch on page 119.

� Mid Plane Extrusion on page 121.

� Introducing: Sketched Circles on page 124.

� Extruding Up To Next on page 126.

� Copy and Paste Features on page 144.

Units: millimeters

Design Intent The design intent for this part is as follows:

1. The part is symmetrical.

2. Front holes are on the centerline.

3. All fillets and rounds (highlighted red above) are R3mm unless 

noted.

4. Center holes in Front and Right share a common centerpoint.

Dimensioned 
Views

Use the following graphics with the design intent to create the part. 
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Exercise 18:
Pulley

Complete this part using the dimensions provided. Use 

relations where applicable to maintain the design 

intent.

This lab uses the following skills:

� Symmetry in the Sketch on page 119.

� Mid Plane Extrusion on page 121.

� Draft Toggle on page 121.

� Introducing: Sketched Circles on page 124.

Optional 
Sketching

If you would like to use the existing geometry, skip to Procedure. If 

you would like to create the sketches, open a new mm part and use the 

dimensions below. There are three sketches required, the first created 

on the Front Plane, the remaining two on the Right Plane.

Procedure Open an existing part named Pulley.

1 Extrusion with draft.
Extrude the Base sketch (red) 
10mm using the Mid-plane end 

condition and 6° of draft.

Front Plane Right Plane
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2 Hanger.

Use the Hanger (blue) sketch and another Mid-
plane extrusion of 4mm with the same amount of 

draft.

3 Cut and hole.

Create a cut using the Center Cut sketch (green). 
The cut is Through All in both directions.

Add a 5mm diameter hole.

Add the fillet (1mm) to the bottom edges after the 

cut.

Create a third Through All cut, 3mm, centered 

above the origin.
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4 Fillets.

Add fillets of 1mm and 

0.5mm as shown. Note 

that these fillets are very 

order dependent; the 

1mm fillets must 

precede the 0.5mm 

ones.

5 Save and close the 
part.

0.5mm

1mm
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Lesson 5
Patterning

Upon successful completion of this lesson, you will be able to:

� Create a linear pattern.

� Add a circular pattern.

� Use geometry patterns properly.

� Create a mirror pattern.

� Use the pattern seed only option with a linear pattern.

� Add a sketch driven pattern.

� Automate the process of fully defining a sketch.
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Why Use 
Patterns?

Patterns are the best method for creating multiple instances of one or 

more features. Use of patterns is preferable to other methods for several 

reasons.

� Reuse of geometry

The original or Seed feature is created only once. Instances of the 

seed are created and placed, with references back to the seed.

� Changes
Due to the seed/instance relationship, changes to the seed are 

automatically passed on to the instances.

� Use of Assembly Component 
Patterns
Patterns created at the part level are 

reusable at the assembly level as 

Feature Driven Patterns. The pattern 

can be used to place component parts 

or sub-assemblies.

� Smart Fasteners

One last advantage of patterns is to 

support the use of Smart Fasteners. 

Smart Fasteners are used to 

automatically add fasteners to the 

assembly. These are specific to holes.

Comparison of 
Patterns

There are many types of patterns available in SolidWorks and the 

following table is intended to highlight the typical uses for each type. 

Note This table lists all types of patterns; not all of them are shown as case 

studies.

� Seed

The seed is the geometry to be patterned. It can be one or more 

features, bodies or faces.

� Pattern Instance

The Pattern Instance (or just Instance) is the “copy” of the seed 

created by the pattern. It is in fact much more than a copy because it is 

derived from the seed and changes with the seed. 
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Types of Patterns The pattern types and how they are typically used are listed in the table 

below. 

Pattern Type: Typical usage: Key:
Seed = 

Pattern Instance = 

Linear  . . . . . . . . 
One-directional array with equal 

spacing.

Linear  . . . . . . . . 
Two-directional array with equal 

spacing.

Linear  . . . . . . . . 
Two-directional array; pattern 

seed only.

Linear  . . . . . . . . 
One- or two-directional array. 

Selected instances removed.

Circular . . . . . . . 
Circular array with equal spacing 

about a center.
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Circular . . . . . . . 
Circular array with even spacing 

about a center. Selected 

instances removed or angle less 

than 360°.

Mirror. . . . . . . . . 
Mirrored orientation about a 

selected plane. Can use selected 

features or the entire body.

Table Driven . . . 
Arrangement based on a table of 

XY locations from a coordinate 

system.

Sketch Driven . . 
Arrangement based on the 

positions of points in a sketch.

Curve Driven. . . 
Arrangement based on the 

geometry of a curve. 

Curve Driven. . . 
Arrangement of full or partial 

circular path.
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Pattern Options Pattern features share several options. They are unique to this class of 

feature and will be discussed in detail later in this lesson.

Curve Driven. . . 
Arrangement based on the 

geometry of a projected curve.

Fill . . . . . . . . . . . 
Arrangement of instances to 

pattern based on a face.

Fill . . . . . . . . . . . 
Arrangement of shapes to pattern 

based on a face.

Pattern 

Feature

Select Feature, 

Bodies or 

Faces

Propagate 

Visual 

Properties

Pattern 

Seed 

Only

Skip 

Instances

Geometry 

Pattern

Vary 

Sketch

Use 

Shapes

Linear � � � � � �

Circular � � � �

Mirror � � �

Table 

Driven
� � �
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Note The sketch options Linear Sketch Pattern  and Circular Sketch 

Pattern  can be used within a sketch to create copies of sketch 

geometry. They do not create pattern features.

Flyout 
FeatureManager 
Design Tree

The flyout FeatureManager design tree enables you to view both the 

FeatureManager design tree and the PropertyManager at the same time. 

This enables you to select features from the FeatureManager design 

tree when it would otherwise be obscured by the PropertyManager. It is 

also transparent, overlaying the part graphics.

The flyout FeatureManager design tree is activated automatically with 

the PropertyManager. It may appear collapsed and can be expanded by 

clicking on the plus “+” sign prefix.

Pattern 

Feature

Select Feature, 

Bodies or 

Faces

Propagate 

Visual 

Properties

Pattern 

Seed 

Only

Skip 

Instances

Geometry 

Pattern

Vary 

Sketch

Use 

Shapes

Sketch 

Driven
� � �

Curve 

Driven
� � � � � �

Fill Features and 

Faces only
� � � � �
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Reference 
Geometry

There are two types of Reference Geometry that are useful in creating 

patterns: Temporary Axes and Axes.

Temporary Axes Every cylindrical and conical feature has an axis associated with it. 

View the temporary axes of the part using View, Temporary Axes. 

One axis is displayed through each circular face in the model. 

Axes Axes are features that must be created using one of several methods. 

The advantages to creating an axis is that it can be renamed, selected by 

name from the FeatureManager design tree, and resized. 

Where to Find It � Click Axis  on the Reference Geometry toolbar.

� Or, click Insert, Reference Geometry, Axis....

Temporary Axes 

can be made 

permanent and 

given unique 

names using the 
One Line/Edge/

Axis option.

Select two planes 

or planar faces 

and the option 

Two Planes.

Select Two 

Points/Vertices 

to define an axis 

through them. 
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Linear Pattern The Linear Pattern tool creates copies, or instances, in a linear pattern 

controlled by a direction, a distance and the number of copies. The 

instances are dependent on the originals. Changes to the originals are 

passed on to the instanced features.

Introducing: 
Linear Pattern

Linear Pattern creates multiple instances in one- or two-dimensional 

arrays. The axis can be an edge, axis, temporary axis or linear 

dimension. 

Where to Find It � On the Features toolbar, click the Linear Pattern tool  from the 

Pattern flyout tool . 

� From the Insert menu, choose: Pattern/Mirror, Linear Pattern....

1 Open the part named 
Grate.
The part contains the seed 

feature that will be used in the 

pattern.

Select a 
Cylindrical/

Conical Face to 

define an axis 

through the 

rotational center.

Select a plane or 

planar face and a 

point or vertex to 

define an axis 

normal to the 

plane through the 

point.
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2 Direction 1.

Click Insert, Pattern/

Mirror, Linear Pattern.

Select the linear edge of 

the part and click the 

Reverse Direction , 

if necessary, to set the 

direction shown. Set the 

Spacing to 2” and 

Number of Instances 

to 5.

Select the three features shown in Features to Pattern.

Note The callout is attached to the geometry used to 

define the pattern direction or axis. It contains 

the key settings for Spacing and Instances 

and is editable. Double-click the setting to 

change and retype the value.

Right-click the callout to access other pattern 

commands such as Reverse Direction and 

Geometry Pattern.

3 Direction 2.

Expand the Direction 2 group box and select 

another linear edge. Set the Spacing and 

Instances as shown.



Lesson 5 SolidWorks 2011
Patterning

172

Deleting Instances Instances that are generated by the pattern can be deleted by selecting a 

marker at the centroid of the instance shown in the pattern preview. 

Each instance is listed in array format (2,3) for identification. 

The seed feature cannot be deleted.

4 Instances to Skip.

Expand the Instances to Skip group box and select the six center 

instance markers. The tooltip shows an array location that is added to 

the list when selected.

5 Completed pattern.
Click OK to add the pattern feature LPattern1.
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Geometry Patterns The Geometry Pattern option is used to minimize rebuild time by 

using the Seed geometry for all Instances in the pattern. It should only 

be used when the geometry of the seed and the instances are of 

identical or similar shape.

� Without Geometry 
Pattern

If the Geometry 

Pattern option is 

cleared, the end 

condition of the seed is 

used in the instances. In 

this example, the Offset 

From Surface end 

condition of the blue 

seed feature is applied 

in the orange instances, 

forcing them to use the same end condition.

� With Geometry 
Pattern

If the Geometry 

Pattern option is 

checked, the geometry 

of the seed is used. The 

geometry is copied 

along the pattern, 

ignoring the end 

condition.

6 Geometry Pattern.

Right-click the Linear Pattern feature and choose 

Edit Feature . Check the Geometry pattern 

option and click OK. Because the plate is constant 

thickness, the resulting geometry will look the 

same.

7 Save and close the part.
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Circular 
Patterns

The Circular Pattern tool creates copies, or instances, in a circular 

pattern controlled by a center of rotation, an angle and the number of 

copies. Changes to the originals are passed on to the instanced features.

Introducing: 
Circular Pattern

Circular Pattern creates multiple instances of one or more features 

spaced around an axis. The axis can be an circular face, edge, axis, 

temporary axis or angular dimension.

Where to Find It � On the Features toolbar, click the Circular Pattern tool  from the 

Pattern flyout tool . 

� From the Insert menu, choose: Pattern/Mirror, Circular Pattern....

1 Open the part named Circular_Pattern.

2 Pattern Axis. 

Click Insert, Pattern/Mirror, Circular 

Pattern....

Click in Pattern Axis and select the cylindrical 

face of the model as shown. 

Tip To use a temporary axis as the pattern axis, 

click View, Temporary Axes or click the on-

screen menu option. 
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3 Settings.

Click in Features to Pattern 

and select the three features 

shown for 

Features to Pattern. 

Click Equal Spacing, 

4 instances and click 

Geometry pattern.

Check that the Angle is set to 

360° and click OK. 

Note The Reverse 

Direction option  is 

meaningful only when 

an angle other than 

360° is used.

4 Save and close the part.
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Mirror Patterns The Mirror Pattern tool creates a copy, or instance, across a plane or 

planar face. The instance is dependent on the original. Changes to the 

original propagate down to the mirrored instance(s).

Introducing: 
Mirror Pattern

Mirror Pattern creates one instance of one or more features or a body 

across a plane. The plane can be a plane or planar face.

Where to Find It � On the Features toolbar, click the Mirror Pattern tool  from the 

Pattern flyout tool . 

� From the Insert menu, choose: Pattern/Mirror, Mirror....

Patterning a Solid 
Body

To mirror all the geometry of a part about a common face, select the 

common face as Mirror Face/Plane and the solid body as Bodies to 

Mirror. The common face must be planar. 

1 Open the part named Mirror_Pattern.

2 Mirror.

Click Insert, Pattern/

Mirror, Mirror and the 

Right plane. Select the 
library feature Keyed 
Hole 1 as the 
Features to Mirror.

Click OK.

Note Geometry Pattern can also be used with 

this feature.

3 Save and close the part.
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Using Pattern 
Seed Only

The Pattern Seed Only option is used when a two direction pattern is 

created. The second direction defaults to patterning all geometry 

created by the first direction unless Pattern Seed Only is used to 

pattern only the original or seed geometry. It is commonly used to 

prevent overlapping results when the two directions use the same 

vector.

1 Open the part named Seed_Pattern.

2 Direction 1.

Click Insert, Pattern/Mirror,

Linear Pattern.... Select the 

linear edge as the Pattern 

direction and 30mm as the 

Spacing, 2 as the 

Number of Instances.

For Features to Pattern, 

select the library feature 

3_Prong_Plug2.

Note An existing pattern feature can be used as the Features to Pattern. 

This enables you to pattern the pattern.

3 Direction 2.

For Direction 2, select 

the linear edge on the 

opposite side as the 

direction, reversing the 

arrowhead. Set the 

instances to 2, spacing 

to 50mm.

Note As seen in the preview, the original (seed) feature is patterned in both 

directions. 
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4 Pattern seed only.

Click Pattern seed 

only to remove the extra 

instance.

Set the Direction 2 

Spacing to 30mm.

5 Save and close the part.

Sketch Driven 
Patterns

The Sketch Driven 

Patterns tool creates 

copies, or instances, in 

a linear arrangement 

controlled by sketch 

points. The pattern can 

be based on the 

centroid of the seed or 

a selected point off the 

centroid.

This example 

represents the holes in 

a structural steel plate.

Note This pattern is intended for use where a linear type of pattern is 

required but the standard Linear Pattern feature can not easily be 

utilized.

Introducing: Sketch 
Driven Pattern

Sketch Driven Pattern creates multiple instances based on points in a 

selected sketch. The sketch must exist before the pattern is created.

Where to Find It � On the Features toolbar, click the Sketch Driven Pattern tool .

� From the Insert menu, choose: Pattern/Mirror, Sketch Driven 

Pattern....

Tip Only point geometry is used by the Sketch Driven pattern. Other 

geometry, such as construction lines, can be used to position points but 

will be ignored by the pattern.
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1 Open Sketch_Driven.
The part contains a seed feature (Hole) and an 
existing linear pattern feature (Standard 
Linear).

Introducing: Point The Point tool creates point entities in the active sketch. The sketch 

entity Point can be used to locate a position in a sketch that other 

geometry (endpoints for example) cannot.

Where to Find It � On the Sketch toolbar click the Point tool .

� From the Tools menu choose: Sketch Entities, Point.

2 Sketch with points.

Open a new sketch on the top 

face of the Plate feature. 
Create the centerline and add 

the points and dimensions as 

shown. 

Close the sketch. 
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3 Sketch driven pattern.

Click Sketch Driven 

Pattern  and select the 

new sketch and the 

Centroid option. Under 

Features to Pattern, 

select the Hole feature and 
click OK.

4 Add points.

Create another sketch and add points in the 

pattern shown, using inferencing to line up the 

rows horizontally as shown.

Note Points cannot be added directly to existing sketch endpoints. The 

message 

Sketch points cannot be added at the same location as an 
existing point. 

will appear if you try. Instead, place the points off the geometry and 

drag and drop them onto the endpoints later.
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Automatic 
Dimensioning of 
Sketches

Fully Define Sketch creates relations and dimensions in a sketch. 

Several dimension styles, such as baseline, chain and ordinate are 

supported. The starting points for horizontal and vertical sets can be 

set.

Introducing: Fully 
Define Sketch

Fully Define Sketch has options for dimension type, entities to be 

dimensioned and starting points.

Note A special option Centerline appears when centerline geometry is used 

in the sketch. Dimensions can be based from the centerline.

Where to Find It � Click Tools, Dimensions, Fully Define Sketch....

� Or, on the Dimensions/Relations toolbar, click Fully Define 

Sketch .

� Or, right-click in the sketch, and choose Fully Define Sketch.

Under defined sketch with 

geometric relations.

Chain option selected with 

start point at origin.

Note: Some dimensions 

have been moved for 

clarity.

Baseline option selected 

with start points at origin.

Ordinate option selected 

with start points at origin.
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5 Relation and dimension 

setup.

Click the Fully Define 

Sketch  tool.

Leave the Relations as 

default, Select all.

In Dimensions, select the 

endpoint of the sketch 

centerline as the datum for 

dimensions in both 

directions.

Set both Schemes to 

Baseline.

Click Calculate and OK.

6 Relations and dimensions.

Horizontal relations and 

dimensions are added to fully 

define the sketch.

Set the values as shown and 

close the sketch. 

Note Sketches dimensioned this way are fully defined but can be edited. You 

can delete and replace dimensions if required.

7 Pattern.

Add another sketch driven pattern using the new 

sketch and the same seed feature, Hole.

8 Save and close the part.
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Exercise 19:
Linear Patterns

Create feature patterns in this part 

using a Linear Pattern.

This lab uses the following skills:

� Linear Pattern on page 170.

� Deleting Instances on page 172.

Procedure Open an existing part.

Note This part has been copied for use in linear, table driven and sketch 

driven patterns.

1 Open the part Linear 
Pattern.
The part includes the “seed” 

feature used in the patterns.

2 Linear pattern.
Create a pattern using the seed. Use the dimensions below.

3 Save and close the part.
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Exercise 20:
Sketch Driven 
Patterns

Create feature patterns in this part 

using a Sketch Driven Pattern.

This lab uses the following skills:

� Sketch Driven Patterns on 

page 178.

Procedure Open an existing part.

1 Open the part
Sketch Driven Pattern.
The part includes the “seed” 

feature used in the patterns.

2 Sketch driven pattern.

Use the dimensions below to define the sketch used with the Sketch 

Driven Pattern.

3 Save and close the part.
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Exercise 21:
Skipping 
Instances

Complete this part using the 

information and dimensions provided.

This lab reinforces the following skills:

� Linear Pattern on page 170.

� Deleting Instances on page 172.

Units: millimeters

Procedure Create a new part.

1 Base feature.

Create a block 

75mmx320mmx20mm. 

It will be useful to have a 

plane centered along the long direction.

2 Seed.

Create the seed feature using the Hole 

Wizard and an ANSI MM drill.

3 Pattern.

Pattern the hole, skipping instances as shown in the diagram below.

4 Pattern of a pattern.
Pattern the pattern to create a symmetrical arrangement of holes.

5 Change.

Change the hole to 8mm diameter and rebuild.

6 Save and close the part.
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Exercise 22:
Linear and 
Mirror Patterns

Complete this part using the information and 

dimensions provided.

This lab reinforces the following skills:

� Linear Pattern on page 170.

� Mirror Patterns on page 176.

� Patterning a Solid Body on page 176.

Procedure Open the existing part Linear & Mirror.

1 Linear pattern.

Using the existing feature, create a Linear Pattern 

that results in three grooves that are spaced 0.20”.

2 Mirror features.

Using a single pattern feature, create the duplicate 

boss and cut as shown.

3 Symmetry.

Use a third pattern feature to create the full model 

from the half model using Bodies to Mirror. 

4 Save and close the part.
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Exercise 23:
Circular 
Patterns

Complete this part using the 

information and dimensions 

provided.

This lab reinforces the following 

skills:

� Circular Patterns on 

page 174. 

Procedure Open the existing part Circular. 
Use an equally spaced circular 

pattern to pattern the cut and 

fillet for 12 total instances. 
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Lesson 6
Revolved Features

Upon successful completion of this lesson, you will be able to:

� Create revolved features.

� Apply special dimensioning techniques to sketches for revolved 

features.

� Use the multibody solid technique.

� Create a sweep feature.

� Calculate the physical properties of a part.

� Perform rudimentary, first pass stress analysis.
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Case Study: 
Handwheel 

The handwheel requires 

the creation of revolved 

features, circular 

patterns and sweep 

features. 

Also included in this 

lesson are some basic 

analysis tools. 

Stages in the 
Process

Some key stages in the modeling process of this part are shown in the 

following list. 

� Design intent
The part’s design intent is outlined and explained.

� Revolved features
The center of the part is the Hub, a revolved shape. It will be created 
from a sketch with a construction line as the axis of revolution.

� Multibody solids

Create two discrete solids, the Hub and the Rim, connecting and 

merging them using a third solid, the Spoke.

� Sweep features

The Spoke feature is created using a sweep feature, a combination of 

two sketches that define a sweep profile moving along a sweep path.

� Analysis
Using analysis tools, you can perform basic analysis functions such as 

mass properties calculations and first-pass stress analysis. Based on the 

results, you can make changes to the part’s design.
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Design Intent The design intent of this part is shown below:

� Spokes must be evenly spaced.

� The center of the rim of the handwheel lies at the end of the spoke.

� The spokes pass through the center of the hub.

Revolved 
Features

The Hub is a revolved feature. It is the first feature created by 
revolving geometry around an axis. Revolved features require 

axisymmetric geometry and a line (used as the axis) in the sketch. This 

revolved feature will be used as the center of the wheel. Under the right 

circumstances, a sketch line may also be used as the centerline.

Procedure To begin this case study:

1 Open a new part using the Part_MM template.

Sketch Geometry 
of the Revolved 
Feature

Geometry for the revolved feature is created using the same tools and 

methods as extruded features. In this case, lines will be used to form the 

shape – a cylinder with a chamfered edge. The centerline is used as the 

axis of revolution and for locating geometry.

2 Rectangle.

Right-click the Right Plane and select Sketch. 

Create a rectangle from the Origin approximately 

50mm high by 30mm wide.

Rim

Handwheel
Hub

Spoke

Diameter
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3 Convert to construction.

Select the vertical line shown and click For 

Construction. The line is converted into a 

construction line.

Introducing:
3 Point Arc

The 3 Point Arc option enables you to create an arc based on three 

points, the two endpoints followed by a point on the curve.

Where to Find It � From the Tools menu, choose Sketch Entities, 3 Point Arc.

� Or, on the Sketch toolbar, click 3 Point Arc .

4 Insert 3 Point Arc.

Begin the arc by positioning the 

cursor on the left vertical line and 

dragging downwards along that 

edge. Release the mouse button 

and then select and drag the point 

on the curve away from the 

sketch.

5 Trimming.

Use the Trim tool with the Power Trim option and 

trim away the portion of the line inside the arc.

Rules Governing 
Sketches of 
Revolved Features

In addition to the general rules governing sketches that 

were listed in Lesson 2: Introduction to Sketching, some 

special rules apply to sketches of revolved features:

� A centerline, axis or sketch line must be specified as 

the axis of revolution.

� The sketch must not cross the axis.

Note that in this example, the right vertical sketch line 

could be used as the axis of revolution.

Not Valid
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Dimensioning the 
Sketch

Revolved geometry is dimensioned like any other with one additional 
option. Dimensions that measure diameters on the finished feature can 
be changed from linear to diameter dimensions.

6 Arc dimension.

Dimension the arc by selecting the vertical and 

then Shift-selecting the circumference of the 

arc. The result is a dimension between the line 

and the tangent of the arc. Using the Shift key 

selects the edge rather than the center of the 

circle or arc.

7 Finished dimension.

Change the Value to 4mm.

8 Vertical dimensions.

Right-click empty space and select More 

Dimensions and Vertical . Create the vertical 

linear dimensions shown at the right. 

The Smart Dimension icon will also work.

Diameter 
Dimensions

Some dimensions should be diameter dimensions in the finished 
revolved feature. For these dimensions, always select the centerline 
(axis of revolution) as one of the picks. You then have your choice of 
either a radius or diameter dimension, depending on where you place 
the dimension text. If you don’t pick the centerline, you won’t be able 
to change the dimension to a diameter.

Note This option is available only if a centerline is used as the axis of 
revolution. Diameter dimensions are not restricted to use in revolved 
feature sketches.
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9 Dimension to centerline.

Dimension between the centerline and the 

outer vertical edge to create a horizontal 

linear dimension.

Do not click to place the dimension text just 

yet.

Notice the preview. If you place the text now, 

you will get a radius dimension.

10 Move the cursor.

Move the cursor to the right of 

the centerline. The preview 

changes to a diameter 

dimension.

11 Resulting dimension.

Click to place the dimension text. Change 

the value to 25mm and press Enter.

Normally, a diameter dimension should 

have a diameter symbol preceding it, 

thus: . When the revolved feature is 

created from the sketch, the system will 

automatically add the diameter symbol to 

the 25mm dimension.

Note If you inadvertently place the dimension text in the wrong place, and 

get a radius dimension instead of a diameter you can fix it. Click the 

dimension, and click the Leaders tab of the Dimension 

PropertyManager. Click the Diameter button  to make the 

dimension a diameter dimension.
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Creating the 
Revolved Feature

Once the sketch is completed, it can be made into a revolved feature. 

The process is simple, and a full (360°) revolution is almost automatic.

Introducing: 
Revolved Feature

The Revolve option enables you to create a feature from an 

axisymmetric sketch and an axis. This feature can be a base, boss or cut 

feature. The axis can be a centerline, line, linear edge, axis or 

temporary axis. If only one axis selection is present, it is used 

automatically. If more than one is present, you must select it.

Where to Find It � From the Insert menu, choose Boss/Base or Cut, Revolve....

� Or, on the Features toolbar, choose Revolved Boss/Base .

12 Make the feature.
Click Boss/Base, Revolve... from the Insert menu. 

A message will appear indicating that the sketch is an open contour and 

asking if you want to close the contour automatically. Click Yes.

The PropertyManager appears 

with these default end conditions:

One Direction

Angle 360°

Accept these defaults by clicking 

OK.

13 Finished feature.

The solid revolved feature is created as the first feature 

of the part.

Rename it Hub.
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14 Edit the sketch.

Right-click the Hub and select Edit Sketch.

Note You can also right-click the feature in the 

FeatureManager design tree and achieve the same 

result.

15 Normal To.

Click Normal To  on the Standard Views toolbar to change the view 

so you can see it’s true size and shape. 

Introducing:
Sketch Fillet 

Sketch Fillets can be used to trim and add tangent arcs in a single step. 

If the corner has been trimmed, select the vertex point to add the fillet. 

Where to Find It � From the Tools menu, choose Sketch Tools, Fillet.

� Or, on the Sketch toolbar, click Sketch Fillet .

16 Fillet settings.

Select the Sketch Fillet  tool and set the value to 

5mm. Make sure the Keep constrained corners 

option is checked.

17 Selections.

Select both endpoints of the arc, as 

indicated. When each is selected, the 

fillet will appear. The dimension 

drives both but only appears once, at 

the first selection. Click OK. 

Since the endpoints that were filleted 

had dimensions, Virtual Sharp 

symbols are added where the corners 

were. These symbols represent the 

missing corners and can be 

dimensioned to or used within relations.

Pick here
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18 Rebuild the model.

To cause the changes to take effect click the 

Rebuild  tool.

Building the 
Rim 

The Rim of the Hand-
wheel is another revolved 
feature. It too is revolved 

360°. The profile of the 

Rim is a slot shape. 

The Rim will be created as 

a separate solid body, not 

merged to the Hub.

19 Sketch.

Create a new sketch on the Right plane. Orient the model in the same 

direction.

Slots Straight and arc Slots are common 

shapes based on lines and arcs. The 

slot is a single entity which is 

composed of lines, arcs, 

construction geometry and points. 
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Introducing: Slots The Slot tool is used to create straight and arc slot shapes based on 

different criteria. There are two types based on lines and two types 

based on arcs. All slot types have the option to create dimensions with 

the geometry. The following types are available: 

Slot Type Resulting Geometry

Straight Slot The Straight Slot is created by locating 

the centerpoints of the arcs and then 

dragging outwards to create the width. 

Centerpoint Straight 

Slot 

The Centerpoint Straight Slot is created 

by locating the geometric center, one of 

the arc centerpoints and then dragging 

outwards to create the width. 

3 Point Arc Slot The 3 Point Arc Slot is created like a 3 

Point Arc (see Introducing: 3 Point Arc 

on page 192) and then dragging outwards 

to create the width.

Centerpoint Arc Slot The Centerpoint Arc Slot is created like 

a Centerpoint Arc (see Sketch Geometry 

on page 33) and then dragging outwards to 

create the width.
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Where to Find It � From the Tools menu, choose Sketch Entities, Straight Slot, 

Centerpoint Straight Slot, 3 Point Arc Slot or Centerpoint Arc 

Slot. 

� Or, on the Sketch toolbar, choose Straight Slot , Centerpoint 

Straight Slot , 3 Point Arc Slot  or Centerpoint Arc Slot . 

20 Centerpoint Straight Slot.

Click Centerpoint Straight 

Slot . Click Add 

dimensions and Overall 

Length. Click the location of 

the centerpoint and a location 

horizontally to the right. Drag 

the width and click OK. 

Tip The dimensions are added automatically if the Add dimensions option 

is clicked. 

21 Rotation axis.
Add a centerline using the 

Centerline  tool, setting 

Vertical and Infinite length. 

Place the line at the origin. 

This will be the axis of 

revolution for the revolved 

feature.

22 Add dimensions.

Add dimensions from 

the centerline to the 

point in the slot and the 

arc center to the Hub 
edge.

The sketch is now fully 

defined.
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Potential Ambiguity This sketch contains two centerlines. The system will not know which 

centerline is intended to be the axis of revolution. The centerline to be 

used can be selected either before or after selecting the Revolve tool.

23 Completed feature.

Select the infinite vertical 

centerline. From the Insert 

menu, choose Boss/Base, 

Revolve.... Use an angle of 

360°.

Rename the feature to Rim.

Multibody Solids Multibody solids occur when there is more 

than one solid body in a part. In cases where 

discrete features are separated by a distance, 

this can be the most efficient method in 

designing a part.

The Solid Bodies folder holds the bodies and also 
lists how many bodies are currently housed in the 

folder (2). The bodies can be merged or combined 

later to create a single solid body.

For more information on multibody parts, see the 

Advanced Part Modeling training manual.

Building the 
Spoke 

The Spoke feature is created using a Sweep feature. The sweep pushes 
a closed contour Profile along an open contour Path. The Path is 

sketched using lines and tangent arcs. The profile is then sketched 

using a circle. The feature will bridge the space between the existing 

Hub and Rim features and combine them into a single solid body.

The Spoke feature is important because it will be patterned to create 

any number of evenly spaced spokes.
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24 Show using the display pane. 

Use the FeatureManager Search box 

 to search by the 

starting letters of a name or some portion 

of the name. 

Type ske into the FeatureManager Design Tree filter to show the 

sketches of the Hub and Rim. 

Click  to expand the Display Pane. Click on the sketch icon for the 

Hub to show it. Repeat for the Rim. 

Click the “x” to clear the FeatureManager Design Tree filter and close 

the pane. 

25 Setup.

Setup for sketching:

� Create a new sketch using the Right plane.
� Change the display to Hidden Lines Visible.

26 Sketch line.

Sketch a horizontal Line 

running from the centerline 

inside the Hub boundaries.

27 Tangent arc.

Create a Tangent Arc from 

the line endpoint in the 

direction shown. The actual 

values are not important as 

you sketch. They will be 

defined by dimensions later.

28 Connecting tangent arc.

With Tangent Arc still 

selected, continue sketching 

by using the previous arc’s 

endpoint as a start. Sketch this 

arc tangent to the first, ending 

at a horizontal tangency posi-

tion.

Tip When the vertical inference line coincides with the arc’s center, the 

tangent of the arc is horizontal.
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29 Horizontal line.

Sketch a final Line. It is 

horizontal, with its length 

to be determined by 

dimensioning.

30 Relations.

Drag and drop the left 

endpoint of the line onto the 

point of the Rim sketch. A 

Coincident relation is added.

Add another relation between 

the line at the opposite end 

and the centerpoint of the arc.

31 Return to a shaded display.

Click Shaded  and hide the Hub and Rim sketches. 

Completing the 
Path and Profile 
Sketches

The geometry sketched will act as the path for the profile sketch.

32 Add dimensions.

Add an Equal relation to the 

arcs. Dimensions are added 

to define the shape. Picking 

end points and center points 

allows for more options 

when creating the 

dimensions.

33 Exit sketch.

Right-click in the sketch and choose Exit Sketch  to close the sketch 

without using it in a feature.
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Introducing: 
Insert Ellipse

Sketching an ellipse is similar to sketching a circle. Position the cursor 

where you want the center and drag the mouse to establish the length of 

the major axis. Then release the mouse button. Next, drag the outline of 

the ellipse to establish the length of the minor axis.

Important! To fully define an ellipse you must dimension or otherwise constrain 

the lengths of the major and minor axes. You must also constrain the 

orientation of one of the two axes. One way to do this is with a Hori-

zontal relation between the ellipse center and the end of the major axis.

Where to Find It � Click Tools, Sketch Entities, Ellipse.

� Or, click Ellipse  on the Sketch Tools toolbar.

34 Ellipse.

Create a new sketch on 

the Front plane. Click 

Ellipse  and position 

the centerpoint at the end 

of the line. Move away 

from center and position 

the major and minor axes 

with additional clicks.

35 Relations and 
dimensions.

Add relations to make the 

centerpoint and one of the 

major axis points 

Horizontal. Add the 

dimensions as shown.

Exit the sketch.

Introducing: Sweep Sweep creates a feature from two sketches: a sweep section and sweep 

path. The section is moved along the path, creating the feature.

Where to Find It � Click Swept Boss/Base  on the Features toolbar.

� Or, click Insert, Base/Boss, Sweep.

Note The Sweep command is covered in depth in the Advanced Part 

Modeling course.
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36 Sweep.

Click the Swept Boss/Base  icon and select the closed contour 

sketch as the Profile and the open contour sketch as the Path. 

Click OK. 

37 Results.

Name the new feature 

Spoke. The Solid 
Bodies(2) folder 
disappears. This indicates 

that the two solid bodies 

have merged into one.

38 Temporary axes.
Display the temporary axes using View, 

Temporary Axes.

39 Pattern the Spoke.
Click Circular Pattern . Select the 

temporary axis as the center of rotation for the 

pattern. 

Click in the Features to Pattern list to make 

it active. Select the Spoke.

Set the Number of Instances to 3 with Equal spacing.



SolidWorks 2011 Lesson 6
Revolved Features

205

Rotate View The Rotate View tool  enables you to rotate the view of the model 

freely. To restrict that motion, you can choose an axis, a line or edge, a 

vertex, or a plane. Click the Rotate View tool and the center axis.

The same result can be obtained using the middle mouse button 

rotation. Select the temporary axis using the middle mouse button, and 

drag with the middle mouse button.

Note If you turned off the temporary axes after you made the circular pattern, 

you will either have to turn them back on or show the Rim sketch in 

order to have an axis or line (centerline) to rotate about.

40 Rotate.

Rotate about the axis by dragging the mouse. 

Switch axes by simply clicking another axis or 

other acceptable choice.

Turn off the temporary axes.

41 Add fillets.

To complete the model, 3mm 

fillets are added to the 

highlighted faces of the model. 

Selection of a face selects all 

edges of that face.

Face selections make the model 

better suited to withstand 

dimensional changes.

Chamfers Chamfers create a bevel on the edge of a model. In many ways, 

chamfers are similar to fillets in that you select edges and/or faces in 

the same way.

Introducing:
Chamfer

Chamfer creates a bevel feature on one or more edges or vertices. The 

shape can be defined by two distances or a distance and an angle.

Note Sketch Chamfers can be added to the sketch rather than to the faces and 

edges of the solid model.

Where to Find It � From the Insert menu, choose Features, Chamfer....

� Or, on the Features toolbar, pick the Chamfer  tool.
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42 Chamfer.

Add a Chamfer 

feature using the top 

edge of the Hub 
feature. Set the 

distances using the 

values shown at right.

RealView Graphics If you have an NVIDIA, ATI or 3DLabs graphics accelerator, you may 

be able to use the RealView Graphics option. It provides high-quality, 

real time material shaders when available. 

Where to Find It � Click RealView Graphics  on the View toolbar and click the 

RealView tab of the Task Pane. 

� Or, click View, Display, RealView Graphics.

Note If you do not have RealView Graphics, skip to step 47 on page 209. 

Tip If RealView Graphics are not available, the icon will be grayed out 

and the RealView tab shown below will not be available. 

RealView On RealView Off
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Appearances, 
Scenes and Decals 

The Appearances, Scenes and Decals tab of the Task Pane contains 

three main folders: Appearances(color), Scenes and Decals.

43 RealView on.

Click RealView  to toggle it on.

44 Appearances and scenes. 

From the Appearances, 

Painted, Powder Coat 

folder, drag and drop 

aluminum powdercoat into 

the graphics window. 

From the Scenes, Basic 

Scenes folder, drag and 

drop Backdrop - Black 

with Fill Lights into the 

graphics window. 
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Tip The Apply Scene  

flyout tool on the Heads-

up View toolbar allows 

you to select and apply a 

scene from the list. 

Another option is to click 

the icon to rotate through 

the list one at a time. 

Appearances Colors and textures are applied using Appearances. This menu has 

tabs for Color/Image and Mapping. 

� Color is used to apply a color to the texture added from the 

Appearance folder. 

� Mapping is used to change the mapping style of the texture added 

from the Appearance folder. 

Where to Find It Right-click the top level part, choose Appearances and the part name. 
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45 Color. 

Right-click the top 

level part and 

choose 

Appearances and 

the part name. 

Lighten the color 

using a dull color 

swatch and light 

grey or white. Click 

OK. 

Note Applying an appearance does not apply a material to the part. For 

applying materials, see Edit Material on page 209. 

46 RealView off.

Click RealView  to toggle it off.

47 Save the part and close it.

Edit Material The Edit Material dialog is used to add and edit the material associated 

with a part. The material is used for calculations that rely on material 

properties, including Mass Properties and SimulationXpress. The 

material can vary by configuration. For more information on 

configurations, see Lesson 10: Configurations.

Tip Part templates (*.prtdot) can include a predefined material.

Where to Find It � Click Edit Material  on the Standard toolbar.

� Or, right-click the Material icon and click Edit Material. 

1 Open HW_Analysis.
Open the existing part HW_Analysis. This part has additional features 
needed for use in the analysis section of this lesson.
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2 Materials.

Click the Edit Material icon  and select Copper Alloys, Aluminum 

Bronze. 

Note The Properties, Appearance and CrossHatch are those assigned by 

the selected material. 
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3 Color. 

Click Apply and Close. 

A change in material 

changes the color of the 

part. The material name is 

also updated in the 

FeatureManager.

Mass Properties One of the benefits of working with a solid model is the ease with 

which you can perform engineering calculations such as computing 

mass, center of mass, and moments of inertia. The SolidWorks software 

does all this for you with a simple click of the mouse.

Note Section Properties can also be generated from a planar face or a 

sketch in a model. The sketch can be active or selected.

Introducing:
Mass Properties

Mass Properties is used to generate the mass properties of the entire 

solid. The properties include mass, volume and a temporary display of 

the principal axes.

Where to Find It � On the Tools toolbar, click the Mass Properties tool .

� From the Tools menu choose Mass Properties....
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4 Mass properties.

Select the Mass Properties... 

option from the Tools menu. 

The Density of Aluminum 

Bronze is used.

The results of the calculations 

are displayed in the dialog 

box.

Note For those parts that do not posses an accurate physical description, you 

can use Assigned Mass Properties. The settings include Mass and 

the location of the Center of Gravity (XYZ). 

To change the settings, click the Options... 

button, click Use custom settings, and set 

the Material Properties. This would only 

change the mass properties for this 

calculation, not the actual material 

properties set by the Material Editor. 



SolidWorks 2011 Lesson 6
Revolved Features

213

Mass Properties 
as Custom 
Properties

Components of the Mass Properties of a part can be carried with the 

part as a Custom Property. This information can be extracted by a Bill 

of Materials report.

File Properties File properties are details about Windows based files that help identify 

it – for example, a descriptive title, the author name, the subject, and 

keywords that identify topics or other important information in the file. 

Document properties can be used to display information about a file or 

to help organize files so that they can be found easily. You can search 

for documents based on document properties.

There are file properties unique to SolidWorks that are more suited to 

engineering than the default properties. Additional properties can be 

added based on the user’s needs.

Metadata File properties and attributes are sometimes referred to as Metadata.

Classes of File 
Properties

File properties can be grouped into several classes.

� Automatic

Automatic properties are maintained by the application that created 

the property. These include properties such as the date the file was 

created, last modified and file size.

� Preset
Preset properties already exist, but the user must fill in the text 

value. The preset file properties used in SolidWorks are stored in 

the file Property.txt. This file may be edited to add or remove 

preset properties.

� Custom
Custom properties are defined by the user and apply to the entire 

document.

� Configuration specific

Configuration specific properties apply only to a specific 

configuration.

� SolidWorks custom properties

There are several custom properties that can be automatically 

updated by SolidWorks. These include the part’s mass and material.

Tip Preset properties can accept text, date, yes/no and numerical data.

Where to Find It � Click File, Properties.



Lesson 6 SolidWorks 2011
Revolved Features

214

Creating File 
Properties

File properties can be created directly in the file, or they can be created 

by other procedures.

� Direct method
File properties are added directly to the file by the user.

� Design tables

Design tables can create custom properties using a column header 

$PRP@property where property is the name of the property to be 

created and populated with the information created in the design 

table.

� SolidWorks Workgroup PDM

SolidWorks Workgroup PDM will add several custom properties to 

files checked into the vault. These include: number, status, 

description, project and revision. SolidWorks Workgroup PDM can 

also be configured to add additional properties defined by the Vault 

Administrator.

Uses of File 
Properties

File properties can be used for several operations.

� Parts, assemblies and drawings 

File properties can be used to create parametric notes. Annotations 

linked to file properties will update as the properties change.

� Assemblies
Advanced Selection and Advanced Show/Hide can select 

components based on specific file properties. Specific procedures 

are found in the training course Assembly Modeling.

� Drawings

File properties can be used to fill in data in the title block, BOM, 

revision blocks and annotations. Specific procedures are found in 

the training course SolidWorks Drawings.
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All SolidWorks documents have the following system-defined 

properties:

Additionally, drawings have the following system-defined properties:

Property Name Value

SW-Author Author field in Summary Information dialog 

box

SW-Comments Comments field in Summary Information

SW-Configuration 
Name

Configuration name in ConfigurationManager 

of part or assembly

SW-Created Date Created field in Summary Information

SW-File Name Document name without extension

SW-Folder Name Document folder with a backslash at the end

SW-Keywords Keywords field in Summary Information

SW-Last Saved By Last Saved By field in Summary Information

SW-Last Saved 
Date

Last Saved field in Summary Information

SW-Long Date Current date in long format (Monday, January 

1, 2005)

SW-Short Date Current date in short format (1/1/2005)

SW-Subject Subject field in Summary Information

SW-Title Title field in Summary Information

Property Name Value

SW-Current Sheet Sheet number of the active sheet

SW-Sheet Format 
Size

Sheet size of the active sheet format

SW-Sheet Name Name of the active sheet

SW-Sheet Scale Scale of the active sheet

SW-Template Size Template size of the drawing template

SW-Total Sheets Total number of sheets in the active drawing 

document
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Prefixes for custom properties linked in notes are used as follows: 

5 File properties.

Click File, Properties and click the Custom tab. Type in the Name 

mass. The Type Text appears automatically. Assign the mass property 

component by selecting Mass from the Value/Text Expression drop-

down list. A SolidWorks special property and Evaluated Value are 

created.

Note The Configuration Specific tab can also be used. This would allow the 

property to vary by configuration. Configurations will be discussed in 

Lesson 10: Configurations.

Prefix Evaluated From

$PRP Current document

$PRPSHEET Model in the view specified in Sheet 

Properties 

For sheet and format notes, the first view in 

the FeatureManager design tree is used

$PRPVIEW Model in the drawing view to which the note 

belongs

$PRPMODEL Component to which the annotation is 

attached
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SolidWorks 
Simulation-
Xpress

SolidWorks SimulationXpress is a first pass stress analysis tool for 

SolidWorks users. It helps you judge whether your part will withstand 

the loading it will receive under real-world conditions. SolidWorks 

SimulationXpress is a subset of the SolidWorks Simulation product.

Overview SolidWorks SimulationXpress 

uses a wizard to provide an 

easy to use, step-by-step 

method of performing design 

analysis. The wizard requires 

several pieces of information in 

order to analyze the part: 

fixtures, loads and materials. 

This information represents the 

part as it is used. For example, 

consider what happens when 

you turn the handwheel. The 

hub is attached to something 

that resists turning. This is represented by a fixture - the hub is 

restrained so it doesn’t move. Fixtures are sometime called constraints. 

A force is applied to the hole in the rim as you attempt to turn the 

handwheel. This is a load. What happens to the spokes? Do they bend? 

Will they break? This depends on the strength of the material the 

handwheel is made of, the physical size and shape of the spokes, and 

the size of the load.

Mesh In order to analyze the model, SolidWorks 

SimulationXpress automatically meshes the 

model, breaking it up into smaller, easier-to-

analyze pieces. These pieces are called elements.

Although you never see the elements, you can 

set the coarseness of the mesh prior to the 

analysis.

Results The analysis produces results in the forms of Factor of Safety, Stress 

Distribution and Deformed Shape.

Externally applied load

Fixture
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Using 
SolidWorks 
Simulation-
Xpress

SolidWorks SimulationXpress walks you through the steps of 

analysis, from Options to Optimize. The steps are:

� Options

Setup the type of units that are commonly used for materials, loads and 

results.

� Fixtures

Select faces of the part that remain in place (fixed) during the analysis. 

� Loads

Add external loads such as forces and pressures to induce stress and to 

deform the part.

� Material

Choose a material for the part from the standard library or input your 

own.

� Run

Run the analysis, optionally setting the coarseness of the mesh used.

� Results

View the results of the analysis: Factor of Safety (FOS), Stress and 

Deformations. This is sometimes called postprocessing.

� Optimize

Optimize a result quantity using a selected dimension. 

Where to Find It � From the Tools menu, select SimulationXpress....

� Or, on the Tools toolbar, click SimulationXpress .

1 Start SimulationXpress.

Click Tools, SimulationXpress.... 

The analysis wizard appears in the 

Task Pane. 
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The Simulation-
Xpress 
Interface

The SolidWorks SimulationXpress interface begins in the Task Pane, 

where the checklist of sequential tasks appears under the SolidWorks 

SimulationXpress  tab. Selection options and the 

SimulationXpressStudy tree appear in the PropertyManager. 

Options The Options dialog contains settings for the System of units and 

Results location.

2 Click Options....

Set the units to SI and use the default Results location.

Click OK and click  Next. 

Phase 1: Fixtures Fixtures are used to “fix” faces of the model that should not move 

during the analysis. You must restrain at least one face of the part to 

avoid analysis failure due to rigid body motion. As you complete each 

phase in the wizard, a green check mark  is added to the list.

3 Fixtures page.

Click  Add a fixture.

Tip Click on the blue hyperlinks (such as Fixed Holes) for examples.

SolidWorks
SimulationXpress
Task Pane Tab

PropertyManager and 
SimulationXpressStudy
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4 Face selection. 

Select the cylindrical face 

and the flat face that form the 

D-shaped hole.

Click OK. 

Click Next. 

Simulation Study A SimulationXpress Study is being constructed 

as the wizard steps are completed. The 

FeatureManager Design Tree is split and the lower 

portion contains the SimulationXpressStudy tree. 

Eventually it will include fixtures, loads, mesh and the results of the 

analysis. 

Phase 2: Loads The Loads page is used to add external forces and pressures to faces of 

the part. Force implies a total force, for example 200 lbs, applied to a 

face in a specific direction. Pressure implies that the force is evenly 

distributed on the face, for example, 300 psi, and is applied normal to 

the face.

Note The specified force value is applied to each face. For example, if you 

select 3 faces and specify a 50 lb. force, SimulationXpress applies a 

total force of 150 lbs. (50 lbs. on each face).

5 Loads page.

In this example, we will use a Force type load. Click  Add a force.
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6 Select the face. 

Select the cylindrical face 

as shown. Click Selected 

direction and click the 

Right plane. 

Set the Force to 3000 and 

click OK.

Phase 3: Material The next phase is selecting the Material. You can choose from libraries 

of standard materials or add your own.

7 Material page.

The current material, selected within 

SolidWorks, should be Aluminum Bronze 

from the Copper Alloys list.

To change the material, select it from the list. 

This is the same list that appears when using 

Edit Material.

Click Next to keep Aluminum Bronze as the 
material. 

Phase 4: Run SimulationXpress prepares the model for analysis, creates the mesh and 

calculates displacements, strains, and stresses.

8 Run page.

The required information has been provided and the analyzer is ready.

Click  Run simulation. 
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Phase 5: Results The Results page is used to display the 

results of analysis. The full 

SimulationXpressStudy tree is shown in 

the split FeatureManager Design Tree. 

This includes all the input and output of 

the study. 

Tip Right-click a result feature (such as Stress (-vonMises-)) and choose 
Show to view it. 

9 Deformation. 

The first result displayed is the Deformation. 

Click  Yes, continue to see the next result. 

The second result is the Factor of Safety (FOS) which compares the 

yield strength of the material to the actual stresses. 

Factor of Safety SimulationXpress uses the maximum von Mises stress criterion to 

calculate the factor of safety distribution. This criterion states that a 

ductile material starts to yield when the equivalent stress (von Mises 

stress) reaches the yield strength of the material. The yield strength 

(SIGYLD) is defined as a material property. SimulationXpress 

calculates the factor of safety at a point by dividing the yield strength 

by the equivalent stress at that point.

At any location, a factor of safety that is:

� Less than 1.0 indicates that the material at that location has yielded 

and that the design is not safe.

� Equal to 1.0 indicates that the material at that location has just 

started to yield.

� Greater than 1.0 indicates that the material at that location has not 

yielded.

10 Factor of safety.

The FOS has areas that are less 

than 1. This indicates that areas 

of the part are overstressed and 

will fail.

Red areas indicate where the fac-

tor of safety is less than one.

Click  Done viewing results.

Click 6 Optimize. 
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Phase 6: Optimize The Optimize tab can be used to bring Factor of Safety, Max Stress 

or Maximum Displacement values to acceptable levels by iterating the 

value of a dimension. The optimization is performed within set numeric 

boundaries with the above constraints. 

11 Optimize the model.

Click Yes for Would you like to optimize your model? and  Next. 

12 Value to change.

Select the 14mm dimension (major axis of the ellipse) as the dimension 

to change. Click OK. 

13 Variables and constraints. 

Set the Min and Max Variable values to 18mm and 22mm as shown. 

For Constraints, select Factor of Safety and set it to a minimum of 1. 

Click Run.

Tip Design Study Properties  can be used to set the results quality and 

output folder location. 

14 Results. 
After several iterations, the optimization is 

complete. Click the Results view tab. The 

resulting changes meet the FOS target with 

only a small increase in weight. 

15 Optimization results.
Click the Optimal Value option and click  Next. Click 4. Run and 

Run Simulation. 
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Updating the 
Model

Changes performed in SolidWorks or during optimization are detected 

by SimulationXpress. Changes can be made to the model, materials, 

fixtures or loads. The existing analysis can be re-analyzed to show the 

newest results.

16 Save data.

Click Close in the SolidWorks SimulationXpress window and Yes to 

save the data. 

17 Change model. 

The optimization process changed the 

selected dimension value. Click the 

Model tab on the bottom of the 

graphics window and change that 

dimension to the rounded value 

20mm and rebuild. 

18 Retrieve data.

Start SimulationXpress again and run 

the simulation again. 

19 Save and close.

Click Close in the SolidWorks 

SimulationXpress window and Yes to 

save the data. 

20 Save and close the part. 
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Results, Reports 
and eDrawings

The following are some examples of the different types of output that is 

available with an analysis. It includes results, reports and eDrawing 

files. 

Note Some of the displays are exaggerated by a deformation scale. 

Type Display

 Stress (-vonMises-)

Displacement (-Res disp-)

Deformation (-Displacement-)
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Factor of Safety (-Max von 

Mises Stress-)

HTML Report

eDrawings File

Type Display
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Exercise 24:
Flange

Create this part using the dimensions provided. Use 

relations wisely to maintain the design intent.

This lab uses the following skills:

� Revolved Features on page 191.

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Holes in the pattern are equally spaced.

2. Holes are equal diameter.

3. All fillets are equal and are R6mm.

Note that construction circles can be created using the Properties of a 

circle.

Dimensioned 
Views

Use the following graphics with the description of the design intent to 

create the part.

Top View

Front View
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Exercise 25:
Wheel

Create this part using the 

dimensions provided. Use 

relations wisely to maintain the 

design intent. 

This lab uses the following 

skills:

� Revolved Features on 

page 191.

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Part is symmetrical about the axis of the hub.

2. Hub has draft.

Dimensioned 
Views

Use the following graphics with the description of the design intent to 

create the part.

Front and Top views, and Section A-A from Front view.
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Optional: Text in a 
Sketch

Text can be added to a sketch and extruded to form a cut or a boss. The 

text can be positioned freely, located using dimensions or geometric 

relations, or made to follow sketch geometry or model edges.

Where to Find It � Click Tools, Sketch Entities, Text....

� Or, on the Sketch toolbar, click Text .

1 Construction geometry.
Sketch on the front face and 

add construction lines and arcs 

as shown.

Tip Use Symmetric relationships 

between the endpoints of the 

arcs and the vertical centerline.

2 Text on a curve.

Create two pieces of text, one 

attached to each arc. They 

have the following properties:

� Text: Designed using
� Font: Courier New 11pt
� Alignment: Center Align
� Width Factor: 100%
� Spacing: 100%

� Text: SolidWorks
� Font: Arial Black 20pt
� Alignment: Full Justify
� Width Factor: 100%
� Spacing: not applicable when using Full Justify

3 Extrude.

Extrude a boss with a Depth of 1mm and Draft of 1°.

Note Extruding text can be time consuming. 

4 Save the part and close it.



Exercise 26 SolidWorks 2011
Guide

230

Exercise 26:
Guide

Create this part using the information and 

dimensions provided. This lab reinforces the 

following skills: 

� Introducing: Slots on page 198. 

Units: millimeters

Procedure Create a new mm part and name it Guide. Create the geometry as 

shown in the following steps. 

Note These images show the sketch relations (View, Sketch Relations) for 

clarity. 

1 Lines and fillet. 

Open a sketch on the Front plane. 
Create the sketch lines, a sketch fillet 

and an angular dimension as shown. 

2 Offset. 
Use offset entities to create the 

20mm offset as shown. 

3 Close ends. 

Close the ends using a 

tangent arc and a line as 

shown. 
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4 Drag to origin. 

Drag the centerpoint of the 

arc to the Origin and drop it. 

This creates a Coincident 

relation. 

5 Fully defined. 

Add a Virtual Sharp by 

selecting the two lines 

as shown and clicking 

the Point tool . 

Complete the sketch by 

adding dimensions as 

shown. 

Extrude the sketch 

10mm.

6 Circle and boss. 

Add a circle to a new sketch on the top face of the model. Use Tangent 

and Coincident relations to relate the circle to the geometry. Fully 

define and extrude the sketch 10mm as shown. 
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7 Fillet. 

Add a fillet R20mm as shown. 

8 Slot. 

Use Straight Slot with the options Overall Length and Add 

Dimensions to create the geometry shown below. Create a through all 

cut with the sketch geometry. 

Tip The slot sketch should be fully defined. It may require a Parallel 

relation. 

9 Hole.

Add a 20mm through all hole to complete the part. 

10 Save and close.
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Exercise 27:
Tool Post

Create this part using the dimensions pro-

vided. Use relations wisely to maintain the 

design intent.

This lab uses the following skills:

� Revolved Features on page 191.

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Part is symmetrical.

2. Center hole is though all.

Dimensioned 
Views

Use the following graphics with the design intent to create the part.

Top View

Front View

Section A-A
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Exercise 28:
Ellipse

Use an ellipse to create the 

part.

This lab reinforces the 

following skills:

� Introducing: 

Insert Ellipse on 

page 203. 

Units: millimeters

Procedure Create a new mm part and name it Offsets. All Countersink holes are 
for an M3 Flat Head Machine Screw. Create the geometry as shown in 

the following steps. 
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Exercise 29:
Sweeps

Create these three parts using swept features. These require a path and a 

section.

This lab uses the following skills:

� Completing the Path and Profile Sketches on page 202.

� Introducing: Sweep on page 203.

Units: millimeters

Cotter Pin The Cotter Pin uses a path that describes the inner edge of the sweep.

Paper Clip The Paper Clip is defined by a path that describes the centerline of the 
sweep.

Thanks to Paul Gimbel, TriMech Solutions, LLC for submitting these examples.
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Mitered Sweep The Mitered Sweep is defined by a path that describes the outer edge 
of the sweep.
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Exercise 30:
Simulation- 
Xpress

Perform a first pass stress 

analysis on an existing part.

This lab uses the following 

SimulationXpress skills:

� Phase 1: Fixtures on 

page 219.

� Phase 2: Loads on 

page 220.

� Phase 3: Material on 

page 221.

� Phase 4: Run on page 221.

� Phase 5: Results on page 222.

Units: millimeters

1 Open Pump Cover.
This part represents a cover that will be filled with oil under high 

pressure.

Start the SimulationXpress wizard.

2 Set the units.

Click Options... and set the units to SI. 

3 Define the fixture.

Select the uppermost faces 

of the four tabs and the 

cylindrical faces of the 

four bolt holes.
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4 Define the load set.

Select Pressure for the 

type of load. Right-click 

one of the faces on the 

inside of the Pump Cover. 
Pick Select Tangency 

from the shortcut menu.

5 Set the pressure value 
and direction.

Set the pressure value to 

250 psi. 

6 Specify the material.

Select Aluminum Alloys 

and select 2014 Alloy from 

the list.

7 Run the simulation.

8 Results. 
The factor of safety is less than 1 indicating that the part is over 

stressed. Also view the stress and deformation plots. 

9 Change the material. 
Right-click the Pump Cover (-2014 Alloy-) icon in the 
SimulationXpressStudy and choose Apply/Edit Material. 

Change the material to Other Alloys, Monel(R) 400.

10 Update.

Click Run Simulation to rerun the analysis using the new material. 

The factor of safety should be greater than 1. 

11 Save and close the part. 
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Lesson 7
Shelling and Ribs

Upon successful completion of this lesson, you will be able to:

� Apply draft to model faces.

� Perform shelling operations to hollow out a part.

� Create planes.

� Use the rib tool.

� Create thin features.
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Shelling and 
Ribs

Creating thin walled 

parts involves some 

common sequences and 

operations, whether they 

are cast or injection 

molded. Both shelling 

and draft are used, as 

well as ribs. This 

example will go through 

the steps of adding draft, 

creating planes, shelling 

and creating ribs.

Stages in the 
Process

Some key stages in the modeling process of this part are given in the 

following list:

� Draft with a plane
Draft can be defined with respect to a planar face or plane and 

direction.

� Using planes

This part contains several features that are aligned to the centerline of 

the part itself. A centered plane is used for locating features.

� Shelling

Shelling is the process of hollowing out a part. You have the option of 

removing one or more faces of the part. A shell feature is a type of 

applied feature.

� Rib tool

The rib tool can be used to quickly create single or multiple ribs. Using 

minimal sketch geometry, the rib is created between bounding faces of 

the model.

� Thin features

The thin feature option creates revolves, extrusions, sweeps and lofts 

with thin walls of constant thickness.
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Analyzing and 
Adding Draft

Draft is required for both cast and injection molded parts. Because draft 

can be created in several ways, it is important to be able to check the 

draft on a part and if necessary, add more.

1 Open the part 
Shelling&Ribs. 

Draft Analysis The Draft Analysis tool is useful in determining whether the part has 
sufficient draft to be removed from the mold based on a set draft angle.

Where to Find It � Click Draft Analysis  on the View toolbar.
� Or, click View, Display, Draft Analysis....

Note The dialog may vary slightly depending on your graphics card. 

2 Click Draft Analysis .

3 Direction of pull.

Select the bottom planar face as the 
Direction of Pull. Click Reverse 
Direction so the pull direction arrow 
points as shown.

4 Results. 

Set the Angle to 2°. 
Colors are assigned to 
the faces according to 
the nature of their draft. 
Three (yellow) faces 
require draft.

Click OK to complete 

the command and the 

face colors and legend 

will remain visible.
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Other Options 
for Draft

So far we have seen one method for creating features with draft, using 

the Draft option in the Insert, Boss/Base, Extrude... command.

There are times when this method does not address your specific 

situation. For example, because of the way we modeled the base 

feature, there isn’t any draft on it. There is a way to add draft to faces 

after they are created.

Introducing: 
Insert Draft

Insert Draft enables you to add draft to faces of the model with respect 

to a neutral plane or a parting line.

Where to Find It � From the Insert menu, choose Features, Draft....

� Or, on the Features toolbar, click the Draft  tool.

Draft Using a 
Neutral Plane

The process of adding draft requires the selection of one Neutral plane 

and one or more Faces to draft. 

5 Neutral plane 
draft.

Click Insert, 

Features, Draft... 

and choose Neutral 

Plane as the Type 

of Draft.

Select the bottom 

planar face, same as 

for draft analysis, as 

the Neutral Plane.

Set the Draft Angle 

to 3 degrees.

Select the three 

yellow faces to draft 

and click OK to 

complete the 

command. 

Note Click Reverse Direction if necessary to point the arrow in the 

direction shown.
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6 Draft analysis recheck.

Notice color change for the 

selected faces. They now 

have positive draft within the 

boundaries set in the draft 

analysis. 

Click the Draft Analysis  

tool again to shut off the 

colors. 

Tip Zooming in on the Top 
view shows the drafted 

faces.

Shelling A shelling operation is used to “hollow out” a solid. You can apply 

different wall thicknesses to selected faces. You can select faces to be 

removed. In this example, all walls will have the same thickness.

Order of 
Operations

Most plastic parts have rounded corners. If you add fillets to the edges 

before shelling and the fillet radius is greater than the wall thickness, 

the inside corners of the part will automatically be rounded. The radius 

of the inside corners will equal the fillet radius minus the wall 

thickness. Taking advantage of this can eliminate the tedious task of 

filleting the inside corners.

If the wall thickness is greater than the fillet radius, the inside corners 

will be sharp.

Introducing: 
Insert Shell

Insert Shell removes selected faces and adds thickness to others to 

create a thin walled solid. It can create multiple thicknesses in the same 

shelling command.

Where to Find It � From the Insert menu, choose Features, Shell....

� Or, on the Features toolbar, click Shell .

Tip Clear Show preview before selecting the faces, otherwise the preview 

will be updated with each selection, slowing down the operation.
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Face Selection Shelling can remove one or more faces from the model or create a fully 

enclosed void. Here are some examples:

7 Shell.

Click Insert, Features, 

Shell... and set the 

Thickness to 1.5mm.

Clear Show preview and 

select the 9 faces 

(including the hidden 

bottom face) shown as 

the Faces to Remove. 

Click OK.

One face selected.

One face selected.

Multiple faces selected.

No faces selected.

Note: The results are 

shown sectioned, using 

the Section View 

command.
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8 Shelled part.

The selected thickness is 

applied to all faces 

except those removed.

Planes The Plane Wizard can be used to create a variety of planes using 

different geometry. Planes, faces, edges, vertices, surfaces and sketch 

geometry can all be used to apply constraints through First, Second 

and optionally Third References. The Fully defined state is listed 

when it is reached. 

Tip If the selections cannot be combined to form a 

valid plane, a message appears in the dialog. 

Where to Find It � Click Plane  on the Reference Geometry toolbar.

� Or, click Insert, Reference Geometry, Plane....

Shortcut Press Ctrl and drag an existing plane to start the Offset Distance plane 

as shown below.

Here are some examples: Offset distance plane.

Offset Distance

Select a planar face or 

plane and a distance. 

Optionally create a series of parallel 

planes the same distance apart.
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Angle

Select a planar face or 

plane and an edge or 

axis.

Optionally create a series of angled planes 

the same distance apart.

Coincident

Select three vertices.

Coincident

Select a line and a 

single vertex.
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Parallel

Select a face and a 

vertex.

Tangent and 
Perpendicular

Select a cylindrical face 

and a planar face or 

plane with 

Perpendicular. 
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Tangent and Parallel

Select a cylindrical face 

and a planar face or 

plane with Parallel. 

Mid Plane

Select two planar faces 

with Mid Plane. 

Perpendicular at a 
Point

Select a sketched line 

and an endpoint.

As a shortcut to Perpendicular at a Point, 

select an edge/line and click Insert, 

Sketch. The plane is created and a sketch 

opened on it.
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9 Offset distance plane. 

Select the thickness face and use the Plane tool to create a new plane 

using an Offset Distance of 10mm to the inside (intersecting the 

model).

Ribs The Rib tool enables you to create ribs using minimal sketch geometry. 

The tool prompts you for the thickness, direction of the rib material, 

how you want to extend the sketch if necessary, and whether you want 

draft.

Tip Unlike other sketches, the rib sketch does not have to cover the 

complete length of the rib feature. This is due to the fact that the rib 

feature automatically extends the sketch to the next feature it finds on 

both ends. 

Rib Sketch The rib sketch can be simple or complex. It can be as simple as a single 

sketched line that forms the rib centerline, or it can be more elaborate. 

Depending on the nature of the rib sketch, the rib can be extruded 

parallel or normal to the sketch plane. Simple sketches can be extruded 

either parallel or normal to the sketch plane. Complex sketches can 

only be extruded normal to the sketch plane. Here are some examples:

Simple sketch 

extruded parallel to 

the sketch plane.
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Introducing: 
Insert Rib

Insert Rib creates a flat topped rib either with or without draft. The rib 

is based on a sketched contour line that defines the path of the rib. A 

full round fillet can be added to round off the rib.

Where to Find It � From the Insert menu, choose Features, Rib....

� Or the pick the Rib  tool on the Features toolbar.

Simple sketch 

extruded normal to 

the sketch plane.

Complex sketch 

extruded normal to 

the sketch plane.
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10 Sketch line.

Create a new sketch on the plane Plane1. 
Sketch two lines, under defined and 

dimensioned as shown. Note that the lines 

are Horizontal.

11 Rib tool. 

Click the Rib tool and set the parameters shown: 

� Thickness: 1.5mm

Create rib on Both Sides of sketch  At 
sketch plane

� Extrusion direction:

Normal to Sketch 

� Draft : 3° outward 

Tip If the Flip material side arrow points away from the model, reverse the 

direction. Click OK. 

12 Rib sketch.

Select the Right plane and create a new sketch. Change the display to 
Hidden Lines Visible. 
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Converting Edges Convert Entities is used to create copies of model edges in the active 

sketch. The edges are projected onto the plane of the sketch, regardless 

whether they lie on that plane or not.

Introducing:
Convert Entities

Convert Entities enables you to copy model edges into your active 

sketch.

Where to Find It � On the Tools menu, click Sketch Tools, Convert Entities.

� Or, on the Sketch toolbar, click Convert Entities .

13 Convert. 

Click Convert Entities  and select the upper edge as indicated. 

Click OK. 

14 Drag. 

Drag the endpoints of the 

converted edge to move it to the 

right.

Use Parallel to Sketch  with 

the options used in the previous 

rib feature to create the rib. 

15 Completed ribs.

Another rib can be 

added using the same 

method as the 

previous one.
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Full Round 
Fillets

The Full Round Fillet option creates a fillet that is tangent to three 

adjacent sets of faces. Each face set can contain more than one face. 

However, within each face set, the faces must be tangent continuously.

Introducing: Full 
Round Fillets

A full round fillet does not need a radius value. The radius is 

determined by the shape of the faces you select. 

Where to Find It � From the Insert menu, choose Features, Fillet/Round....

� Or click Fillet  on the Features toolbar.

16 Full round.

Click Fillet icon 

and the Full round 

fillet option. Under 

Items To Fillet, 

select one face in 

each set as shown.

17 Save and close.

Center face is 

Side faces

removed

are trimmed
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Thin Features Thin Features are made by using an open sketch profile and applying a 
wall thickness. The thickness can be applied to the inside or outside of 
the sketch, equally on both sides of the sketch or unequally on either 
side. Thin feature creation is automatically invoked for open contours 
that are extruded or revolved. Closed contours can also be used to 
create thin features.
Thin features can be created for extrudes, revolves, sweeps and lofts.

Revolve, open

Revolve, closed

Extrude, open

Extrude, closed
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1 Open Thin_Features.

2 Thin revolve.

Select the strainer sketch and 
the Revolve tool. When the 

system asks whether the sketch 

should be automatically closed, 

click No.

Set the Direction 1 thickness 

to 5mm and the direction to the 

outside.

Click OK. 

3 Thin extrude.

Select the bracket sketch and the 
Extrude tool. Set the Thin Feature 

to Mid-Plane and 5mm. Click 

Auto-fillet corners and set the 

Fillet Radius to 3mm.

4 Preview.

Click Detailed Preview  to view the 

auto fillets. Click the button again to 

dismiss the preview.



Lesson 7 SolidWorks 2011
Shelling and Ribs

256

5 Direction.

Set the direction of the extrude 

towards the base feature and 

use Up To Next. 

Click OK.

6 Save and close the file.

Note This example offers another 

comparison between Up To 

Surface (top) and Up To Next 

(bottom).
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Exercise 31:
Compression 
Plate

Create this part using the 

dimensions provided. Use 

relations wisely to maintain the 

design intent.

This lab uses the following 

skills:

� Shelling on page 243.

� Ribs on page 249.

� Converting Edges on 

page 252.

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Part is symmetrical.

2. Ribs are equally spaced.

3. All fillets and rounds are 1mm.

Dimensioned 
Views

Use the following graphics with the design intent to create the part.

Top View

Front View
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Bottom View

Right View

Detail A

Detail B
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Exercise 32:
Blow Dryer

Create this part by following the 

steps as shown. 

This lab uses the following skills:

� Analyzing and Adding Draft 

on page 241.

� Shelling on page 243.

� Planes on page 245.

� Ribs on page 249.

� Full Round Fillets on 

page 253.

Optional 
Sketching

If you would like to use the existing geometry, skip to Procedure. If 

you would like to create the sketch, open a new mm part and use the 

dimensions below. The sketch is on the Right Plane.

Procedure Open an existing part in the Exercises folder.

1 Open the part Blow Dryer.
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Extrude, Draft and 
Rounds

Starting with the sketch, the base feature is created, drafted and 

rounded.

2 Extrude.
Extrude the sketch 25mm as 

shown.

3 Draft.

Add draft of 2° to all outer faces except the 

outlet face, using the back face of the model as 

the neutral plane. This is a partial Front view, 
looking into the outlet face.

Tip There is no draft on outlet face.

4 Rounds.

Add rounds 

(R16mm and 

R11mm), using the 

size and sequence 

shown, to the solid 

body.

5 Check draft.

Using Draft Analysis, check the draft for 2° against the Right Plane. 

Other features Use the following guidelines and drawing to add other features, 

including shells and ribs, to complete the model. 
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6 Complete the part.

Complete the part using the following guidelines.

� Wall thickness is constant.

� Vents and ribs are the same size.

� All fillets and rounds 1mm except full rounds on ribs.

7 Save and close the part.
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Exercise 33:
Blade

Create this part using the information and 

dimensions provided. 

This lab reinforces the following skills:

� Planes on page 245.

� Full Round Fillets on page 253.

� Thin Features on page 254.

Units: millimeters

Procedure Create a new part. Refer to the image above for the sizes of fillets and 

rounds. 
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Lesson 8
Editing: Repairs

Upon successful completion of this lesson, you will be able to:

� Diagnose various problems in a part.

� Repair sketch geometry problems.

� Use the rollback bar. 

� Repair dangling relations and dimensions.

� Use the FeatureXpert to repair filleting problems.

� Use the FilletXpert and DraftXpert to add fillets and draft.
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Part Editing The SolidWorks software provides the capability to edit virtually 

anything at any time. In order to emphasize this, the major tools for 

editing parts are covered and reviewed here in one lesson.

Stages in the 
Process

Some key stages in the process of modifying this part are shown in the 

following list. Each of these topics comprises a section in the lesson.

� Add and delete relations

Sometimes the relations in a sketch must be deleted or changed due to 

changes in the design.

� What’s Wrong?

When errors occur, the What’s Wrong option can be used to 

investigate and pinpoint the problem.

� Edit sketch
Making changes to the geometry and relations of any sketch can be 

done through Edit Sketch.

� Check sketch for feature

Check Sketch for Feature can check a sketch for problems, verifying 

its suitability for use in a feature. You must Edit Sketch before using 

Check Sketch for Feature.

� Edit feature

Changes to how a feature is created are done through Edit Feature. 

The same PropertyManager that is used to create a feature is used to 

edit it.

� Feature-, Fillet- and DraftXperts

Use the FeatureXpert to automatically repair errors in fillet and 

chamfer features. Use the FilletXpert and DraftXpert to add fillet and 

draft features.

Editing Topics Editing covers a wide range of topics from fixing 

broken sketches to reordering things in the 

FeatureManager design tree. These topics can be 

summarized as repairing errors, interrogating the 

part, and changing the design of the part. Each is 

described below.

Information from a 
Model

Nondestructive testing of a model can yield many important insights as 

to how the model was created, the relationships that were established, 

and changes that can be incorporated. This section will focus on using 

editing tools in conjunction with rollback to “interrogate” the model.
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Finding and 
Repairing 
Problems

Finding and repairing problems in a part is a key skill in solid 

modeling. Many changes that are made to a given part (Edit Feature, 

Edit Sketch and Reorder, to name a few) can cause features down the 

line to fail. Pinpointing the problem area and finding the solution will 

be discussed in this section.

Problems can occur in sketches or any other feature of the part. 

Although there are many types of errors, there are some that occur 

more often than others. Dangling dimensions and relations are very 

common, as is extraneous geometry in sketches. 

Opening a part that has errors can be confusing. One error near the 

beginning of the process can often cause many later features to fail 

along with it. Repairing that initial error may fix the rest of the errors as 

well. Some repairs will be made to this model before interrogating and 

changing it.

Settings Two settings in the Tools, Options dialog affect how errors are 

handled. Show errors every rebuild ensures that the error dialog 

appears after each rebuild. Use the When rebuild error occurs pull-

down to control the action taken when a part is opened with errors. It 

can prompt for action, stop the rebuild at the error or continue.

Procedure We will begin by making the proper settings.

1 Error settings.

Click Tools, Options, System Options, General. Click Show errors 

every rebuild and the Prompt pull-down from When rebuild error 

occurs. Click OK.

2 Open the part named Editing CS.
This part was built and saved with numerous errors. 

3 Feature failure.

After opening, the system displays another message box, labelled 

What’s Wrong. Each error is listed by feature name in the scrollable 

dialog.

The model is not visible; errors have caused many features to fail.

What’s Wrong 
Dialog

The What’s Wrong dialog lists all the errors in the part. The errors 

themselves are broken down into Errors that prevent features from 

being created and Warnings that do not. The other columns offer some 

help in diagnosing the problem including a preview in some cases.
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Tip Click the question mark  to open on-line help regarding this type of 

error. 

Tip The columns of the dialog can be sorted by the column headers. Click 

on the Type header to sort by Error and Warning types.

Note The display of this error dialog is controlled by the option Show errors 

every rebuild on the Tools, Options, System Options, General 

menu. This option must be enabled in order for this message to appear. 

There are several controls:

� Through the Tools, Options... dialog 

� Through the message dialog itself: Display What’s Wrong during 
rebuild 

� Through the message dialog itself: display of just errors (Show 

errors), just warnings (Show warnings) or both 
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4 FeatureManager design tree.

Close the What’s Wrong dialog. The 

FeatureManager design tree lists many 

errors indicated with markers. The markers 

placed next to the features have particular 

meanings:

� Top Level Error

The error marker next to the part name at the 

top of the tree  marks an error in the tree 

below. Useful in assemblies and drawings to 

see part errors.

� Expand

An Expand marker  is placed next to a 

feature that has an error or warning on the 

feature beneath it. Expand the feature to see 

the problem. The text of the feature is shown 

in yellow.

� Error 

An Error marker  is placed next to a 

feature that has a problem and cannot create 

geometry. The text of the feature is shown in 

red.

� Warning

A Warning marker  is placed next to a 

feature that has a problem but creates 

geometry. This is common for “dangling” 

geometry and relations. The text of the 

feature is shown in yellow.

� Normal Features

Normal features that do not have warnings or errors appear with black 

text. 
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Searching the Tree The FeatureManager Search 

box  can 

be used to search by the 

starting letters of a name or 

some portion of the name. 

Try typing “sk”, “fil”, and 
“pa” as examples.

Click the “x” to clear the 
search.

Where to Begin Features are rebuilt in sequence from the top of the tree. The best place 

to begin is at the first (base) feature with an error, in this case that is the 

feature main. An error in the base feature may cause a series of errors 

in the child features.

Many of the errors you will find are related to sketches. Don’t forget 

the SketchXpert on page 313 as a solution for over defined sketches. 

5 What’s Wrong?

The What’s Wrong option is used to highlight an error message for a 

selected feature. Right-click the main feature and select What’s 

Wrong?. The message indicates that the sketch cannot be used for the 

feature because an endpoint is wrongly shared.

Tip Floating the cursor over the error 

in the FeatureManager design tree 

will result in a balloon labelled 

with the feature name and the 

same description as the What’s 

Wrong description. 
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6 Edit the sketch.

The What’s Wrong message has indicated the sketch (Sketch1) as the 
problem. Edit the sketch of the feature.

Sketch Issues There are several reasons why sketches 

will not rebuild, but they can include 

geometry, relations or dimensions. Extra 

lines connected to existing endpoints and 

small unwanted pieces of geometry are 

common. 

Note A single gap in an otherwise continuous contour is acceptable. 

7 Zoom to fit. 

Geometry that is away from the intended 

profile geometry can cause sketch issues. 

Click Zoom to Fit  and all the 

geometry in the sketch will be shown. 

There is a very small piece of 

disconnected geometry. 

Box Selection Box selection enables you to select multiple sketch entities with a 

drag-window. Entities are selected based on whether the window is 

dragged from right to left or left to right. The selection includes 

dimensions.

Left to right: Only the geometry completely within the window (the 

short line) is selected. 

Right to left: The geometry within and crossing the window (short line 

and two long lines) is selected. This is also called cross selection.

Tip Using Shift with the box selection maintains previous selections. Using 

Control with the box inverts the selections.
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8 Select. 

Use left to right box selection to select 

the extraneous line and delete it.

Zoom in on the remaining geometry. 

Check Sketch for 
Feature

Check Sketch for Feature enables you to check the validity of a sketch 

for use in a feature. Since different features have different sketch require-

ments – for example, revolved features require an axis of revolution – 

you select the type of feature for which the sketch is to be evaluated. Any 

geometry that impedes the creation of that feature will be highlighted. It 

will also check for missing and inappropriate geometry.

Where to Find It � From the Tools menu, select Sketch Tools, Check Sketch for 

Feature....

Note If Check Sketch for Feature encounters sketch problems, it starts 

Repair Sketch automatically. See Repair Sketch on page 271. 

9 Check Sketch.

The Check Sketch for Feature... 

command checks for incorrect 

geometry in the sketch, compared to 

what is required by the Contour type. 

In this case the Feature Usage is set to Base Extrude because that is 

the type of feature this sketch belongs to. The Contour type is 

determined from the type of feature. 

Click Check. 
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10 Message. 

A message appears 

stating: 

The sketch cannot be 
used for a feature 
because an endpoint 
is wrongly shared by 
multiple entities. To 
try to fix the sketch 
right now, click OK. 
Click OK.

Repair Sketch The Repair Sketch tool is used to find errors in the sketch and allow 

you to repair them. Repair sketch organizes the errors, describes them 

and zooms in on them using the magnifying glass. 

Where to Find It � Click Tools, Sketch Tools, Repair Sketch. 

Magnifying Glass The Magnifying Glass tool is useful in finding and selecting small 

edges and faces in a model or an assembly. The magnifying glass 

typically is used while other tools are active. Some additional functions 

are: 

� Use the middle mouse button/wheel to zoom within the glass. 

� Use Alt + middle mouse button/wheel to section the model. 

� Use Ctrl + middle mouse button/wheel to move the magnifying 

glass and pointer together. 

Where to Find It � Click the keyboard shortcut g to start the magnifying glass. 
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11 Repair Sketch. 

Repair Sketch starts automatically. Set 

the Gap to 0.010mm and click Refresh 

. Three errors appear with the 

magnifying glass zoomed in on the first 

one. 

12 Next. 

Click Next . Since two errors are in 

roughly the same area, the mirror 

remains in more or less the same place.

Rotate the wheel to zoom the magnifying 

glass in on the problem area. 

The error description is: 

A small entity. Is it intentional?. 

It isn’t. Click the short line and delete it. 

Click Refresh. 

13 Two Points Gap. 

The next error is listed as a Two Points 
Gap. As shown in the magnifying glass, 

there is a gap between endpoints. Select 

the endpoints and add a Merge relation.
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14 Last error. 

Click Refresh and the last 

error appears. Close the dialog. 

Use left to right box selection 

to select the extraneous line and 

delete it.

15 Equal. 

Add an Equal relation between the 

edges as shown to complete the 

sketch. 

Using Stop and 
Repair

You have the option to either rebuild the entire model to the end or stop 

at the next error and rebuild only to that feature. Choose one of two 

options at the message prompt. 

Continue (Ignore Error) - Rebuilds the part and allows you to choose 

the next edit. 

Stop and Repair - Stops at the next error and places the rollback bar 

after that feature. After each repair, SolidWorks will again stop at the 

next error. 

16 Message. 

Exit the sketch. A message appears to provide you with editing options: 

Feature Sketch2 has a warning, which may cause subsequent 
features to fail. Would you like to repair Sketch2 before 
SolidWorks rebuilds the subsequent features?

Click Stop and Repair. The rollback bar is placed after the Cut-
Extrude1 feature.

17 Next error.

The next error is listed in the What’s Wrong dialog. So that you don’t 

see this message dialog every time you make a correction, deselect the 

Display What’s Wrong during rebuild option. 
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18 Next error.

The top error on the list is for Sketch2 under the feature Cut-
Extrude1. It contains dangling sketch entities according to the 
message. Dangling sketch entities are found when dimensions or 

relations reference things that no longer exist.

Note Dangling dimensions and relations can 

be hidden from view. The Hide 
dangling dimensions and 

annotations option can be found under 
Tools, Options, Document Properties, 

Detailing.

Reattach Collinear 
Relations

Dangling collinear relations can be quickly repaired by reattaching 

them to a similar linear edge of the model.

19 Edit Sketch.

Right-click the Cut-Extrude1 feature and choose Edit Sketch.

20 Dangling relations.

One line of the sketch is shown in the 

dangling color. Click on that line to select it 

and display its drag handles. The drag handle 

can be used in a drag and drop repair 

procedure. 

When you click on the line, its relations are 

displayed in the PropertyManager. The 

relation that is dangling is color coded the 

same as the sketch entity itself.
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21 Reattach.

Drag the handle onto the topmost horizontal 

edge of the base feature. The system 

transfers the collinear relation from the 

missing entity (a deleted plane) to the model 

edge. The sketch is no longer dangling.

Repairing Relations 
Using Display/
Delete Relations

Some relations, like coincident points, can only be repaired through the 

Display/Delete Relations command. This option enables you to sort 

through all the relations in a sketch.

Introducing: 
Display/Delete 
Relations

Display/Delete Relations provides a way to systematically query all 

entities in a sketch. In addition, you can display the relations based on 

criteria such as dangling or over defined. You can also use Display/

Delete Relations to repair dangling relations.

Where to Find It � Click Tools, Relations, Display/Delete....

� Right-click in the sketch, and select Display/Delete Relations.

� Click Display/Delete Relations  on the Sketch toolbar.

22 Undo.

Click Undo to remove the last event, the repair of the dangling relation.
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23 Display/Delete Relations.

Click Tools, Relations, 

Display/Delete Relations.

In the Filter list select 

Dangling. This displays only 

the relations that are dangling.

Select the Collinear relation.

24 Entities section.

Look at the lower section of the PropertyManager. 

There is a list of the entities used by this relation. 

One entity has a Fully Defined status, the other is 

Dangling.

25 Replacement.

Select the entity marked Dangling and select the same top horizontal 

edge of the base feature as in step 21 on page 275.

Click Replace and then click OK, and close the sketch.

26 Roll forward. 

Drag the rollback bar to a position between Cut-
Extrude2 and Chamfer1.

27 Message. 

Right-click Sketch3 of the Cut-Extrude2 
feature and choose What’s Wrong. 

The message states: 
The plane used by this sketch is missing 
and cannot be accessed. You can use 
command 'Edit Sketch Plane' to add a 
reference plane for this sketch.
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Repairing Sketch 
Plane Issues

Another common error occurs when a plane or feature with a planar 

face is removed that was used as a sketch plane for another feature. In 

this case, the sketch has an error and requires that a new sketch plane be 

assigned. 

Introducing: Edit 
Sketch Plane

Edit Sketch Plane enables you to change the plane or face that a 

specific sketch is created on. The new sketch plane does not have to be 

parallel to the original.

Where to Find It � From the Edit menu, select Sketch Plane....

� Or, right-click the sketch Edit Sketch Plane .

28 Edit sketch plane. 

Right-click Sketch3 and choose Edit 

Sketch Plane . The PropertyManager 

lists **Missing**Plane<1> as the sketch 
plane and a dashed outline of the missing 

reference is shown. 

29 Select a replacement. 

Select the front planar face of the part as a 

replacement. Click OK. The feature is 

repaired.

30 Roll forward.

Roll forward to just after Cut-Extrude4, which carries the next error 
marker. Use What’s Wrong on this feature.
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Reattach 
Dimensions

Dangling dimensions can be quickly repaired by reattaching them to 

edges or vertices of the model. The dimension value will reflect the 

new distance.

Tip Dimensions can be reattached in this manner whether they are dangling 

or not.

31 Edit the sketch. 

Edit the sketch of the Cut-Extrude4 
feature. Note that the 9mm dimension is the 

dangling color for dimensions and relations. 

The dimension is trying to attach to 

geometry that no longer exists, and therefore 

it is considered dangling.

Click on the 9mm dimension to see the drag 

handles. The end marked with the red square 

handle is the dangling end, similar to how 

dangling relations are marked.

32 Drag and drop.

Drag the handle and drop it on the bottom 

edge of the part when the edge cursor 

appears. If you try to drop it on an 

inappropriate location, the cursor will display 

the  symbol. Both the dimension and the 

geometry return to their normal colors. The 

dimension’s value updates to reflect the size 

of the geometry. If you need to change the 

dimension, double-click it.

33 Exit the sketch to rebuild the model.
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Reattach Concentric 
and Coradial 
Relations

Dangling concentric and coradial relations can be quickly repaired by 

reattaching them to a similar circular edge of the model.

34 Roll Forward.

Right click on Cut-Extrude8 and select Roll Forward.

35 Edit sketch.

Edit the sketch of the Cut-
Extrude8 feature. Click the 
rightmost dangling circle 

(Concentric) to see the drag 

handle. Drag and drop the 

handle on the small circular 

edge behind. Repeat the 

procedure for the leftmost 

dangling circle (Coradial). Exit 

the sketch.

36 Roll to end.

Right-click in the FeatureManager and select Roll To End to position 

the rollback bar at the end of the FeatureManager design tree. 

Highlighting 
Problem Areas

Certain error messages contain the preview symbol . If you click on 

that marker, the system will highlight the problem area in the model. If 

you use What’s Wrong on the feature directly, it automatically 

highlights the problem area.

37 Highlight message.

Click on the preview symbol to visually display the area in which the 

error occurs. 
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38 Graphic error display.

The area where the error occurs is highlighted 

with an edge. The fillet fails in the area 

indicated by the dotted line. 

FeatureXpert The FeatureXpert option is available for certain 

conditions where fillets or draft features fail. In this 

example, the Fillet2 feature is failing. FeatureXpert will 
make use of all adjacent fillets to create a solution. The 

automated solution may involve splitting selections into different fillet 

features and reordering the sequence. The FeatureXpert is based on 

SolidWorks SWIFT technology.

Note The option Enable FeatureXpert must be clicked from Tools, 

Options, System Options, General for this to be available. 

39 FeatureXpert.

Click the FeatureXpert button on the What’s 

Wrong dialog box. Note that the original fillet 

has been split into three fillets.

40 Model rebuilt.

The model is now rebuilt without any error or 

warnings. Save and close the model. 
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FilletXpert In addition to solving fillet problems, the 

FilletXpert tool is used to create multiple 

fillets quickly and efficiently, leaving 

concerns of sequence to the system. It 

automatically leverages the FeatureXpert 

and Reorder to fix potential problems as 

you create the fillet features. 

Options within the dialog allow you to 

Add, Change and Remove fillets. 

The FilletXpert tool is accessed from the 

standard Fillet tool . 

1 Open the part FilletXpert. 

2 FilletXpert. 

Click Fillet  and FilletXpert. Set the radius to 4mm. Select the edge 

as shown and the Connected to start loop  option. Click Apply. 
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3 Edge selection. 

Set the radius to 1mm. Select the edge shown and the Between left 

feature and part  option. Click Apply. 

Changing Fillets Using the Change tab on the FilletXpert dialog allows you to Resize 

or Remove fillets within the context of the PropertyManager. This 

allows you to make bulk selections and edit individual fillets. 

Tip Fillets can be changed whether they were created with the current 

FilletXpert PropertyManager or not. 
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4 Change. 

Click the Change tab and select the fillet at the base of the circular 

boss as shown. Set the radius value to 5mm and click Resize. 

5 Remove. 
Select this set of fillets by selecting the indicated face with Right Loop 

and click Remove. Click OK. 

6 Save and close the model.
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FilletXpert Corners Corner faces generated by fillets can be modified to alternative blends 

using the Corner tab of the FilletXpert. 

Tip If you try to select a corner that is unsuitable, a message will appear 

telling you that you must select a corner that has three constant radius 

fillets of mixed convexity meeting at one vertex. 

1 Open the part Corners. 

2 Select face. 

Click Fillet , FilletXpert and Corner. 

Select the face as shown. 

Click Show Alternatives and select the 

alternative shown. 

3 Copy to. 

The Copy to option 

allows you to apply the 

same corner alternative to 

other similar corners. 

Click the fillet corner that 

was just changed. Click 

Enable Highlighting and 

click in the Copy 

Targets selection box. 

Similar corners highlight. 

Select them and click 

Copy to.
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4 Results. 

Click OK. 

5 Save and close the model.

DraftXpert The DraftXpert tool is used to add multiple neutral plane drafts of 

different draft angles, leaving concerns of sequence to the system. It 

automatically leverages the FeatureXpert and Reorder to fix potential 

problems as you create the draft features.

Options within the dialog allow you to Add and Change draft features.

The DraftXpert tool is accessed from the standard Draft tool . 

1 Open the part DraftXpert. 

2 Toggle DraftXpert.

Click the Draft icon  and 

click the DraftXpert button. 

Click the Add tab and click 

Auto paint. Also, select the 

rear face as the Neutral 

Plane. Reverse the direction 

if necessary. 
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Tip The Auto paint option is used to display 

the current draft, by face, while you work. 

You can also mouse over a face to get a 

draft value. Use the Show/Hide Faces 

buttons  to show/hide groups of faces. 

The Positive Draft faces are hidden in this 

example.

3 Draft cylindrical face.
Set the draft angle to 3°. Select the cylindrical face, as shown, to draft. 

Click Apply on the dialog or right click  to apply.

4 Planar faces. 
Select the four “vertical” faces 

and the “horizontal” face of the 

base.

Click Apply.
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5 Different draft angle.

Set the draft angle to 2°. 

Select the bottom planar face as shown. 

Click OK.

6 FeatureManager.

Some draft features were created after the extrusions 

and before fillets. FilletXpert and DraftXpert have 

reordered the sequence automatically to prevent 

rebuild failures. 

7 Save and close the model.
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Exercise 34:
Errors1

Edit this part using the 

information and dimensions 

provided to repair the errors 

and warnings and complete the 

part.

This lab reinforces the 

following skills:

� What’s Wrong Dialog on 

page 265.

� Check Sketch for Feature 

on page 270.

� Reattach Collinear 

Relations on page 274.

� Reattach Dimensions on 

page 278.

� Highlighting Problem 

Areas on page 279.

Procedure Open the existing part Errors1 and make several edits to remove the 

errors and warnings from the part. Use the drawing below as a guide.

Before

After
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Exercise 35:
Errors2

Edit this part using the 

information and 

dimensions provided to 

repair the errors and 

warnings and complete 

the part.

This lab reinforces the 

following skills:

� What’s Wrong Dialog 

on page 265.

� Finding and 

Repairing Problems 

on page 265.

� Check Sketch for 

Feature on page 270.

Procedure Open the existing part Errors2 and make several edits to remove the 

errors and warnings from the part. Use the drawing below as a guide.

Tip Click Merge solids in the Mirror1 feature. The completed part should 

be a single solid body.

After

Before
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Exercise 36:
Errors3

Edit this part using the 

information and dimensions 

provided to repair the errors 

and warnings and complete 

the part.

This lab reinforces the 

following skills:

� What’s Wrong Dialog on 

page 265.

� Check Sketch for Feature 

on page 270.

� Repairing Relations 

Using Display/Delete 

Relations on page 275.

� Reattach Dimensions on 

page 278.

� Highlighting Problem 

Areas on page 279.

Procedure Open the existing part Errors3 and make several edits to remove the 

errors and warnings from the part. Use the drawing below as a guide.

Before

After
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Exercise 37:
Adding Draft

Edit this part using the information and 

dimensions provided. Use editing 

techniques to maintain the design intent.

This lab reinforces the following skills:

� Introducing: Edit Sketch Plane on 

page 277.

Procedure Open the existing part Add Draft, and make several edits using the 

final drawing below. Change the model so that 5° of draft is added.
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Exercise 38:
Copy and 
Dangling 
Relations

Complete this part by copying 

features and making repairs.

This lab uses the following 

skills:

� What’s Wrong Dialog on 

page 265.

� Reattach Concentric and 

Coradial Relations on 

page 279.

Note Instant 3D  must be disabled to complete this exercise. 

Procedure Open existing parts.

1 Open the BoneWrench and HexCut.
Open both files and click Window, Tile Vertically.

2 Copy Hex feature.
Control-drag a face of the Hex feature and drop it onto the top planar 
face of the BoneWrench as shown. 

Click the Dangle button on the Copy Confirmation dialog.
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3 Repair.

Edit the sketch with an 

error and select the inner 

construction circle. 

Drag and drop the red 

marker to an appropriate 

replacement reference.

Size the hexagon as 

shown.

Locations Use the following 

graphics to locate and 

size a total of 4 copied 

cuts using the end 

condition Through All.

4 (Optional) Cosmetic fillets.

Optionally add the following fillets and rounds:

5 Save the parts and close them.

R2mm R1mm R0.5mm
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Exercise 39:
Using the 
FilletXpert 1

Complete this part by using both the 

FeatureXpert and FilletXpert.

This lab uses the following skills:

� Box Selection on page 269.

� FilletXpert on page 281.

Procedure Open an existing part.

1 Open FilletXpert_Lab_1.

2 Fillet.

Click the Fillet tool and the Manual 

button. Set the Radius value to 2mm and 

Box Select the edges as shown. Click 

OK.

3 FeatureXpert.
The What’s Wrong dialog explains 

that the fillets cannot be created. 

Click the FeatureXpert button. The 

fillets are created.
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4 Remove.

Use FilletXpert to remove selected 

fillet faces as shown.

5 Resize.

Use FilletXpert to resize 

selected fillet faces to 

1mm as shown.

6 Save and close.
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Exercise 40:
Using the 
FilletXpert 2

Complete these parts by using 

the FilletXpert.

This lab uses the following 

skills:

� FilletXpert on page 281.

Procedure Open existing parts.

1 Open FilletXpert_Lab_2 and FilletXpert_Lab_3.

2 FilletXpert.

Add the fillets shown with the FilletXpert using this code: red = 1mm 

and yellow = 2mm.

Tip Sometimes it is easier to fillet all the edges then remove and edit fillets 

later.
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Lesson 9
Editing: Design Changes

Upon successful completion of this lesson, you will be able to:

� Understand how modeling techniques influence the ability to 

modify a part.

� Utilize all the available tools to edit and make changes to a part.

� Use Sketch Contours to define the shape of a feature.

� Edit with instant 3D tools. 
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Part Editing The SolidWorks software provides 

the capability to edit virtually 

anything at any time. In order to 

emphasize this, the major tools for 

editing parts are used here to create 

a design change.

Stages in the 
Process

Some key stages in the process of modifying this part are shown in the 

following list. Each of these topics comprises a section in the lesson.

� Information from a model
Many of the most commonly used editing commands: Edit Sketch, Edit 

Feature, Edit sketch plane, Reorder, Rollback and Change dimension 

value are used here.

� Edit the model

Use the editing tools to modify the geometry and design intent.

� Sketch contours

A single sketch can be used to create multiple features by using 

contours within the sketch.

Design 
Changes

Some changes have to be made to the model. Some will change the 

structure of it, others only dimension values. Making design changes to 

a model can be as simple as changing the value of a dimension and as 

difficult as removing external references. This section steps through a 

series of changes to a model. The focus is on editing features rather 

than deleting and reinserting them. Editing enables you to maintain 

references to drawings, assemblies or other parts that would be lost if 

you deleted the feature.

Procedure We will edit a part that was repaired in a manner similar to the previous 

lesson.
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Required Changes The changes to the model are 

as follows:

� The circular boss is 

centered over the rib.

� The rib is rounded at the 

end.

� The circular boss is 

tangent to the right edge.

� A cutout with holes is 

added to the base.

� The circular boss is flush 

with the vertical plate. 

� Only the base is shelled.

1 Open the part named Editing_Design_Changes.
This part was built with numerous errors and repaired.

Information 
From a Model

The part has some built-in problems 

related to the sequence of features. These 

problems will become evident when it 

comes time to make design changes. In 

order to understand the way that this part 

was constructed, we will walk through the 

steps of building it and introduce some of 

the tools that will be used. The design 

intent of the part will be revealed as the features are rebuilt one at a 

time.

Introducing: Go To The Go To... option can be used to search the text of the 

FeatureManager for a specific word or set of characters. Features are 

expanded to show any features found.

Where to Find It � Right-click the top level feature, and select Go To....

2 Go To.
Right-click the top level feature 

and select Go To.... Type the partial 

name sketch and click Start from 

the top.
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3 Find Next.

Click Find Next until the last occurrence is 

found. The message This item was not 
found will appear.

The search expanded all the features that 

have sketches so that the sketches are visible.

Tip You can close all expanded features by right-

clicking in the FeatureManager and choosing 

Collapse Items or pressing Shift+C.

Note The FeatureManager Search Box can also be used to search for text 

strings. 

4 Roll the part back to the beginning.

Using Rollback, place the bar at the first 

feature in the FeatureManager design tree. 

This places the rollback bar after the feature 

Base_Plate. It can then be rolled forward 
one feature at a time.

5 Feature Base_Plate.
The Base_Plate was created from a 

rectangle and extruded. To investigate this 

further, use Edit Feature on the feature.
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6 Edit Feature.

The graphics show the sketch 

geometry and the preview. Cancel the 

dialog.

Roll forward one feature by dragging 

the marker or moving it down with the 

arrow key.

7 Feature Base_Fillet.
Fillets of equal radius are added to the front 

corners in this feature.

Roll forward to a position just after the 

Sketch2 feature.

8 Feature Vertical_Plate.
This feature was sketched on the rear face of 

the model and extruded towards the front.

9 Edit Sketch.
Edit the sketch of the feature 

Vertical_Plate to see the geometry 

and its connections points.
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10 Display/Delete Relations. 

Click Display/Delete Relations . Set the Filter 

to All in this sketch and click individual relations 

in the list to explore all geometric relations on the 

sketch entities. The relations will explain how 

entities are attached to each other and to the rest of 

the model.

Close the dialog and close the sketch without 

making any changes.

11 Sketch geometry.

To see the sketch geometry more clearly, 

right-click Sketch2, and select Show . 

The sketch icon appears in color when it is 

being shown. Using Hidden Lines 

Removed, the position of the sketch is 

clear.

Roll forward to a position just after the 

Circular_Plane feature.

12 Circular_Plane.
The plane was created for sketching 

the next feature, a circular boss. It 

lies behind Sketch2. 
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Dependencies Dependencies are relationships between features in the 

FeatureManager design tree. This information is important when 

editing, deleting or reordering features. 

Parents - Features that the target feature depends upon. 

Children - Features which are dependent upon the target feature. 

Introducing: Parent/
Child Relationships

Parent/Child is used to display the dependencies between features. It is 

used to display the parents and children of a feature. 

Where to Find It � From the right-mouse button over a feature click Parent/Child. 

13 Parent/Child relationships.
Check the relationships on the plane. 

Right-click the plane and select Parent/

Child.... The Parent of the plane is the 

Base_Plate feature – the plane is 
dependent upon it. The Children are 

Sketch3 and the Circular_Boss; they 
are dependent on the plane.

Click Close and roll forward.

14 Feature Circular_Boss. 
Circular_Plane was used for sketching 
Circular_Boss. The sketch was extruded 
through the part from the rear.

Roll forward to a position just before the 

Wall_Thickness feature.

15 Feature Rib_Under.
This feature was sketched as a rectangle 

and extruded up into the Circular_Boss. 
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Rollback to a 
Sketch

If the rollback bar is dragged and dropped between an absorbed sketch 

and its feature, a dialog appears. The dialog tells you that you have 

chosen to rollback to an absorbed feature and that the feature will be 

temporarily unabsorbed so it can be edited. This changes the sequence 

so that the sketch precedes the feature.

16 Rollback to Sketch4.
Move the rollback bar to a position between the 

Rib_Under feature and its sketch Sketch4. The 
message appears: 

You have chosen to rollback to Sketch4 
which is absorbed in feature Rib_Under. 
The following features will be temporarily 
unabsorbed for editing purposes: Sketch4

Click OK.

Tip This technique is very useful when editing 

features that have multiple sketches such as 

Sweep and Loft features.

Sweeps and lofts are covered in the course 

Advanced Part Modeling.

17 Roll Forward.

Roll forward to a position after Sketch4.
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18 Edit Sketch Plane.

Right-click the Sketch4 feature and 
choose the option Edit Sketch Plane to 

determine which sketch plane was used. 

The highlighted face identifies the sketch 

plane.

Click Cancel and roll forward to a 

position after the Wall_Thickness 
feature.

Note The selection for Sketch Plane/Face can be cleared to force the sketch 

plane reference to dangle. A confirmation message appears in that case:

There is no selection for the sketch plane reference. Select OK 

if you would like this to be a dangling reference.

19 Feature Wall_Thickness.
The model was shelled out leaving both 

circular faces and the bottom face open. 

See the section cut at the right for details.

Roll forward to a position after the 

CounterBore feature.

20 Feature CounterBore.
The Hole Wizard was used to create a 

counterbore hole on the top planar face. 

However, due to the thin wall, it appears

as a simple cut.

Roll forward to a position after the 

LPattern1 feature.

21 Pattern feature.

The CounterBore was patterned using
a linear pattern, LPattern1.

Roll forward to a position after the 

Rib_Fillet feature.
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22 Rib_Fillet feature.
The Rib_Fillet feature creates fillets where 
the Rib_Under joins the Circular_Boss 
and Base_Plate.

Right-click and select Roll to End.

23 Circ_Fillet feature.
This feature creates fillets on both sides of 

the Vertical_Plate.

Rebuilding 
Tools

Rebuilding a model incorporates the changes that you have made. Slow 

rebuild times can slow down the modeling process significantly. There 

are some tools available to optimize rebuilding times.

Rollback to 
Feature

Rollback can be used to limit the rebuilding time by 

rolling back to the feature being edited. For example, 

if the Vertical_Plate is being edited, rollback to a 
position just after that feature.

Changes are made to the feature and it is rebuilt. Due 

to the rollback position, only the features before the 

bar are rebuilt, limiting the scope of the rebuild. The 

remainder of the part will be rebuilt when the bar is 

moved. 

Rebuild Feedback 
and Interrupt

During a rebuild, a progress bar and status are shown on the bottom bar 

of the SolidWorks window. The rebuild can be stopped by pressing the 

Esc (Escape) key. 
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Feature 
Suppression

Feature Suppression is a more permanent method 

of limiting rebuild time. Features that are suppressed 

are not rebuilt. Configurations can be used to arrange 

combinations of suppressed features.

Feature Statistics Feature Statistics is a tool that displays the amount of time it takes to 

rebuild each feature in a part. Use this tool to identify the features that 

take a long time to rebuild. Once they are identified, you can possibly 

edit them to increase efficiency, or suppress them if they are not critical 

to the editing process.

Introducing: Feature 
Statistics

The Feature Statistics dialog box displays a list of all features and 

their rebuild times in descending order.

� Feature Order 

Lists each item in the FeatureManager design tree: features, sketches, 

and derived planes. Use the shortcut menu to Edit Feature, Suppress 

features, and so on.

� Time%

Displays the percentage of the total part rebuild time to regenerate each 

item.

� Time

Displays the amount of time in seconds that each item takes to rebuild.

Where to Find It � From the menu, select Tools, Feature Statistics....

1 Feature Statistics.

Click Tools, Feature Statistics....

The features are listed in descending 

order according to the amount of time 

required to regenerate them.
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Interpreting the Data The first thing to keep in mind is that the total rebuild time for this part 

is approximately 1/4 second, so a change to any one feature is not likely 

to make a significant difference.

The second thing is the number of significant digits and rounding error. 

For example, Feature1 may appear to take twice as long to rebuild as 

Feature2, 0.02 seconds versus 0.01 seconds. Does this indicate a 
problem with Feature1? Not necessarily. It is quite possible that 
Feature1 takes 0.0151 seconds while Feature2 takes 0.0149 seconds, 
a difference of only 0.0002 seconds.

Use Feature Statistics to identify features that significantly impact 

rebuild time. Then either:

� Suppress features to improve performance.

� Analyze and modify features to improve performance.

What Affects 
Rebuild Time?

Features can be analyzed to determine why they behave as they do. 

Depending on the feature type and how it is used, the reasons will vary. 

For sketched features, look for external relations and end conditions 

that reference other features. Keep these relations attached to the 

earliest feature possible. Do the same for sketch planes.

Tip In general, the more parents that a feature has, the slower it will rebuild.

See Repairing Relations Using Display/Delete Relations on page 275 

for an example of changing relations in a sketch.

For features applied to edges or faces, check the feature’s options and 

the position of the feature in the FeatureManager. See4 Edit Feature. on 

page 311 for an example of changing relations in a feature.

General Tools In general, there are four tools available to modify features:

� Edit Feature (see Introducing: Edit Feature on page 82) 

� Edit Sketch (see Introducing: Edit Sketch on page 81) 

� Edit Sketch Plane (see Introducing: Edit Sketch Plane on 

page 277) 
� Delete Feature 

Deletions Any feature can be deleted from the model. Consideration should be 

given to what other features, other than the selected one, will be deleted 

with it. The Confirm Delete dialog lists Dependent Items that will be 

deleted with the selected one. The sketches of most features are not 

automatically deleted. However, the sketches associated with Hole 

Wizard features are automatically deleted when the hole is deleted. For 

other dependent features, deleting the parent will delete the children.
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2 Delete feature.

Select and delete the 

CounterBore feature. The check 
box, Also delete all child 

features, is already checked. The 

dialog indicates the LPattern1 
feature will also be deleted 

because it is a child of the 

CounterBore.

Click Yes to confirm the deletion.

Reorder Reorder allows for changes to the sequence of features in the model. 

Sequence changes are limited by parent/child relationships that exist. 

Reorder features by dragging and dropping them onto other features in 

the FeatureManager design tree. They are placed after the feature that 

they are dropped onto. 

Note You cannot reorder the target (child) feature before the parent feature.

3 Try to reorder.

Try to reorder the shell feature, Wall_Thickness, to a position 
immediately after the Base_Fillet. The cursor displays a “no move” 

 symbol. If you try to drop the feature, this message appears:

Cannot reorder. Change would put child feature before parent 
feature. 

The Circular_Boss references need 
to be removed in order for us to be 

able to reorder the feature. 

4 Edit Feature. 
Right-click the Wall_Thickness 
feature and select Edit Feature.

Select both of the highlighted 

circular faces. The Faces to 

Remove selection list will show 

only a single face.
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Note When you reselect an already selected face, it acts like a toggle, 

deselecting it.

As an alternative, you can click on an item in the selection list and 

deselect it by pressing the Delete key on the keyboard. Sometimes this 

can be confusing because you might not always know which face is 

labeled Face<2>.

5 Changes to dependencies.

Editing the Wall_Thickness feature 
causes a change in the 

dependencies. The parent is now in 

only one feature, the Base_Plate.

The feature can now be reordered. 

6 Reorder.

Drag the Wall_Thickness feature 
and reorder it by dropping it on 

the Base_Fillet. It is positioned 
after the Base_Fillet feature.

7 Results. 

Now the shelling operation affects only 

the first and second features of the part.

8 Editing the sketch.

Edit the sketch of the Vertical_Plate 
feature.

9 Add new relation.
Hold down Ctrl and 

select the rightmost 

vertical line and the arc. 

Right-click and select 

Make Tangent  to add 

a Tangent relation 

between the line and the arc. 
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Overdefined 
Sketches

If the status of the sketch changes from fully defined to over defined 

(see Status of a Sketch on page 38), a diagnostic tool appears. This tool 

can be used to repair the sketch. Other unfavorable states can be 

repaired as well.

10 Over defined. 

The addition of the 

relation triggers an 

error in the sketch. The 

sketch is now over 

defined. 

SketchXpert The SketchXpert option is used to automate the repair of Over 

Defined, No Solution Found, or Invalid Solution Found conditions in 

the sketch. The SketchXpert is based on SolidWorks SWIFT 

technology.

Note General part editing and repairs were discussed in Lesson 8:  Editing: 

Repairs.

Where to Find It � Click the Over Defined (or other condition) button in the lower 

right corner.

11 Over Defined.

When the sketch 

becomes Over Defined, 

a message pops up from 

the lower right corner of 

the screen. Click on the 

text Over Defined.
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12 Diagnose.

Click Diagnose and click the  button to walk through the solutions. 

Each solution represents a possible solution. Each set uses a different 

combination of relations and dimensions. Relations or dimensions that 

will be removed by selecting that set are marked with a red line through 

them. They are also listed in the More Information/Options group in the 

PropertyManager. 

13 Select.

Accept the solution that 

deletes the horizontal 

linear dimension. 

Possible Solutions 1-4



SolidWorks 2011 Lesson 9
Editing: Design Changes

315

Manual Repairs The Manual Repair option can also be used to 

resolve the over defined state. Using this option, 

the conflicting relation or dimension is selected 

and deleted. 

14 Exit the sketch.

15 Resulting model.

This moves the 

Circular_Boss so that 
its cylindrical face is tangent 

to the outer edge of the 

Base_Plate. The fillets 
update to the new positions.

16 Edit the Rib_Under sketch. 
The Rib_Under sketch is still tied 
to its original relations, the outer 

edge of the Base_Plate. 
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17 Display relations.

Show all the geometric relations in 

the sketch using the All in this 

sketch option. In order to 

reposition the rib, most of the 

relations must be deleted.

Select and remove these relations 

using the Delete button:

� Collinear relation to the vertical edge of the Base_Plate.
� Both Distance relations (the two dimensions).

Keep the Collinear relation to the Vertical_Plate and the Vertical 
relation on the left hand line.

18 New geometry.

Delete the bottom line of the 

rectangle and add a tangent arc. 

Dimension the sketch as shown.

Tip Shift+select the arc when creating the 2mm dimension. 

19 Vertical relation.

Deleting the Collinear relation 

leaves the right vertical line 

without any relation to keep it 

vertical. To fix this, add a 

Vertical relation to the 

rightmost line.

20 Temporary graphics.

Turn on display of Temporary 

Axes and relate the center of the 

arc to the temporary axis. This 

will center the rib on the circular 

boss. Close the sketch. 
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21 Result.

The Rib_Under feature is now centered 
under the Circular_Boss. It has a 
rounded front edge and is also inside the 

edge of the boss by a small amount.

22 Edit Sketch Plane.

Expand the listing of the Circular_Boss 
feature. Right-click the sketch and select 

Edit Sketch Plane from the shortcut 

menu.

You do not have to edit the sketch.

23 Face or plane selection.

The current plane used in the sketch 

is highlighted. You can now choose a 

new sketch plane.

Select the rear face of the model and 

click OK.

24 Edited sketch plane.

The Circular_Boss feature has 
been edited. The sketch now 

references a model face rather than a 

plane.

25 Delete the plane.

Check the Parent/Child Relationships of the plane. The 

Circular_Plane now has no children. 

Delete the plane.
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26 Edit Feature.

Edit the Circ_Fillet feature. 
Add the edge shown and click 

OK.

27 Result.

The additional edge is filleted as 

part of the Circ_Fillet feature.

28 Save and Close.

An existing part will be used for 

the reminder of the case study.

29 Open Partial_Editing CS.
Open an existing part that is identical except for one additional sketch, 

Contour Selection. The sketch contains two circles enclosed within a 
rectangle.

30 Reorder and rollback.

Reorder the Contour Selection 
sketch to a position between the 

Base Fillet and Wall_Thickness 
features.

Rollback to a position between 

the Contour Selection sketch 
and Wall_Thickness feature.
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Sketch 
Contours

Sketch Contours allow you to select portions of a sketch that are 

generated by the intersection of geometry and create features. This way 

you can use a partial sketch to create features.

Another advantage of this method is that the sketch can be reused, 

creating separate features from different portions of the sketch.

Two commands, Contour Select Tool and End Select Contours, are 

used to start and end the contour selection process.

Contours 
Available

There are often multiple Sketch Contours available within a single 

sketch. Any boundary generated by the intersection of sketch geometry 

can be used singly or in combination with other contours.

Using this sketch as an example, there are some of the possible regions, 

contours and combinations available for use.

Individual 
Regions

Individual 
Contours

Combined 
Contour 
Selection
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Introducing: 
Contour Select Tool

The Contour Select Tool is used to select one or more contours for use 

in a feature. The cursor looks like this:  when the Contour Select 

Tool is active.

Where to Find It � Right-click in the graphics area and choose Contour Select Tool.

� Right-click a sketch and choose Contour Select Tool.

Introducing: End 
Select Contours

End Select Contours is used to end the selection of contours.

Where to Find It � Right-click in the graphics area or on the sketch in the 

FeatureManager design tree and choose End Select Contours.

� Click the Confirmation Corner symbol .

31 Extrude a cut.

Use the Contour Select Tool to 

select the rectangular region of the 

sketch.

Create a blind cut, 10mm deep into 

the model.

Rename the feature Hole_Mtg.

Shared Sketches A sketch can be used more than once to create multiple features. 

When you create a feature, the sketch is absorbed into the feature and 

hidden from view. When you activate the Contour Select Tool, the 

sketch is automatically made visible.

32 Add more cuts.
Select the sketch of the 

Hole_Mtg feature and click 

Extruded Cut  on the 

Features toolbar. 

Expand the Selected 

Contours list and select the 

two circular regions of the 

sketch.

Extrude the regions using the 

end condition Through All.

Rename the cuts Thru_Holes.
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33 Roll to End.

Right-click in the 

FeatureManager design tree 

and select Roll to End. Note 

that the cut holes are used in 

the shelling operation to 

create additional, unneeded 

faces.

34 Reorder.

Reorder the Thru_Holes feature to a position 
after the Wall_Thickness feature. The result 
is that the Thru_Holes feature is not affected 
by the shelling.

35 Change wall thickness.
Change the wall thickness to 6mm and rebuild 

to complete the model.
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Copying Fillets A quick and easy way to create a new fillet is to copy it from an 

existing feature. The new fillet is the same type and size but unrelated 

to the original. 

36 Copy.

Hold down Ctrl and drag the Circ_Fillet feature onto the edge of the 
model. Release the mouse button.

The fillet can be copied from the FeatureManager design tree, or 

directly from the model.

Tip Chamfers can be copied using the same procedure.

37 New fillet feature.

A new fillet feature is created on the edge. 

Edit the fillet and add the edge on the opposite side. Change the radius 

value to 3mm.

38 Trimetric view.

Change the view orientation to a 

Trimetric view.
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Introducing: Section 
View

Section View cuts the view using one or more section planes. The 

planes can be dragged dynamically. Planes or planar faces can be used. 

Where to Find It � Click Section View  on the View toolbar.

� Or, click View, Display, Section View.

Note Drawing view sections can also be created by clicking OK and saving a 

Drawing Annotation View. They are added to the drawing using the 

View Palette.

39 Select Face.

Select the planar face indicated. It will be used 

to define the section plane.

Note You do not have to pre-select the section plane. 

If you do not, the system will use a default 

section plane, usually the Front.

40 Section view.

Click Section View  to use 

the selected face as the 

section plane.

The Section 1 group box 

includes options for the 

Reference Section Plane, 

Section Direction, Offset 

Distance and Angles.
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41 Drag the plane.

Using the arrows, drag in a 

direction normal to the plane and 

drop.

The plane angle can be changed by 

dragging the edges of the section 

plane.

42 Reverse section direction.

Click Reverse Section Direction 

 to reverse the direction of the 

section. 

Click Cancel to close the dialog. 

43 Save and close the model.
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Editing with 
Instant 3D

The tools of Instant 3D allows you to create 

geometry quickly and accurately. It includes 

drag and drop tools with on screen rulers to 

change dimension values. The tools include:

� Rulers to measure depth.

� One-click value change. 

Where to Find It � Click Instant3D  from the Features toolbar.

Instant3D Handles These tools depend on the Instant3D  icon, which must be toggled 

on. The Instant3D mode displays spherical handles to move and resize 

geometry by dragging using a ruler. 

Dragging Face 
Geometry

When a face is selected, there are several tools available to edit the 

geometry of that face and the feature it belongs to. 

Face Normals Face normals appear when faces 

are selected in Instant3D mode. 

In some cases, they can be 

dragged to reposition that face, as 

shown at right. 

If the face is dragged in the 

opposite direction of the 

extrusion, the feature is modified. 

It can be changed from a boss to 

a cut, or vice-versa, depending on 

the direction and distance that it 

is dragged. 

OnOff
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Note If the face is fully defined, the 

message appears:

This object is fully constrained.

A symbol appears, and the normal 

cannot be dragged. 

Dragging to a Face 
or Vertex

The ruler dimension can be set by a face or vertex selection when a face 

normal is used. See Drag to Depth on page 327 for more information. 

Moving the Feature The 2-axis triad that appears on face selection can be used to move the 

feature if the feature is under defined. You can also choose to delete the 

constraints that are holding it in order to move it. 

One Click 
Changes

Instant3D mode also allows for one-click value 

changes. Click the dimension text and it can be 

changed directly.

Tip Anytime you are making changes to a model, using this or other 

methods, errors and warnings may appear and require repairs. Refer to 

Editing: Repairs and the previous sections of this lesson for reference. 

1 Open the part Instant. 

2 Drag dimensions. 

Click the figure_eight 
feature and set these 

values using drag or 

direct selection of the 

dimension as shown. 

The dimensions are: 

40mm, 50mm and 

22mm. 
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3 Drag angle. 

Click the angle plane and drag to 
33° as shown. 

4 Width. 

Click the dimension and use One Click 

Change to make it 30mm as shown. 

Drag to Depth Using the Alt key, the depth of an extrusion can be set to the same value 

as an existing depth defined by a face or vertex selection. 

5 Drag using Alt. 

Click the face of the out feature as shown and drag the face normal. 

Press and hold the Alt key while moving the cursor to the face of the 

well feature and drop it as shown. The depths of both features are set to 
the same depth value 19mm.
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Live Section Plane The Live Section Plane is used to dynamically section the model with 

a plane. The thickened edges of the section can be selected and dragged 

with rulers. The unthickened edges are not editable. 

Where to Find It � Right-click a plane or planar face and select Live Section Plane.

6 Create live section plane. 

Right-click the Front plane and select 
Live Section Plane. The section plane 

is added to the part with an active triad. 

Live Section Plane 
Folder

The Live Section Plane feature is stored as 

Live Section Plane1 under the Live Section 
Planes folder of the FeatureManager Design 

Tree. 

It can be shown/hidden or suppressed/

unsuppressed from this position. 

Can be dragged Cannot be dragged
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7 Drag edge. 

Right-click the Live 
Section Plane1 feature and 
select Fit To Part. 

Drag the edge as shown 

upward, reversing the 

direction of the extrusion. 

The distance value is not 

important. 

Note It is clear that although the depth values of the out and well features 
were equal in step 5 on page 327, they are not tied together. 

8 Up to surface. 

Click Undo  to negate the 

change. Right-click the later 

of the two features, out, and 
select Edit Feature. Using 

Up To Surface, select the top 

face of the well as shown and 
click OK. 
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9 Drag another edge. 

Drag the edge as shown 

upward, setting the value at 

10mm. 

This time the edge of the 

well feature is dragged, 
rather than the edge of the 

out feature. This is due to 
the relationship that was 

created in the previous step. 

10 Hide live section plane. 
Expand the Live Section Planes folder. Right-
click the Live Section Plane1 and select 

Hide . 

11 Hole repairs. 

Show Sketch7 of the Ø10.0 (10) 
Diameter Hole1 feature. Double-click 
the Sketch9 of the Ø8.0 (8) 
Diameter Hole1 feature to edit it. 
Locate the points on the sketch 

endpoints as shown by drag and drop. 

Tip Dragging the geometry of a Hole Wizard feature, 

except for blind hole depths, should be avoided. 

These dimensions are standard sizes and should 

not be changed. If they are inadvertently changed, 

edit the feature and click Restore Default Values. 

12 Save and close the model. 
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Exercise 41:
Changes

Make changes to the part created in the 

previous lesson. 

This exercise uses the following skills:

� Deletions on page 310.

� Reorder on page 311.

� Copying Fillets on page 322

Procedure Open an existing part.

1 Open the part Changes.
Several changes and additions will be 

made to the model.

2 Delete.

Delete the mounting holes, cutout and 

shell (Cut-Extrude1, 
Wall_Thickness and Cut-Extrude2) 
and absorbed features from the model.

3 Same thickness.

Set the thicknesses of the Base_Plate 
and Vertical_Plate to the same value, 

12mm.
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4 Cut.

Remove the portion of the 

Vert_Plate on the right side of the 
Circular_Boss and Rib_Under.

Edit, Rollback and Reorder features 

where necessary to maintain the 

filleting.

5 Fillet.
Add another fillet the same radius as 

the Circ_Fillet.

6 Counterbored holes.

Add two counterbored holes of the 

following size:

ANSI Metric

M6 Hex Cap Screw

Through All

Reorder features where necessary to 

avoid undercuts.

7 Save and close the part.
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Exercise 42:
Editing

Edit this part using the information and dimensions provided. Use 

relations, up to surface end conditions to maintain the design intent.

This lab reinforces the following skills:

� Reorder on page 311.

Procedure Open the existing part EDITING, and make several edits:

Change the existing part, editing and adding geometry and relations, to 

match the version shown below.



Exercise 43 SolidWorks 2011
SketchXpert

334

Exercise 43:
SketchXpert

Use the SketchXpert to repair 

the part.

This lab reinforces the 

following skills:

� SketchXpert on page 313.

Procedure Open an existing part and named SketchXpert. Repair the sketches as 
shown in the following steps. 

1 Edit Sketch1. 
Expand the Base-Extrude 
feature and edit the sketch 

Sketch1. Click View Normal To 

to orient the sketch as shown. 

2 Solution. 

Start the SketchXpert and click 

Diagnose. Choose the solution 

shown at right. 
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3 Other sketches. 

Complete repairs to the remaining two sketches using SketchXpert.

Edit Sketch3 from the Cut-Extrude1 
feature. Select the solution shown. 

Edit Sketch9 from the Ø10.0 (10) 
Diameter Hole1 feature. Use Manual 
Repair and delete the relations shown. 

4 Save and close the part.
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Exercise 44:
Instant 3D

Use the Instant 3D tools to create, edit 

and complete the part.

This lab reinforces the following skills:

� Editing with Instant 3D on page 325.

� Instant3D Handles on page 325.

� Dragging Face Geometry on 

page 325.

� One Click Changes on page 326.

Procedure Open the existing part Instant_Lab and edit geometry as shown in the 

following steps.

Note Repair any fillet errors that may occur. 

1 Open the part Instant_Lab. 

2 Select face. 

Select the face of the Stop 
feature as shown. 

3 Drag handle. 

Drag the handle of the 

dimension to 70mm. 
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4 Drag angle. 

Click the Angle plane and drag 
the handle to 50° as shown. 

5 Holes. 

Change the display to show 

the rear of the model. 

Edit the Ø12.0 (12) 
Diameter Hole1 feature and 
change to an Up To Next end 

condition to prevent the 

extended cuts. 

6 Driving sketch. 
The Layout sketch was intended to drive the position of the Thin 
Feature. 

Click the Layout sketch and drag the dimension to 35mm. 

The change has no effect on the Thin Feature.
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7 Edit sketch. 

Edit the sketch of the Thin Feature and 
delete the 20mm dimensions. Drag the 

endpoint to the intersection of the 

construction lines. Also. select both lines 

and add an Equal relation. 

Exit the sketch. 

8 Holes. 

Click the Ø12.0 (12) 
Diameter Hole1 feature 
and click the 110mm 

dimension. Type 100. 

9 Save and close the model. 
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Exercise 45:
Contour 
Sketches

Edit these parts using the information provided. Extrude profiles to 

create the geometry.

This lab reinforces the following skills:

� Sketch Contours on page 319.

� Shared Sketches on page 320.

#1
Depth: 50mm
and 30mm

#2
Depth: 3.5”, 1” 
and 2.5”

#3
Depth: 30mm and 
10mm

#4
Depth: 1.5” and 
0.5”
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Handle Arm

Oil Pump

Idler Arm
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Lesson 10
Configurations

Upon successful completion of this lesson, you will be able to:

� Use configurations to represent different versions of a part within a 

single SolidWorks file.

� Use configure feature to create and edit configurations.

� Suppress and unsuppress features.

� Change dimension values by configuration.

� Suppress features by configuration. 

� Link dimension values together to capture design intent.

� Create equations.

� Understand the ramifications of making changes to parts that have 

configurations.

� Use the design library to insert features into a part.



Lesson 10 SolidWorks 2011
Configurations

342

Configurations Configurations allow you to represent more than one version of the part 

in the same file. For example, by adding the machined features (holes, 

chamfers, pockets, etc.) and changing dimension values in the parts at 

the top of the illustration, you can represent the rough forgings shown 

below them.

This lesson addresses the use of configurations in parts. Assembly con-

figurations are covered in another lesson.

Terminology Some of the terms used when discussing and working with 

configurations are explained below.

Configuration Name The Configuration Name appears in the ConfigurationManager. It is 

used to distinguish between configurations within the same part or 

assembly at the part, assembly or drawing level.

Suppress/
Unsuppress 
Features

Suppress is used to temporarily remove a feature. When a feature is 

suppressed, the system treats it as if it doesn’t exist. That means other 

features that are dependent on it will be suppressed also. In addition, 

suppressed features are removed from memory, freeing up system 

resources. Suppressed features can be unsuppressed at any time.

Other Configurable 
Items

In addition to features, other items can be suppressed and unsuppressed 

using configurations:

� Equations
� Sketch Constraints
� External Sketch Relations
� Sketch Dimensions
� Colors

Sketch Planes and extrude End Conditions can be set differently on a 

configuration by configuration basis.
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Using 
Configurations

Both parts and assemblies can have configurations. Drawings do not 

have configurations of their own but drawing views can display 

different configurations of the files they reference.

Methods to Create 
Configurations

SolidWorks allows you several methods to create configurations. 

Convenience often dictates the method used, but the methods can be 

mixed as needed. The chart below lists options. 

Procedure In this lesson you will learn about using configurations within a part 

file. In Lesson 12: Bottom-Up Assembly Modeling, you will explore 

using configurations in conjunction with assemblies.

Begin this example by following this procedure:

1 Open the Ratchet Body.

Method Description

Manually add names Right-click on the top level component or 

the blank space in the 

ConfigurationManager and choose Add 

Configuration. This creates a new 

configuration name. When you add a new 

configuration, that configuration becomes 

active. See Adding New Configurations on 

page 344.

Copy and Paste Select a configuration name in the 

ConfigurationManager and copy it using 

any of the standard techniques for copying 

a feature: Ctrl+C, Edit, Copy, or the  

tool. Paste the configuration using Ctrl+V, 

Edit, Paste, or the  tool. 

Configure Feature Right-click on a feature, material or 

dimension to access Configure Feature 

Material or Dimension tool in the Modify 

Configurations dialog. Use the <Creates 

a new configuration.> cell to add a new 

configuration. See Creating 

Configurations on page 344. 

Design Table A design table uses Microsoft Excel to 

create configuration names and track the 

changes. Because it uses Excel, the power 

of that product can be used in the creation 

of the configurations. 
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Accessing the 
Configuration-
Manager

Configurations are managed from within 

the same window that is occupied by the 

FeatureManager design tree. To switch the 

display within this window, use the tabs located at the very top of the 

window pane. Clicking the  tab will display the 

ConfigurationManager (shown at the upper right) with the default 

configuration listed. The default configuration is named Default. (Who 

says we don’t have a sense of humor?) This configuration represents 

the part as you modeled it — with nothing suppressed or changed. 

When you want to switch back to the FeatureManager display, click the 

 tab.

Defining the 
Configuration

You define the configuration by turning off or suppressing selected 

features in the part. When a feature is suppressed, it still appears in the 

FeatureManager design tree, but it is grayed out. This version of the 

part is saved or stored in the active configuration. You can create many 

different configurations within a part. You can then easily switch 

between different configurations using the ConfigurationManager.

Creating 
Configurations

Configuring a feature or dimension means to alter it based on a 

configuration. For a feature, its suppression state (suppressed or 

unsuppressed) can vary by configuration. For a dimension, its value 

can vary by configuration. 

Adding New 
Configurations

Configurations can be created manually. There are several options 

beyond the Configuration name that you can set in the new 

configurations.

Where to Find It � Position the cursor within the ConfigurationManager and from the 

right-mouse menu, choose Add Configuration...

Bill of Materials 
Options

Sets the name that should appear under Part Number in a BOM.

Advanced Options The advanced options include rules for creation of new features and 

color settings. Parent/Child options are for assemblies only.

� Suppress new features and mates 
This option controls what happens to newly created features when 

other configurations are active and this configuration is inactive. If 

checked, new features added with other configurations active are 

suppressed in this one.

� Use configuration specific color
Allows for different colors for each configuration using the color 

palette. Different materials may introduce different colors.



SolidWorks 2011 Lesson 10
Configurations

345

2 ConfigurationManager. 

Click the ConfigurationManager tab . 

3 Add new configuration. 

Place the cursor in the Configurations area and 

right-click Add Configuration.

Type the name Forged, Long and click Suppress 
features under Advanced Options. Click OK. 

Tip The active configuration is shown in color. The inactive configurations 

are greyed out. 
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Splitting the 
FeatureManager 
Window

Many times it is efficient to be able to 

access both the FeatureManager design 

tree and the ConfigurationManager at 

the same time. This is particularly true 

when working with configurations. 

Rather than switch back and forth using 

the tabs, you can split the FeatureMan-

ager window top to bottom, creating 

two panes. One pane can show the Fea-

tureManager design tree and the other 

can show the 

ConfigurationManager.

To subdivide the FeatureManager 

window into two panes, drag the splitter 

bar downwards from the top of the 

window. Use the tabs to control what is 

displayed in each pane. 

4 Split. 

Split the FeatureManager Window and arrange it like the image shown 

in Splitting the FeatureManager Window on page 346 with the 

FeatureManager design tree on the top and the ConfigurationManager 

on the bottom. 
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5 Check Parent/Child.

Right-click the Recess feature and select Parent/Child. From the 

dialog, right-click the Pocket feature and select Parent/Child. 

Introducing: 
Suppress

Suppress is used to remove a feature from memory, essentially 

deleting it from the model. It is used to remove selected features from 

the model to create different “versions” of that model. All the children 

of a feature that is suppressed are suppressed with it.

Unsuppress and Unsuppress with Dependents are used to reverse 

the effect of suppression on one (unsuppress) or more (unsuppress with 

dependents) features.

Where to Find It � From the right-mouse menu, click Suppress.

� Or, click the Suppress tool  on the Features toolbar.

� Or, choose Edit, Suppress from the pull-down menu.

� Or, click Suppressed in the Feature Properties dialog box.

6 Suppress. 

Close the open dialog. Right-click the 

Recess feature and select Suppress . 

The system suppresses not only the Recess 
but also the Pocket, the Wheel Hole, and 
the Ratchet Hole. Why? Because the 

Pocket, and Ratchet Hole are all children 
of the Recess (see step 6 on page 347) and 
the Wheel Hole is a child of the Pocket. 

If you recall, the Pocket was sketched on 
the bottom face of the Recess. The two 
holes were then sketched on the bottom face 

of the Pocket. This is what established the 
parent-child relationships among them.

When the features are suppressed in the 

FeatureManager design tree, their 

corresponding geometry is suppressed in 

the model, too. 
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Copy and Paste 
Configurations

When you create a new configuration, the active configuration and 

settings are used to form the new configuration. You can also select any 

configuration, active or not, and copy it and paste it into the 

ConfigurationManager. 

The name will be Copy of <copied configuration> and it will be 
inactive. 

Changing the Active 
Configuration 

To make a different configuration active, simply double-click on the 

one that you want in the ConfigurationManager. Only one 

configuration can be active at any time.

7 Copy and paste. 

Select the Forged, Long configuration and click Edit, Copy. Click in 
the Configurations section and click Edit, Paste. 

8 Rename. 

Rename the configuration to Forged, Short. 
Double-click it to make it the active configuration. 

Other Ways to 
Configure

There are other ways to configure features and dimensions after the 

configuration names have been established. 

Features Features can be suppressed or unsuppressed 

in the active, specified, or all configurations 

using Properties.

Right-click the feature and select Feature, 

Properties. Check or clear Suppressed 

and select the configurations using the drop-

down list.

Dimensions Double-click a dimension and 

change the value. In the drop-

down, choose This Configuration 

, All Configurations  or 

Specify Configurations . 



SolidWorks 2011 Lesson 10
Configurations

349

If Specify Configurations is chosen, 

selected configurations can be chosen 

from the list of all configurations. 

9 Change dimension value. 

Double-click the Handle feature and double-click the 220mm 

dimension. Type the value 180 and select This Configuration . 

Click Regenerate  and OK. 

10 Create new configuration. 

Create a new configuration by copy and paste or Add Configuration. 

Name the configuration Machined, Short. 

Unsuppress with 
Dependents

The options Unsuppress with Dependents and Suppress with 

Dependents can be used to unsuppress or suppress a feature and all 

dependents. 

Note Using unsuppress affects a single feature (see Introducing: Suppress on 

page 347) not the feature and children. 

Where to Find It � Click Edit, Unsuppress with Dependents, This Configuration, 

All Configurations or Specified Configurations. 
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11 Unsuppress. 

Select Recess and click Edit, Unsuppress with Dependents, This 
Configuration. 

Configuration 
Naming

Configurations can be renamed in the same way as features. However, 

if a configuration is being referenced by another SolidWorks document, 

renaming that configuration can cause some difficulties.

A Better Approach Instead of renaming the default configuration we will make a copy of it 

and then rename the copy. 

The configuration Machined, Long is the same as Default. 

12 Copy and paste. 
Copy the configuration Default and rename it to Machined, Long. 
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Completed 
Configurations

The completed configurations (not including Default) are shown 
below. 

13 Save and close the file. 

Using Link 
Values, 
Equations and 
Configure 
Feature

This section combines several useful tools in the process of creating a 

socket part. Link Values are used to set dimensions equal to one 

another. Equations are used to create a mathematical relationship 

between dimensions. Configure Feature/Dimension provides a table-

driven method to create and manage configuration. 

The design of this socket will be 

based upon an ANSI Metric size M5 

Hex Nut Style 1 component. The 

distance across the flat faces is 

8mm and the depth is 4.7mm. 

The cut in the socket will be larger 

than those dimensions to 

accommodate the nut. 
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1 Open Socket.
The Socket part (shown 
here with Show Feature 

Dimensions and View, 

Dimensions Names on) 

contains two cut features 

that represent the 

overlapping hexagon cuts. 

They retain their original 

names.

Note Right-click the Annotations folder to toggle Show Feature 
Dimensions on. Click View, Dimensions Names. 

2 Change value.

Double-click the 6 Point feature and double-click 
the 11mm dimension. Change the value to 8mm 

and add 1mm to the nominal value to represent the 

gap between a bolt head and the socket as shown. 

We are using a unit value to make the configurations easy to work with. 

Click OK. 

Link Values Link Values can be used to set a series of dimensions equal by 

assigning them the same name. Changing the value of any of the linked 

dimensions changes all of them. The linking can be removed using 

Unlink Value. This option is superior to equations for setting several 

values equal to each other.

In this example there are two linear dimensions: one in each of the 

hexagon shaped cuts. Link values will be used to tie them together.

Where to Find It � From the Dimension Modify dialog, choose Link Value.

� Right-click one or more dimensions and select Link Values.

Note The dimensions being linked together must be of the same type. Link 

angular dimensions to other angular dimensions and so forth.

3 Access link values.
Double-click the same dimension as if to change 

the value. Using the drop-down menu, select Link 

Value.



SolidWorks 2011 Lesson 10
Configurations

353

4 Name the link value.

In the Shared Values dialog, type the name AcrossFlats and click 
OK.

5 Link Value added.
The link value is added and is used as the 

dimension name. A prefix symbol is also 

added to identify this dimension as being 

linked. 

6 Equation folder.

The link value is listed under the Equations folder in 
the FeatureManager design tree.

7 Add link value.

Double-click the sketch of the 12 Point feature and double-click the 
11mm dimension. Using the drop-down menu, select Link Value and 

select AcrossFlats from the drop-down. The value of the existing link 

value is assigned to this dimension. 

Rebuild the model.
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Equations Many times you will need to establish a relationship between 

parameters that cannot be achieved using geometric relations or 

modeling techniques.

For example, you can use equations to establish mathematical relations 

between dimensions in the model. This is what we will do next.

This equation will establish a relationship between the diameter of the 

cylinder and the distance across the flats of the hex. As the distance 

across the flats increases, so will the diameter.

Note Simple equality statements within a part can be created more easily 

with Link Values than equations.

Preparation for 
Equations

Although you can begin writing equations and applying them to the 

model with little or no preparation, it is a much better practice to make 

a small investment in time up front to achieve added benefit later on. 

You should consider the following:

� Renaming the dimensions

Dimensions are created by the system with 

somewhat cryptic default names. To make it easier 

for others to interpret the equations and understand 

what exactly is being controlled by them, you 

should rename the dimensions giving them more 

logical and easily understood names. Click a 

dimension, select the Value tab and click in the 

Primary Value to rename it. Only the portion 

before the @ sign is changed. 

Note When equations are used in an assembly, the full name uses the form: 

Name@FeatureName@PartName.

� Dependent versus independent

The SolidWorks software uses equations of the form Dependent = 

Independent. This means that in the equation A = B, the system solves 

for A when given B. You can edit B directly and change it. Once the 

equation is written and applied, you cannot directly change A. Before 

you start writing equations, you need to decide which parameter will 

drive the equation (the independent one) and which will be driven by 

the equation (the dependent one).

� Which dimension drives the design?

In this example, we will control the diameter of the cylinder based on 

the distance across the flats of the hex. This means the flat distance is 

the driving or independent parameter and the diameter is the driven or 

dependent one. The size of the hex drives the design. 
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Functions The functions displayed as buttons on the Add Equation dialog box 

include basic operators, trigonometry functions and many more.

Equation form The equation required in this example uses the distance across the flats 

of the hex as the driving dimension. This forces changes in the cylinder 

diameter, a feature that precedes it. The form is:

Driven Dimension = Driving Dimension + Constant

where:

Driven Dimension = CylinderDiameter@Sketch1

Driving Dimension = AcrossFlats@Sketch2

Constant = 6

Introducing: 
Equations

The Equations dialog can be used to add, edit, delete and configure 

equations. 

Where to Find It � Click Equations  on the Tools toolbar.

� Or, from the Tools menu, click Equations.

� Or, right-click the Equations folder and choose an option.
� Or, from the Dimension Modify dialog, choose Add Equation.

8 Add Equation.
Double-click the Cylinder 
feature and the diameter 

dimension (25mm). In the 

dialog, choose Add Equation 

from the drop-down list.

9 Dimension added.

The dimension is added to 

the new equation on the 

left side of the equals sign.
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10 Complete equation.

Click either of the link 

value dimensions and add 

“+ 6” to complete the 

equation.

Click OK to add the 

equation.

11 List.

The current list of equations, including link values , are listed in the 

Equations dialog. Click OK and rebuild the model.

The Evaluates To column refers to the 

value of the CylinderDiameter
@Sketch1 dimension. Changes to the 

AcrossFlats@Sketch2 dimension force 

the evaluation to change. 

Tip If your equations make use of angular dimensions, select Radians or 

Degrees as the Angular Equation Units.

Note The driven dimension, 

CylinderDiameter@Sketch1 in this case, cannot 
be changed directly. Double-clicking it leads to a 

grayed out Modify dialog.
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Global Variables and 
File Properties

Global Variables (or independent variables) and File Properties can be 

added and used within equations to represent yield strength, Poisson's 

ratio or other constants. They can be used within equations. A list of 

available global variables, default properties and custom properties can 

be accessed from the  button. 

Suppression Using 
an Equation 

The iif statement can be used to suppress or unsuppress a feature based 

on a dimension value. For example, an equation to suppress the 

chamfer based on a diameter would be written like this: 

"Chamfer1"= iif ("CylinderDiameter@Sketch1"<15,  
"suppressed", "unsuppressed") 

This means:

� Suppress the Chamfer1 feature if the value of the 
CylinderDiameter@Sketch1 dimension is less than or equal to 

15mm. 

� Unsuppress the Chamfer1 feature if the value of the 
CylinderDiameter@Sketch1 dimension is greater than 15mm.
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A Few Final Words 
About Equations

Equations are solved in 

the order in which they are 

listed. If you try to add an 

equation and get this 

message: 

"The variable 
D@Sketch2 is already 
used in the earlier 
equation and is getting 
modified. Please 
reorder OR change the equations to avoid multiple rebuilds." 
It means that your equations are in the wrong order. Use the list to 

reorder them. Consider this example: Given three equations: A=B, 

C=D, and D=B/2, consider what happens if you change the value of B. 

First, the system will compute a new value for A. When it evaluates the 

second equation, nothing is changed. When the third equation is 

evaluated, the changed value of B yields a new value for D. However, it 

would not be until the second rebuild that this new value for D would 

be used to compute a new value for C. Reordering the equations thus: 

A=B, D=B/2, and C=D solves the problem. 

Configure 
Dimension/
Feature

The Configure Dimension/Feature tool is another way to create 

configurations in the part. The interface uses a table to control 

configuration names, suppression states and dimension values. 

Modify 
Configurations 
Columns 

The dialog that appears when using either Configure Dimension or 

Configure Feature is Modify Configurations. It contains three types 

of columns: configuration, dimension or feature.

Configuration 
Column 

The configuration column includes the current 

configurations and can be added by typing in the 

< Creates a new configuration. > cell. 

Dimension Columns A dimension column is created when a dimension is 

configured or double-clicked into the table. Numeric 

values are typed into the cells. 

Feature Columns A feature column is created when a feature is 

configured or double-clicked into the table. The 

suppress checkbox can be checked or cleared. 

Related dimensions can be added using the pulldown 

menu on the upper right corner. 

Configure 
Dimension

Configure a dimension using Configure Dimension. It can also be 

used to add new configurations. 
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Where to Find It � From a dimension, right-click Configure Dimension. 

Configure Feature The Configure Feature tool is used to change features (suppression 

state) by configuration in a single dialog. 

Where to Find It � From a feature, right-click Configure Feature.

12 Modify dimension. 

Double-click the 6 Point feature. Right-click the 9mm dimension and 

select Configure Dimension. 

13 Create configurations and sizes. 

Click in < Creates a new configuration. > and type M5-6. This 
refers to an M5 size that is a 6 point socket. Press Enter and type M6-6 
and then M8-6. 

This dialog shows the value of the dimension by configuration. Click in 

the cells and change the values of the dimensions as shown. 

Tip The dimension has the column title Linked Dimension because a link 

value was applied to it. 
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14 Name and save table. 

Type in the name Cut Size and click Save table view  and Apply. 

15 Adding a feature as a column. 

Double-click the feature 12 Point in the FeatureManager design tree. 

Click Suppress for the M5-6, M6-6 and M8-6 configurations. Click 
Save table view  and OK. 

16 Resulting configurations.
Switch to the ConfigurationManager and double-click each 

configuration to make it active.

M5-6 M6-6 M8-6
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17 Recall table. 

The table is stored in the ConfigurationManager 

under the Tables folder. Right-click Show Table 
to recall it. 

18 Add more configurations. 

Add the configurations M5-12, M6-12 and M8-
12 as shown. Set the values and clear the Suppress column for them. 

Click Save table view  and Apply. 

19 Dimension from a feature. 
Double-click the feature 6 Point in the FeatureManager design tree. 

Click the pulldown next to the feature name and select the dimension 

D2. 

Click Save table view , Apply and OK. 
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20 Delete and rename. 

Double-click the table Cut Size to recall it. 

Right-click in the title Suppress of the 6 Point column and select 

Delete. Right-click in D2 of the 6 Point column and select Rename 

and type Well. Change the values as shown. 

Click Save table view  and OK.

21 Configurations created.

For each size there is a 6 and 12 point versions. 

22 Save and close the part. 
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Other Uses of 
Configurations

Part configurations have numerous applications and uses. Some of the 

reasons for creating different configurations include:

� Application-specific requirements.

� Different product specifications such as a military and civilian 

version of a part.

� Performance considerations.

� Assembly considerations.

Application-specific 
Requirements

Many times the finished 

part model contains fine 

detail such as fillets and 

rounds. When preparing a 

part such as the one 

shown at the right for 

finite element analysis 

(FEA), it is desirable to simplify the part. By suppressing the 

unnecessary detail features you can create a configuration specifically 

for FEA.

Another application that might require a specialized model 

representation would be rapid prototyping.

Performance 
Considerations

Parts with complex geometry such as swept and lofted features, 

variable radius fillets, and multi-thickness shells have a tendency to tax 

system resources. You might want to consider defining a configuration 

that suppresses some of these features. This will allow you to improve 

system performance when working on other, unrelated areas of the 

model. When you do this, however, be sure to take into account parent/

child relations. You cannot access, use, or reference suppressed features 

– therefore they can’t serve as parents.
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Assembly 
Considerations

When working on complex assemblies that contain large numbers of 

parts, using simplified representations of those parts can improve 

system performance. Consider suppressing unnecessary detail such as 

fillets, leaving only critical geometry that is needed for mating, 

interference checking, and defining fit and function. When you add a 

component to an assembly, the Insert, Component, From File... 

browser enables you to choose the configuration of the part to be 

shown. To take best advantage of this, you have to plan ahead, defining 

and saving the configuration when the component is built.

Similar parts that have the same 

basic shape can be defined as 

different configurations and used 

in the same assembly. The part 

shown at the right has two 

configurations. For an example 

showing how to use two different 

configurations of a part within an 

assembly see Using Part 

Configurations in Assemblies on 

page 425.

Modeling 
Strategies for 
Configurations

When you model a part that will be used with configurations, you 

should give some thought to what you want the configurations to 

control. Consider, for example, the part used in the previous procedure.

One way a part like this can be modeled is to make a single sketch of 

the profile and build the part as a single revolved feature.

Although that approach seems efficient, having all the information 

contained in a single, monolithic feature really limits your flexibility. 

By breaking the part down into smaller, individual features, you gain 

the flexibility of being able to suppress features such as fillets or cuts.
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Editing Parts 
that Have 
Configurations

When configurations are added to a part, features may be automatically 

suppressed, dialogs list many additional options, and other strange 

things can happen. This section shows what happens when there are 

multiple configurations in the part being edited. 

Note End conditions, colors and materials can also be configured.

1 Open the part.
Open the part WorkingConfigs. This part has 
one configuration: Default. 

Configurations and new features will be added to 

the part.

2 Add configuration.

Use Add Configuration to add a configuration named keyseat and 
optionally, add a comment.

Click OK.

3 Added to list.

The new configuration is added 

to the list and automatically 

made the active configuration. 

Notice that the name of the active configuration is shown in 

parentheses, appended to the part name icon.

4 Copy and paste.

Copy and paste keyseat to create another new configuration. Name it 

ports and make it the active configuration.

By default the option 

Suppress features is 

selected. This means that as 

new features are added, they 

are suppressed in all 

configurations except the active one.

At this time, all three configurations are the same. 

Tip The name in square brackets is the name that will appear in a BOM. 

This can be changed by changing the setting for the Part number 

displayed when used in a bill of materials in the Configuration 

Properties dialog.
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Design Library The Design Library is a collection of features, parts and assembly files 

within the Task Pane. The files can be inserted into parts and 

assemblies to reuse existing data. The features folder will be used in 
this example.

Default Settings The first of three library features will be inserted using the default 

settings for location and size.

5 Folders.

Click the Design Library and the pushpin.

Expand the features folder.

Expand the inch folder.

Click the fluid power ports folder.

6 Drag and drop.

Drag and drop the sae j1926-1 (circular 
face) feature onto the planar model face as 

shown. The drop face is the Placement Plane 

for the feature. 

7 Settings and selections.

Select the configuration 516-24 from the list. 

Select the Edge1 (circular edge) reference as 
indicated in the preview window.

Click OK. 

Note The Link to library part option will create a link to update this part 

from changes in the library feature.
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Tip Checking Override dimension values allows the internal dimension 

values of the feature to be changed.

8 Feature.
The library feature is added to 

the FeatureManager design tree 

as a library feature consisting of 

sketches, a plane and a cut. 

Note The “L” labels superimposed over the feature icons indicate a library 

feature.

Multiple 
References

Many features contain multiple references to faces, edges or planes. 

These are used to attach dimensions and set relations on geometry.

If the references are not properly attached to model geometry, they will 

become dangling. For more information, see Reattach Dimensions on 

page 278.

9 References.

Drag and drop the sae j1926-1 
(rectangular face) feature onto the 
planar face. This feature requires the 

selection of two references, each being a 

linear model edge.

Select the 716-20 configuration. For 
the two References, select the edge 

shown in green followed by the edge shown in red.

10 Dimension values.

Set each Locating Dimension 

to 0.5” by clicking the cell and 

typing.

Click OK.
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11 Check configurations.

The new features are unsuppressed in the active configuration (ports) 
but suppressed in all the others.

12 Active configuration.

Make the configuration keyseat the active one.

Dropping on 
Circular Faces

Some features attach to circular faces of the target model and require 

the first “drop” face to be that face. In these cases, the Placement Plane 

is selected after the drop.

13 Feature.

Open the keyways folder in the design library. Drag and drop the 
rectangular keyseat feature onto the circular face of the shaft.

Select the ∅ 0.6875 W=0.1875 configuration and the planar end 
face as the Placement Plane. 
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14 Reference.

Select the circular edge of the end 

face as the Reference.

15 Locating dimensions.

Set the Locating 

Dimensions to the 

values shown.

Click OK.

16 Check configurations.
The new feature is unsuppressed in the active configuration (keyseat) 
but suppressed in all the others.

17 Save and close the file.
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In the Advanced 
Course...

In the advanced course Assembly Modeling, the concept of 

Configurations is carried into assemblies.

Assemblies can have configurations that are created manually, through 

configure component or design tables. While part configurations focus 

on features, assembly configurations focus on components, mates, or 

assembly features. Assembly configurations can be used to control:

� Assembly Features

� Components

� Mates and Mate Dimensions

At the assembly level there are more options available to control one or 

more component instances.
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Exercise 46:
Configurations

Use an existing part as the basis for a series 

of configurations. Create different versions 

by suppressing various features in each 

configuration.

This lab reinforces the following skills:

�  Creating Configurations on page 344.

� Adding New Configurations on 

page 344. 

� Introducing: Suppress on page 347.

Configurations Open the existing part config part. Create new configurations to 
match the conditions and names below. Add features to the model 

where required. 

Note The Section configuration is created using a cut feature. To create the 
cut feature, activate the Standard configuration. Then use the Front 
plane and the command Insert, Cut, With Surface..., to cut the model.

What is this Thing? The part used in this example is the 

main twin barrel component from a 

toy that shoots soft, foam rockets.

Best Better

Includes ammo 
holder and sight

Includes sight only

Standard Section

Includes neither 

ammo holder nor 
sight

Shows a section cut 

through the 

Standard model

ammo sight
holder
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Exercise 47:
Working with 
Configurations

Using an existing part with 

configurations, add new features 

and modify others.

This lab reinforces the following 

skills:

� Adding New Configurations 

on page 344. 

� Introducing: Suppress on 

page 347.

� Editing Parts that Have Configurations on page 365.

Procedure Open the existing part Working with Configurations. The part 
contains seven (7) existing configurations. They are all copies of the 

Default configuration. Control the features as shown below. 

Suppression State Set the suppression state of the following features. 

End Condition To set the End Condition of the center hole 
feature use Edit Feature. 

Configuration
Fillets & 

Chamfers

Stepped 
sketch (cut)

doublewall U S

doublewall.simple S S

singlewall U S

singlewall.simple S S

stepped U U

stepped.simple S U

Configuration center hole

doublewall Through All

doublewall.simple Through All

singlewall Up To Next

singlewall.simple Up To Next

stepped Up To Next

stepped.simple Up To Next
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Exercise 48:
Using Link 
Values

Create link values in an existing part and test it.

This lab reinforces the following skills:

� Link Values on page 365.

Procedure Open the existing part named Link Values. Create a link value that 
makes all the fillets feature values equal.

1 Create link value.

Create and apply a link value named 

All_fillets&rounds to the dimension of the 

Rounds feature.

2 Apply link value.

Apply the link value to the remaining three 

fillet features:

Fillets.1

Fillets.2

Fillets.3

3 Test.

Test the links by changing any one of the four 

to 0.125” and rebuilding.

4 Save and close the part.
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Exercise 49:
Using 
Equations

Create an equation using an existing 

part and test it.

This lab reinforces the following 

skills:

� Equations on page 367.

Procedure Open the existing part named Using Equations. The dimensions A, B 

and C shown above will be used to define the equation.

1 Write equation.

Write an equation that keeps the bolt 

circle diameter (A) centered between 

the outside edges of the hub (B) and 

flange (C). The (A) value should be 

driven.

2 Test equation.

Test the equation be changing 

the flange diameter to 12” and 

rebuilding the model. Test other 

values if you wish.

3 Save and close the part.

Tip If you are having trouble, the equation format should be:

A=(C-B)/2+B.

A

B

C
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Exercise 50:
Using 
Configure 
Dimension/
Feature 1

Use an existing part with configure 

dimension and configure feature to create 

new configurations. 

This lab reinforces the following skills:

� Configure Dimension on page 358.

� Configure Feature on page 359. 

Procedure Open the existing part Using Configure Feature. 

1 Configure Dimension and Feature. 

Create configurations using configure dimension and configure feature. 

Create a table view with the settings shown. 

2 Save and close the part.

Configuration 

Name

Sketch1 Holes Sketch2

EndR SideR CtoC Suppress BoltH CenterH

Size1 30mm 60mm 130mm Clear 25mm 75mm

Size2 25mm 50mm 100mm Clear 20mm 60mm

Size3 20mm 40mm 90mm Clear 15mm 50mm

Size4 15mm 30mm 80mm Clear 12mm 45mm

Size5 10mm 20mm 60mm Click 10mm 30mm

Default 30mm 60mm 120mm Clear 25mm 75mm
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Exercise 51:
Using 
Configure 
Dimension/
Feature 2

Use an existing part with configure dimension and 

configure feature to create new configurations. 

This lab reinforces the following skills:

� Configure Dimension on page 358. 

� Configure Feature on page 359. 

Procedure Open the existing part Speaker.

Configurations Suppress, unsuppress or modify dimensions of the features rounded 
tweeter, volume control and tweeter to create the following 
configurations. 

Detail of tweeter The tweeter feature size differs from the 200 to 300 series (right). 

100 Series 200 Series 300 Series

100C 100S 200C 200S 300C 300S

C = Control, S = Slave
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Lesson 11
Using Drawings

Upon successful completion of this lesson, you will be able to:

� Create several types of drawing views.

� Modify drawing views by alignment and tangent edges. 

� Add annotations to a drawing.
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More About 
Making 
Drawings

Drawings were first introduced in Lesson 3: Basic Part Modeling. In 

this section we will explore some additional detailing topics. These 

topics include: Model Views, Section Views, Detail Views and 

several Annotation types. In addition, multiple drawing sheets will be 

used to detail both the forged and machined configurations of the part. 

Stages in the 
Process

The steps in planning and executing the creation of this drawing are 

listed below.

� Views

Introductions to many commonly used drawing views including: 

section, broken, model, and projected views. 

� Annotations

Use annotations to add notes and symbols to the drawing. 
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1 Open the drawing Ratchet Body. 
Open the drawing named Ratchet 
Body. It is an A (ANSI) Portrait sheet 
with one drawing view. 

The other sheet settings are:

� Type of projection = Third angle

� Scale = 1:1

Section View The Section View tool is used to create a new drawing view that is 

defined by cutting an existing view with a section line. The new view is 

automatically aligned to the parent view.

Where to Find It � Click Section View  tool on the Drawing toolbar. 

2 Sketch section view. 

Click Section View  

and sketch the horizontal 

line as shown. 

� Flip direction = 

selected

� Import annotations = 

cleared 

� Display style = Click 

Use parent style 

� Scale = Click Use 

sheet scale 
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3 Place view. 

Click below the view to place the section view. 

View Alignment Alignment is used to keep related drawing views aligned to 

one another by limiting movement. When you drag a view, 

dashed lines appear to show any existing alignment 

conditions. Alignment can be added or removed from any 

view.

Break Alignment The automatic alignment between a source drawing view and a section, 

or projected view can be broken to move the view freely.

Where to Find It � Right-click a view and select Alignment, Break Alignment. 

4 Break alignment.

Right-click the section view and select Alignment, Break Alignment. 

The view is now free to move. 

Tip To move a view, click the edge or Alt+click anywhere in the view and 

drag. 
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5 Similar section. 

Create another section view with similar settings 

to the previous one including the options Partial 

section and Display only cut face(s) selected. 

After placing the section, break the alignment as 

in the previous step.
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Model Views The Model View creates a single view based on a predefined view 

orientation: Top, Front, Isometric and so on. The View Palette 
(Drawing Views on page 90) can also be used to create an orientation-

based view.

Where to Find It � Click Model View  on the Drawing toolbar. 

6 Model view. 

Click Model View  and 

select the Ratchet Body 

part. Click Next . Click 

*Right as the Orientation 
and Hidden Lines Removed 

 as the Display Style. 

Click Use sheet scale. 

Place the view just above the 

title block area and click OK. 

The view is wider than the 

sheet format borders. 
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Broken View Broken Views, sometimes called interrupted views, make it possible to 

display a long part at a larger scale on a smaller size drawing sheet. 

This is done by creating a gap or break in the view using a pair of break 

lines. 

Where to Find It � Click Break  on the Drawing toolbar. 

7 Broken view. 

Select the view and click Broken View. Click 

Add vertical break line and set the Gap size to 

30mm. Use the default Zig-Zag Cut. 

Click in the view to create pairs or breaks. When 

the first pair is complete, the view breaks. Create a 

second break on the handle. Click OK. 
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Tangent Edges Tangent Edges are topological edges of faces that match in tangency. 

The most commonly seen tangent edges are the edges of fillets. They 

are often made visible in pictorial views but are removed from 

orthographic views.

Where to Find It � Right-click the view and select Tangent Edge and an option.

8 Tangent edges removed. 
Right-click in the view and select Tangent Edge, Tangent Edges 

Removed. 

Aligning Views Views can be aligned by origin or center. They can also be returned to 

the default alignment. 

Where to Find It � Right-click a view and select Alignment, and an option.

9 Align views. 

Right-click in SECTION B and choose Alignment, Align Horizontal 

by Origin. Click in the broken view to complete the alignment. 

10 Complete revolved section. 

Align SECTION A using the same procedure. 
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Note If dimensions are added across the break lines, they are true and include 

the break symbol . 

Detail Views Detail Views can be created using a closed sketched shape in an 

activated source view. The contents of the detail view are determined 

by what is enclosed within the sketch. 

Where to Find It � Click Detail View  on the Drawing toolbar. 

11 Detail view. 

Click detail view and click Draft quality for 

Cosmetic Thread Display. 

Sketch a circle in the view as shown. Name the 

view HEAD and click Use sheet scale and place 
the new view as shown.
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Drawing Sheets 
and Sheet 
Formats

Drawing sheets, as mentioned earlier, represent the paper sheet. 

Contained within the drawing sheet is the sheet format that holds the 

title block and text. 

Tip The SolidWorks drawing file contains one or more drawing sheets 

which in turn can contain multiple views.

Drawing Sheets The “paper sheets” are used to hold the views, dimensions and 

annotations and create the drawing.

Where to Find It � Right-click on the drawing sheet and select Edit Sheet Format to 

access the sheet format. 

Adding Drawing 
Sheets

In this lesson, multiple drawing sheets with multiple views will be 

created.

Tip The new drawing sheet does not have to be the same size as the current 

drawing sheet. 

Where to Find It � Click the Add Sheet tab . 

Sheet Formats The border, title block and text used to add information to the drawing. 

Where to Find It � Right-click on the sheet format and select Edit Sheet to access the 

drawing sheet. 

12 Add new sheet. 

Click Add Sheet  and add a new drawing 

sheet. Right-click the new sheet tab and choose Rename. Rename the 

sheet to MACHINED. Rename the original sheet to FORGED. 
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Projected Views Projected Views are created by folding off an existing view in one of 

eight possible projections. 

Where to Find It � Click Projected View  on the Drawing toolbar. 

13 Projected view. 

Create a Model View using 

the Ratchet Body. Under 
Reference Configuration, 

select Machined, Long 
“Machined” from the list.

Click *Right orientation and 
a custom scale of 1:2. Move 

the cursor above the model 

view and click to place a 

Projected View. The 

projected view is the desired 

view. 

14 Delete view.

Click the original model view (*Right) and press the Delete key. 
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Drawing View 
Properties

The Drawing View Properties dialog provides information about the 

view and allows you to change settings like the configuration of the 

component used in the view. 

Where to Find It � Right-click the view and select Properties.

15 View properties. 

Right-click the view and 

choose Properties. Check to 

see that under Use named 

configuration, Machined, 
Long “Machined” is used 
and click OK. 

16 Detail view. 

Add a detail view 

renaming it HOLES as 
shown. 

Remove the tangent 

edges. 

17 Section of detail. 

Create a section through the centerpoint 

of an arc by “waking up” the 

centerpoint and sketching a line through 

it. 

Rename section to SECTION E. 
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18 Model view. 

Add a model view using the Forged, Long 
"Forged" configuration, *Isometric 
orientation, scale 1:4 and Shaded with 

Edges and place it in the upper right corner. 

Annotations Annotations are symbols used to enhance the drawing by providing 

additional information for manufacturing and assembly. Many types of 

annotations are available in SolidWorks. The most general type, the 

Note, is representative of the characteristics that annotations possess.

Notes Notes are used to add text and labels to drawings.

Where to Find It � Click Note  from the Annotation toolbar. 

1 Note in view. 

Double-click the model view. Click Note  and click in the model 

view. Type Configuration and press the Enter key. 

2 Link to property. 

Click Link to Property 

 and click Model in 
view to which the 

annotation is attached. 

Select SW-
Configuration Name 
from the list and click OK. 
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3 Copy and paste. 

Click in the view and click Edit, Copy. 

Click on the drawing and click Edit, Paste. 

Using the drawing view properties, change 

the configurations to those shown here. 

Datum Feature 
Symbols

Datum Feature Symbols can be added to a drawing view on a surface 

that appears as an edge (including silhouettes) to identify datum planes 

in the part. 

Where to Find It � Click Datum Feature Symbol  on the Annotation toolbar. 

4 Add datums. 

Click Datum Feature and click the line in 

SECTION E as shown. Move to the left and below 

to click and place the datum. Repeat the procedure 

for the arc in DETAIL HOLES. 
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Surface Finish 
Symbols

You can specify the surface texture of a part face by using a Surface 

Finish Symbol. 

Where to Find It � Click Surface Finish Symbol  on the Annotation toolbar. 

5 Add surface finish. 

Click Surface Finish and Machining Required. 

Click on the line in SECTION E as shown. Click 
OK and drag the symbol along the line. 

6 Dimensions. 

Use the Smart Dimension tool to 

add the dimensions as shown. 
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Dimension 
Properties

The properties of a dimension can be accessed by selecting a 

dimension. The options are divided into three tabs: Value, Leaders and 

Other. 

Where to Find It � Click a dimension. 

7 Diameters. 

Click either of the radial dimensions in DETAIL 
HOLES. Click the Leaders tab of the Dimension 

PropertyManager and click Diameter. Repeat for 

the remaining radial dimension. 

8 Tolerance. 

Click the dimension shown and set the Tolerance/

Precision values: 

� Tolerance Type = Limit

� Maximum Variation = 0.1

� Minimum Variation = 0.2

� Primary unit precision = .1
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Centerlines Centerlines are created as fonted lines and arcs in the drawing view.

Where to Find It � Click Centerline  on the Annotation toolbar. 

9 Add centerlines. 

Click Centerline  and select the two cylindrical 

faces as shown. Also add the 20mm dimension. 

Geometric 
Tolerance 
Symbols

The Geometric Tolerance Symbol is used to add geometric tolerances 

using feature control frames to parts and drawings. SolidWorks 

supports ANSI Y14.5 Geometric and True Position Tolerancing.

Where to Find It � Click Geometric Tolerance Symbol  on the Annotation toolbar.

10 Geometric tolerances. 

Click Geometric Tolerance . Click No 

Leader. Using the symbols, lists and keyboard, 

create the symbol shown below. Create a second 

symbol using the same procedure. 

Tip The Primary, Secondary and Tertiary pulldowns have a 

combination of type-in and symbol buttons. 
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11 Drag and drop.

Drag and drop the geometric tolerances onto dimensions as shown. 

They attach to the dimensions and move with them. 

Copying Views Existing views can be copied and pasted within the same sheet, onto 

different sheets within the same drawing, or between drawings. They 

can also be moved without copying. 

12 Drag and drop. 

In the FeatureManager 

Design Tree, Control+drag 

the last drawing view up and 

drop it on the FORGED 
sheet. 

The copied view is placed on 

the FORGED sheet as a new 
view. 

Tip Using drag and drop without the Control key moves the view to the 

drawing sheet. 
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13 Switch sheets. 

Move the cursor over the FORGED sheet to see a preview. Click the 
FORGED sheet to open it. 

14 Copy in sheet. 

Copy the view again and set the configurations for 

each as shown. 
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15 Add dimensions and centerlines.

Add dimensions and centerlines to the drawing as shown. 

Dimension Text The Dimension Text group box that appears 

when you select a dimension allows you to prefix, 

append or replace the text of a dimension. The 

actual text is shown as <DIM> in the field. Click 
before or after the text (or use Enter to add lines) 

to place text and/or symbols. 

Deleting the <DIM> text eliminates the text of the 

dimension for replacement. 

Tip The lower portion of the group box contains commonly used symbols 

such as diameter, degrees and centerline. 

16 Overriding dimension text. 

Click the 220mm dimension and delete the <DIM> text. This message 

appears: Overriding the dimension value text <DIM> disables 
tolerance display. Do you want to continue? Click Yes. 
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17 Text. 

Type this text and click OK. 

220mm Long

180mm Short

18 Append dimension text. 
Select all three of the radial dimensions in the 

view. Place the cursor after the dimension text 

(R<DIM>), press the Space bar and type TYP. 
Click OK. 

19 Save and close the files. 
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Exercise 52:
Details and 
Sections

Create a multiple sheet drawing of a part.

This lab reinforces the following skills:

� Section View on page 379. 

� Model Views on page 382. 

� Broken View on page 383. 

� Projected Views on page 387. 

� Copying Views on page 394. 

� Dimension Text on page 396. 

Units: millimeters

Procedure Use the part Details&Sections to create drawings shown here and on 
the following page. 

Sheet1 Create the drawing shown below using an A (ANSI) Landscape 

template. 

Note The view labelled Top View and the broken view below it are both 

oriented to the Top view. 
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Sheet2 Create the drawing shown below using an A (ANSI) Portrait template. 
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Exercise 53:
Broken Views 
and Sections

Create a multiple view drawing of a part. 

This lab reinforces the following skills:

� Section View on page 379. 

� Model Views on page 382. 

� Broken View on page 383. 

� Datum Feature Symbols on page 390. 

� Centerlines on page 393. 

� Dimension Properties on page 392. 

� Dimension Text on page 396. 

Units: millimeters

Procedure Use the part Broken&Sections to create drawings shown here and on 
the following page. 

Sheet1 Create the drawing shown below using an B (ANSI) Landscape 

template. 



Exercise 54 SolidWorks 2011
Drawings

402

Exercise 54:
Drawings

Create a multiple view drawing of a 

part with configurations. 

This lab reinforces the following skills:

� Section View on page 379. 

� Detail Views on page 385. 

� Notes on page 389. 

Units: millimeters

Procedure Use the part Design for Configs to create a B-size drawing similar to 

the one shown here. See details below. 

Views Model and section views. 
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Lesson 12
Bottom-Up Assembly

Modeling

Upon successful completion of this lesson, you will be able to:

� Create a new assembly.

� Insert components into an assembly using all available techniques.

� Add mating relationships between components.

� Utilize the assembly-specific aspects of the FeatureManager design 

tree to manipulate and manage the assembly.

� Insert sub-assemblies.

� Use part configurations in an assembly.
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Case Study: 
Universal Joint

This lesson will examine assembly modeling through the construction 

of a universal joint. The joint consists of several components and one 

sub-assembly.

Bottom-Up 
Assembly

Bottom-Up assemblies are created by adding and orienting existing 

parts in an assembly. Parts added to the assembly appear as Component 

Parts. Component parts are oriented and positioned in the assembly 

using Mates. Mates relate faces and edges of component parts to planes 

and other faces/edges.

Stages in the 
Process

Some key stages in the modeling process of this part are shown in the 

following list. Each of these topics comprises a section in the lesson.

� Creating a new assembly

New assemblies are created using the same method as new parts.

� Adding the first component

Components can be added in several ways. They can be dragged and 

dropped from an open part window or opened from a standard browser.

� Position of the first component

The initial component added to the assembly is automatically fixed as it 

is added. Others components can be positioned after they are added.

� FeatureManager design tree and symbols
The FeatureManager design tree includes many symbols, prefixes and 

suffixes that provide information about the assembly and the 

components in it.

� Mating components to each other

Mates are used to position and orient components with reference to 

each other. Mates remove degrees of freedom from the components.

� Sub-assemblies

Assemblies can be created and inserted into the current assembly. They 

are considered sub-assembly components. 
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The Assembly In this lesson we will make an assembly using existing components. 

The assembly is a universal joint, and is made up of a number of 

individual parts and one sub-assembly as shown below:

1 Open an existing part.
Open the part bracket. A new assembly will 

be created using this part.

The first component added to an assembly 

should be a part that will not move. By fixing 

the first component, others can be mated to it 

without any danger of it moving.

crank sub

Yoke_male

Bracket

pin[long]

pin[short]
(2 copies)

Spider

Yoke_female
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Creating a New 
Assembly

New assemblies can be created directly or be made from an open part 

or assembly. The new assembly contains an origin, the three standard 

planes and a Mates folder. 

Introducing: Make 
Assembly from Part/
Assembly

Use the Make Assembly from Part/Assembly option to generate a 

new assembly from an open part. The part is used as the first 

component in the new assembly and is fixed in space. 

Where to Find It � Click Make Assembly from Part/Assembly  on the 

Standard toolbar.

� Or, click File, Make Assembly from Part.

Introducing: New 
Assembly

Create a new assembly file using a template. 

Where to Find It � Click New  on the Standard toolbar.

� Or, click File, New.... 

2 Choose template.

Click File, Make Assembly from Part and select the Advanced 

button from the New SolidWorks Document dialog. Select the 

Training Template Assembly_MM.

Shortcut Double-click the desired template to automatically open a new 

assembly document using that template.

Note The units of the assembly can be different from the units of the parts. 

For example, you can assemble a mixture of inch and millimeter parts 

in an assembly whose units are feet. However, when you edit the 

dimensions of any of the parts in the context of the assembly, they will 

be displayed in the units of the assembly, not those of the part itself. 

Using Tools, Options..., you can check the units of the assembly and if 

desired, change them.
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3 Locate component.

Place the component at the 

origin by placing the cursor at 

the origin or by simply clicking 

OK.

4 Save.

Save the assembly under the 

name Universal Joint. 
Assembly files have the file 

extension *.sldasm.

Close the bracket part file.

Position of the 
First 
Component

The initial component added to the assembly is, by default, Fixed. 

Fixed components cannot be moved and are locked into place wherever 

they fall when you insert them into the assembly. By using the  

cursor during placement, the component’s origin is at the assembly 

origin position. This also means that the planes of the component match 

the planes of the assembly, and the component is fully defined.

Consider assembling a washing machine. The first component logically 

would be the frame onto which everything else is mounted. By aligning 

this component with the assembly’s planes, we would establish what 

could be called “product space”. Automotive manufacturers refer to 

this as “vehicle space”. This space creates a logical framework for 

positioning all the other components in their proper positions.

FeatureManager 
Design Tree and 
Symbols

Within the FeatureManager design tree of an assembly, the folders and 

symbols are slightly different than in a part. There are also some terms 

that are unique to the assembly. Now that a part is listed there, they will 

be described.
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Degrees of 
Freedom

There are six degrees of freedom for any 

component that is added to the assembly 

before it is mated or fixed: translation 

along the X, Y, and Z axes and rotation 

around those same axes. How a component 

is able to move in the assembly is 

determined by its degrees of freedom. The 

Fix and Insert Mate options are used to 

remove degrees of freedom.

Components Parts that are inserted into the 

assembly, such as the bracket, 
are represented by the same top-

level icon as is used in the part 

environment. Assemblies can 

also be inserted and are shown 

with a single icon. However, 

when the listing of these icons is 

expanded, the individual 

components and even the 

component’s features are listed 

and accessible. 

� State of the component

The part can be fully, over 

or under defined. A (+) or 

(-) sign in parentheses will 

precede the name if it is 

Over or Under Defined. 

Parts that are under defined 

have some degrees of freedom available. Fully defined ones have 

none. The Fixed state (f) indicates a component is fixed in its 

current position, but not mated. The question mark (?) symbol is 

for components that are Not Solved. These components cannot be 

placed using the information given.

� Instance Number
The instance number is used internally to distinguish each instance 

of the component from each other when multiple instances of the 

component are included in the assembly. 

Tip Instances are not renumbered for deletions. The highest instance 

number may not reflect the total.

� Component Part Folder
Each component part contains the entire contents of the part, 

including all features, planes and axes.
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External 
Reference Search 
Order

When any parent document is opened, all documents that are 

referenced by the parent document are also loaded into memory. In the 

case of assemblies, components are loaded in memory according to the 

suppression state they were in when the assembly was saved. 

The SolidWorks software searches for referenced documents in the 

following order:

1. Random Access Memory

If a file with the correct name is already in memory, SolidWorks 

will use that file.

2. The directory paths specified in the Folders list on the File 

Locations tab in Tools, Options (optional)

Users may establish a list of directories for SolidWorks to search 

first. Generally, these directories would be shared network locations 

where projects are stored. Establishing this list is optional and may 

be bypassed.

3. The last path you specified to open a document

When you open a parent document, SolidWorks will search in the 

same directory for the referenced files.

4. The last path the system used to open a document

This applies if the system opened a referenced document last.

5. The path where the referenced document was located when the 

parent document was last saved

This is the path stored in the parent document except that the drive 

path (C:\, D:\, etc.) is considered to be the current drive.

6. The path where the referenced document was located when the 

parent document was last saved with the original disk drive 

designation

This is the absolute path name stored with the parent document.

7. If a referenced file is still not found, SolidWorks gives you the 

option to browse for it

When SolidWorks reaches the end of the search list and has not 

found a document, it turns the process over to the user to search 

manually.

Note All updated reference paths in the parent document are saved when you 

save the parent document.

File Names File names should be unique to avoid bad references. If you have two 

different parts called bracket.sldprt, a parent document that is 

looking for the part will find whichever comes first in the search order.

Annotations The Annotations feature is used for the same purpose as in a part. 

Annotations can be added at the assembly level and imported to a 

drawing. Their display is also controlled by the Details option.
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Rollback Marker The Rollback marker can be used in an assembly to rollback:

� Assembly planes, axes, sketches
� Mates folder
� Assembly patterns
� In-context part features
� Assembly features

Any features below the marker are suppressed. Individual components 

cannot be rolled back.

Reorder Certain objects in an assembly can be reordered. They are:

� Components
� Assembly planes, axes, sketches
� Assembly patterns
� In-context part features
� Mates within the Mates folder
� Assembly features

Mate Groups The mating relationships in assemblies are 

grouped together into a Mate Folder 

named Mates. A mate group is a 

collection of mates that get solved in the order in which they are listed. 

All assemblies will have a mate group.

� Mates Folder
The folder used to hold mates that are solved together. Identified by 

a double paper clip icon .

� Mate
The relationships between faces, edges, planes, axes or sketch 

geometry that define the location and orientation of components. 

They are 3D versions of the 2D geometric relations in a sketch. 

Mates can be used to fully define a component that does not move, 

or partially define one that is intended to move. Under no 

conditions should a component be over defined. The possible states 

for a mate are Under Defined, Over Defined, Fully Defined or 

Not Solved.
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Adding 
Components

Once the first component has been inserted and fully defined, other 

parts can be added and mated to it. In this example, the Yoke_male 
part will be inserted and mated. This part should be under defined so 

that it is free to rotate.

There are several ways to add components to the assembly:

� Use the Insert dialog.
� Drag them from the Explorer.
� Drag them from an open document.
� Drag them from the Task Pane.

All these methods will be demonstrated in this lesson, beginning with 

use of Insert Component. This is the same dialog that appears 

automatically when Make Assembly from Part is used.

Insert Component The Insert Component dialog is used to find, preview and add 

components to the current assembly. Click the Keep Visible (pushpin) 

button to add multiple components or multiple instances of the same 

component.

Where to Find It � Click Existing Part/Assembly  on the Assembly toolbar.

� Or, click Insert, Component, Existing Part/Assembly....

5 Insert Yoke_male.
Click Insert, Component, Existing Part/

Assembly... and select the Yoke_male 
part using the Browse... button. Position 

the component on the screen to the left of 

the bracket and click to place it.

The new component is listed as: 

(-) Yoke_male <1>

This means that the component is the first instance of Yoke_male and 
it is under defined. It still has all six degrees of freedom.

Tip Clicking on a component in the FeatureManager design tree will cause 

that component to highlight. Also, moving the cursor to a component in 

the graphics window will display the feature name.
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Moving and 
Rotating 
Components

One or more selected components can be moved or rotated to 

reposition them for mating using the mouse or the Move and Rotate 

Component commands. Also, moving under defined components 

simulates movement of a mechanism through dynamic assembly 

motion.

Where to Find It Using the mouse:

� Drag and drop a component.

� Right-click a component, and select Move 

with Triad. The triad provides visible axes, 

webs (plane between axes) and rings. Use the 

triad to move or rotate components along axes/

webs or around rings. Float over arrowhead: 

left-drag to move along the axis. Float over 

ring: left-drag to rotate around the ring.

Using the menus:

� From the pull-down menu choose: Tools, Component, Rotate or 

Move.

� Right-click the component, and select Move....

� Or, on the Assembly toolbar pick one of these tools:

Moves a component. This can also be used to rotate components 

that have rotational degrees of freedom.

Rotates the component in one of several ways: about its 

centerpoint; about an entity such as an edge or axis; or by some angular 

value about the assembly X, Y, or Z axes.

Note Move Component and Rotate 

Component behave as a single, 

unified command. By expanding 

either the Rotate or Move options, 

you can switch between the two commands without ever closing the 

PropertyManager.

The Move tool has several options for defining the type of movement. 

The option Along Entity has a selection box, Along Assembly XYZ, 

By Delta XYZ, and To XYZ Position require coordinate values.

The Rotate tool also has options to define how the component will 

rotate.
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6 Move.

Click on the component and drag it to move it 

closer to where it will be mated.

Other options for moving and rotating the 

component will be discussed later in this 

lesson. 

Mating 
Components

Obviously dragging a component is not sufficiently precise for building 

an assembly. Use faces and edges to mate components to each other. 

The parts inside the bracket are intended to move, so make sure that 

the proper degree of freedom is left available.

Note The Standard Mates are discussed in this lesson. The Advanced 

Mates (Symmetric, Cam, Gear and Distance/Angle Limit Mates) are 

discussed in the Assembly Modeling manual.

Introducing: 
Insert Mate

Insert Mate creates relationships between component parts or between 

a part and the assembly. Two of the most commonly used mates are 

Coincident and Concentric.

Mates can be created using many different objects. You can use:

� Faces

� Planes

� Edges

� Vertices

� Sketch lines and points

� Axes and origins

Most mates are made between a pair of objects.

Where to Find It � On the Insert menu, select Mate....

� Or, on the Assembly toolbar, click Mate .

� Or, right-click a component and choose Mate.

Note Mates have icons that are based on their type, for example 

Coincident .
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Mate Types and 
Alignment

Mates are used to create relationships between components. Faces are 

the most commonly used geometry in mates. The type of mate, in 

combination with the conditions Anti-aligned or Aligned, determines 

the result.

Anti-Aligned Aligned

Coincident 
(faces lie on the same 

imaginary infinite plane)

Parallel 

Perpendicular 

Aligned and anti-aligned do 

not apply to Perpendicular.

Distance 

Angle 
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Fewer options are available with cylindrical faces but they are every bit 

as important.

Common Buttons There are three buttons common to all the controls:

�  is Undo

�  is Flip Mate Alignment

�  is OK or Add/Finish Mate

In addition to these, the Mate dialog itself also has specific mate 

alignment controls,  and .

Tip After the mate has been created, you can right-click and select Flip 

Mate Alignment to reverse the alignment.

Anti-Aligned Aligned

Concentric 

Tangent 

Lock 

Select anywhere on component.

Components that are locked 

will move together. No 

alignment options.
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Things to which you 
can mate

There are many types of topology and geometry that can be used in 

mating. The selections can create many mate types.

Topology/

Geometry
Selections Mate

Faces or 
Surface

Line or Linear 
Edge

Plane

Axis or 
Temporary 
Axis

Point, Vertex, 
Origin or 
Coordinate 
System

Arc or Circular 
Edge
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Tip Although planes can be selected on the screen if they are visible, it is 

often easier to select them by name through the FeatureManager design 

tree. Click the “+” symbol to see the tree and expand individual 

components and features. 

Mating Concentric 
and Coincident

The Yoke_male component is to be mated so that its shaft aligns with 

the hole and the flat face contacts the bracket inner face. Concentric 
and Coincident mates will be used.

Selection Filter The selection filter option is very useful in mating. Since many mates 

require face selections, the filter can be set to allow selection of only 

faces. Filters remain in effect until SolidWorks or the part is exited, or 

the filter is changed or cleared.

Where to Find It � Click Toggle Selection Filter Toolbar  on the Standard toolbar 

and select one or more filter types.

� Press the F5 key.

7 Selection filter.

Toggle the Selection Filter Toolbar on and set the Select option to 

faces . 

8 Mate PropertyManager.

Click on the Insert Mate tool  to access the 

PropertyManager. If the PropertyManager is open, 

you can select the faces without using the Ctrl key.
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Mate Options Several mate options are available for all mates:

� Add to new folder
Creates a new folder to hold all the mates created 
while the Mate tool is active. The folder resides in 
the Mates folder and can be renamed.

� Show pop-up toolbar

Toggles the Mate pop-up toolbar on and off.

� Show preview
Shows the positioning created by the mate as soon as the second 
selection is made. It is not finalized until the dialog OK is clicked.

� Use for positioning only

This option can be used to position geometry without constraining it. 
No mate is added.

Introducing: Mate 
Pop-up Toolbar

The Mate pop-up toolbar is used to make 
selections easier by displaying the available 
mate types on the screen. The mate types that are available vary by 
geometry selection and mirror those that appear in the 
PropertyManager. The dialog appears on the graphics but can be 
dragged anywhere.

Either the on-screen or PropertyManager dialog can be used. This 
lesson uses the on-screen dialog. All types are listed in the chart Mate 
Types and Alignment on page 414.

9 Selections and preview.

Select the faces of the Yoke_male 
and the bracket as indicated.

As the second face is selected, the 

Mate pop-up toolbar is displayed.

Concentric is selected as the default 

and the mate is previewed.

10 Add a mate.

The faces are listed in the Mate Settings list. Exactly two items should 

appear in the list.

Accept the Concentric mate and click Add/Finish Mate (check mark).

11 Planar face.

Select the top planar face of the Yoke_male 
component.
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12 Select Other.

Use Select Other to select the 

hidden face of the bracket on the 
underside of the top flange. Add a 

Coincident mate to bring the 

selected faces into contact.

13 Mates listed.

The mates, concentric and coincident, 

remain listed in the Mates group box. 

They will be added to the Mates folder 
when the OK button on the 

PropertyManager dialog is clicked. They can also be removed from this 

group box so that they are not added. Click OK.

14 State of constraint.

The Yoke_male component is listed as under 

constrained. It is still able to move by rotating around 

the axis of its cylindrical surface. 

Test the behavior of the Yoke_male by dragging it.

15 Add the spider.
Use Insert Component to add the spider 
component.

16 Concentric mate for spider.
Add a mate between the spider and the 
Yoke_male.

Add a Concentric mate between the two cylindrical 

faces.

Turn off the face Selection Filter.
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Width Mate The Width mate is one of the Advanced Mates from the Mate dialog. 

Selections include a pair of Width selections and a pair of Tab 

selections. The Tab faces are centered between the Width faces to 

locate the component. The spider component should be centered 

within the Yoke_male and Yoke_female components. 

Note The remaining advanced mates are discussed in the Assembly Modeling 

manual.

Width References The Width selections form the “outer” faces, used to contain the other 

component.

Tab References The Tab selection(s) form the “inner” faces, used to locate the 

component.

Width selections Tab selection(s) Result

(Front view)

(single selection)

(Front view)

(Front view)
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17 Width mate.

Click Insert, Mate and 

select the Advanced Mates 

tab. 

Click the Width  mate and 

select the Width selections 

and Tab selections as 

shown. 

18 Results.

The mate keeps the spider centered inside the 
Yoke_male with equal gaps on each side.
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19 Mates by component.

Expand the spider component in the FeatureManager design tree. A 

folder named Mates in Universal Joint is added to each component 

that is mated. The folder contains the mates which use geometry of that 

component. 

The folder is a subset of the Mates folder which contains all mates.

Note The icon  indicates that the mate is in the path to ground, or, it is one 

of the mates that keeps the component in position. 
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Adding Components 
Using Windows 
Explorer

Another way to add components to the assembly is through Windows 

Explorer or My Computer. The part or assembly file(s) can be dragged 

and dropped into the active assembly.

20 Open Windows Explorer.

Size the Windows Explorer window so the SolidWorks graphic area 

can be seen. Since SolidWorks is a native Windows application, it 

supports standard Windows techniques like “drag and drop”. The part 

files can be dragged from the Explorer window into the assembly to 

add them. Drag and drop the Yoke_female into the graphics area. 

21 Rotate using Triad.

Right-click the Yoke_Female and select 
Move with Triad. Drag the ring as shown.

22 Concentric mate.

Select the cylindrical faces as shown and add a 

Concentric mate between them.
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23 Second width mate.

Add a Width mate between the spider and the 
Yoke_female.

The spider is centered on the Yoke_female 
component.

24 Potential over defined condition.

Select the faces of the Yoke_female and bracket 
as shown. Because of the clearance between the 

Yoke_female and the bracket, a Coincident 
mate is unsolvable. The gap prevents coincidence.

The Coincident mate is selected as default and a 

warning dialog appears:

The default mate type (coincident) would over-define the 
assembly. Please select the mate type below.

Parallel Mate A Parallel mate keeps the selected planar faces or planes parallel to 

each other without forcing contact between them.

25 Set to Parallel.
Select the Parallel mate to 

maintain the gap between the 

faces. Press g to use the 

magnifying glass and view the 

gap.
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Dynamic 
Assembly Motion

Drag under defined components to display the motion allowed by the 

remaining degrees of freedom. 

Note Components that are fixed or fully defined cannot be dragged.

26 Drag components.

Drag the Yoke_male component to turn it. The 

mated components spider and Yoke_female 
move with it.

Displaying Part 
Configurations in 
an Assembly

When you add a part to an assembly you can choose which of its 

configurations will be displayed.

Or, once the part is inserted and mated, you can switch its 

configuration.

The Pin The part named pin has two configurations: 
SHORT and LONG. Any configuration can be 
used in the assembly. In this case, two 

instances will use SHORT and one will use 
LONG.

Using Part 
Configurations 
in Assemblies

Multiple instances of the same part can be used in an assembly, with 

each instance referencing a different configuration. We will use 

multiple instances of a part with different configurations in this 

assembly.

There are several ways to create this type of configuration within a 

part:

� Applying different dimension 

values to individual 

configurations as shown at the 

right.

� Use Modify Configurations.

� Design tables.

Drag and Drop from 
an Open Document

The pin will be inserted by dragging it in from an open document 

window into the assembly.

Note If the bracket window is still open, close it before the next step.

LONG

SHORT
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27 Drag and drop.

Open the part pin and tile the windows of the assembly and part. Drag 

and drop the pin into the assembly window by dragging the top-level 

component ( ) from the FeatureManager design tree. An 

instance of the pin is added to the assembly.

Important! The pin is a component that 

contains multiple 

configurations. 

Components like this 

display the configuration 

and display state they are 

using as part of the 

component name. In this 

case the configuration used 

by instance <1> is LONG. 
The display state is Display 
State 1 within the 
configuration <LONG>. 
Each instance can use a 

different configuration/display state combination.

Note Display States are primarily used in assemblies, but can be used in 

multi-body parts. For more information on display states, see the 

Assembly Modeling training manual. 
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28 Concentric mate.

Add a Concentric mate between the cylindrical 

face in the Yoke_female and pin.

The pin can be dragged while using the mate 

dialog. Drag it through as shown.

29 Tangent mate.
Add a Tangent mate between the planar 

end face of the pin and the cylindrical 
face in the Yoke_female.

The Second Pin Another instance of the pin is needed. This one will be the shorter 
version, SHORT. We will open the pin, tile the windows of the part and 
assembly, and show the part’s ConfigurationManager.

Opening a 
Component

When you need to access a component while working in an assembly, 

you can open it directly, without having to use the File, Open menu. 

The component can be either a part or a sub-assembly.

30 Cascade the windows.

Click Window, Cascade to see both the part and assembly windows.

Switch to the ConfigurationManager of the pin.
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31 Drag and drop a configuration.

Drag and drop the configuration SHORT into the graphics window of 
the assembly. You can drag and drop any configuration from the 

ConfigurationManager, not just the active one.

Other Methods of 
Selecting 
Configurations

To get the same result using Insert Component, browse for the part 

and associated configuration.

When using Explorer, parts that contain 

configurations trigger a message box 

when dragged and dropped. Select the 

desired configuration from the list.

32 Second instance.

The second instance of the pin 
component is added, this time using the 

SHORT configuration. The component is 

added and it displays the proper 

configuration name in the FeatureManager design tree.
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33 Mate the component.

Add Concentric and Tangent mates to mate the 

second instance of the pin.

Recent Documents SolidWorks maintains a list of recently opened documents that can be 

used to access documents quickly. Type the shortcut key R and click 

the document to open. 

Where to Find It � Type the shortcut R. 

Tip The full pathname of the selected document is listed at the top of the 

screen similar to Ctrl+Tab. 

34 Switch documents. 

Switch to the pin.sldprt document, close it and maximize the 

assembly window.
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Creating Copies of 
Instances

Many times parts and sub-assemblies are used more than once in an 

assembly. To create multiple instances, or copies of the components, 

copy and paste existing ones into the assembly.

35 Drag a copy.

Create another copy of the pin component 

by holding the Ctrl key while dragging the 

instance with the SHORT configuration 
from the FeatureManager design tree of 

the assembly and dropping it in the 

graphics area. The result is another instance that uses the SHORT 
configuration, since it was copied from a component with that 

configuration.

Tip You can also drag a copy by selecting the component in the graphics 

area.

Component Hiding 
and Transparency

Hiding a component temporarily removes the component’s graphics 

but leaves the component active within the assembly. A hidden 

component still resides in memory, still has its mates solved, and is still 

considered in operations like mass property calculations.

Another option is to change the transparency of the component. 

Selections can be made through the component to others behind it.

Introducing:
Hide Component
Show Component

Hide Component turns off the display of a 

component, making it easier to see other parts of the 

assembly. When a component is hidden, its icon in the 

FeatureManager design tree appears in outline form 

like this: .

Show Component turns the display back on.

Where to Find It � Click Hide/Show Components  on the Assembly toolbar. This 

acts as a toggle. If the component if visible, it will hide it. If the 

component is hidden, it will show it.

� Right-click the component and select Hide components or Show 

components.

� Right-click the component and select Component Properties.... 

Select the Hide Component check box.

� From the pull-down menu, choose Edit, Hide or Edit, Show.
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Introducing: Change 
Transparency

Change Transparency makes the component 

transparency 75% and switches it back to 0%. 

Selections pass through the transparent 

component unless the Shift key is pressed 

during selection. The FeatureManager design 

tree icon does not change when a component is 

transparent.

Where to Find It � Click Change Transparency  on the Assembly toolbar. This 

acts as a toggle.

� Right-click the component and select Change Transparency.

36 Hide the bracket.
Change the view orientation from the default 

Isometric by pressing Shift+Left Arrow once. Click 
on the bracket component and hide it using the Hide/

Show Component  tool. 

Important! Use Hide Component not Hide Solid Body. Hide Solid Body will 

hide the solid within the part.

37 Complete the mating.
Complete the mating of this component by adding 

Concentric and Tangent mates using Insert Mate.

38 Show the component.

Select the bracket again and click Hide/Show 

Component to toggle the graphics back on.

39 Return to previous view.

Previous view states can be recalled using the 

Previous View  button on the View toolbar. 

Each time you press the button, the view 

display backs up through the display list, 

whether the view state was saved or not. Click 

once to return to the previous Isometric view.
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Component 
Properties

The Component Properties dialog controls several aspects of a 

component instance.

� Model Document Path

Displays the part file that the instance uses. To replace the file instance 

references with a different file, use File, Replace....

� Display State specific properties
Hides or shows the component. Also enables you to select a display 

state by name. 

� Suppression state

Suppress, resolve or set the component to lightweight status.

� Solve as

Makes the sub-assembly rigid or flexible. This allows dynamic 

assembly motion to solve motion at the sub-assembly level.

� Referenced configuration

Determines which configuration of the component is being used.

Where to Find It � Click or right-click a component and select Component 

Properties . 
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40 Component properties.

Click the pin<3> component and select Component Properties . 

The Referenced configuration option is set to SHORT. This dialog 
box can be used to change the configuration, suppress, or hide an 

instance. Click Cancel.

Sub-assemblies Existing assemblies can also be inserted into the current assembly by 

dragging. When an assembly file is added to an existing assembly, we 

refer to it as a sub-assembly. However, to the SolidWorks software, it is 

still an assembly (*.sldasm) file.

The sub-assembly and all its component parts are added to the 

FeatureManager design tree. The sub-assembly must be mated to the 

assembly by one of its component parts or its planes. The sub-assembly 

is treated as a single piece component, regardless of how many 

components are within it.

A new assembly will be created for the components of the crank. It will 

be used as a sub-assembly.

41 New assembly.

Create a new assembly using the Assembly_MM template. 

Click Keep Visible  on the Begin Assembly 

PropertyManager and add the crank-shaft component. 

Locate it at the origin of the assembly. It is Fixed.

42 Add components.

Using the same dialog, add the 

crank-arm and crank-knob 
components.

Close the dialog.
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Smart Mates Mates can be added between components while dragging and dropping 

them. This method, called Smart Mates, uses the Alt key in 

conjunction with standard drag and drop techniques.

These mates use the same Mate pop-up toolbar as the Mate tool uses to 

set the type and other attributes. All mate types can be created with this 

method.

Certain techniques generate multiple mates and do not use the toolbar. 

These require the use of the Tab key to switch mate alignment.

43 Smart Mate concentric.

Follow these steps to add a Concentric mate through the Smart Mate 

technique:

1. Press and hold the Alt key.

2. Click and hold the circular face of the 

crank-arm.

3. Move the component over the circular 

face of the crank-shaft.
4. Drop the component when the  

tooltip appears, indicating a concentric 

mate.

5. Confirm the Concentric type from the 

Mate pop-up toolbar.

A Concentric mate is added between the crank-arm and the crank-
shaft components.

44 Smart Mate parallel.

Spin the crank-arm around so the flat is 

selectable using dragging. Select the flat and 

Alt-+drag it to the flat on the crank-shaft. 
Drop the component when the  symbol 

appears, indicating a Coincident mate 

between planar faces.

Use the Mate pop-up toolbar to switch to a 

Parallel mate.
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45 Coincident.

Select the edge of the crank-arm and Alt-

+drag it to the flat on the crank-shaft. Drop 
the component when the  symbol appears, 

indicating a Coincident mate between and 

edge and a planar face. Use the Mate pop-up 

toolbar to confirm the Coincident mate.

46 “Peg-in-hole”.

The “Peg-in-hole” option is a 

special case of the Smart Mate that 

creates two mates from one drag 

and drop. This operation is easier if 

the crank-knob has been rotated.

Select the circular edge on the 

crank-knob. Press Alt and drag it 
to the circular edge on the top of the 

crank-arm. 

Release the Alt key when the  

symbol appears, indicating that both 

Coincident and Concentric mates 

will be added.

Press the Tab key, if necessary, to 

reverse the alignment. Drop the component.

47 Save.
Save the assembly, naming it crank sub. Leave the assembly open.

Inserting Sub-
assemblies

Sub-assemblies are existing assemblies that are added to the active 

assembly. All of the components and mates act as a single component.

48 Select the sub-assembly.

Switch to the main assembly. Using Insert Component, the dialog is 

set to list any open parts or assemblies under Open documents. The 

crank sub is listed and selected.
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49 Place the sub-assembly.

Place the sub-assembly near the top of the Yoke_male component. 

Expanding the sub-assembly component icon shows all the component 

parts within it, including its own mate group.

Mating Sub-
assemblies

Sub-assemblies follow the same rules for mating as parts. They are 

considered components and can be mated using the Mate tool, 

Alt+drag mating or a combination of both.

50 Smart Mate concentric.

Add a Concentric mate, using Alt+drag, 

between the cylindrical surfaces of the post on 

the top of the Yoke_male and the crank-shaft.

51 Parallel mate.

Mate the flat on the Yoke_male with the flat in the 
D-hole in the crank-shaft using the Mate tool and 
a Parallel mate.
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52 Alignment.

Click the Flip Mate Alignment 

button to test Anti-Aligned 

(above) and Aligned (right). Use 

the anti-aligned condition for this 

mate.

Question: Why wouldn’t you use a Coincident mate here?

Distance Mates Distance mates allow for gaps between mating components. You can 

think of it as a parallel mate with an offset distance. There is generally 

more than one solution so the options Flip Mate Alignment and Flip 

Dimension are used to determine how the distance is measured and 

which side it is on.

53 Select the faces.

Select the top face of the bracket and 
the bottom face of the crank-shaft 
component to create the mate.

Answer: Because unless the dimensions of the

flats and the diameters of the shaft and corre-

sponding hole are exactly right, a coincident mate

would over define the assembly.
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54 Add a Distance mate.

Specify a distance in units that are different 

than the current units. Type 1/32”.

Note You could type in or “ after the number. The system will automatically 

convert it to the current units, millimeters.

If the crank-shaft penetrates into the bracket select the Flip 

Dimension  button.

Click OK to create the mate.

Tip Double-clicking a Distance or Angle mate 

in the FeatureManager displays it on the 

screen. The value displays in the units of the 

assembly, in this case millimeters.

55 Select in the FeatureManager design tree.
Select the sub-assembly crank sub in the 
FeatureManager design tree. All components in the sub-

assembly will be selected and highlighted.

Tip From the graphic window, right-click a component of the sub-assembly 

and click Select Sub-assembly.

56 Dynamic Assembly Motion.
Use Change Transparency on the yokes. Drag the 

crank-arm to see the motion of the spider. 

Use For Positioning 
Only

The mate option Use for positioning only can be used to position 

geometry without adding the restriction of a mate. This is a useful 

method for setting up a drawing view.
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57 Mate.

Click the Mate tool and select Use for 

positioning only. Select the planar faces 

shown and a Parallel mate. Click OK.

The geometry is positioned like a 

parallel mate condition but no mate is 

added. Save the assembly.

Pack and Go Pack and Go is used to collect and copy all the files used by the 

assembly into a single folder or zip file. It is especially useful when the 

entire assembly must be sent to another user and the files are stored in 

many different folders. 

Note Drawings and Simulation results can also be collected and copied.

Where to Find It � From the pull-down menu, choose File, Pack and Go.

58 Pack and Go.

Click File, Pack and Go and select Save To Zip File using the default 

name and Flatten to single folder.

Click Save.

59 Save and close the part.
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60 Zip file.

Double-click the zip file Universal Joint.zip in the lesson folder.
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Exercise 55:
Mates

Create this assembly by adding 

components to a new assembly and using 

Insert Mate.

This lab uses the following skills:

� Creating a New Assembly on page 406.

� Adding Components on page 411.

� Mating Components on page 413.

Units: millimeters

Procedure Create a new assembly.

1 Add the component Base.
Create a new assembly. 

Drag the RectBase from the Mates folder 
into the assembly and fully constrain it to the 

assembly origin.

2 Add the EndConnect.
Add an instance of the EndConnect to the 
assembly. Mate it to the RectBase using a 
distance of 10mm and two coincident mates as 

shown. 

3 Add the Brace. 
Add an instance of the Brace to the assembly. 

Mate it to the RectBase using coincident 
mates as shown. 

The Brace is centered on the hole in the 
EndConnect component. 

 

Tip Coincident mates between planes can be used to center components. 
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4 Additional components. 

Add more instances of the Brace and EndConnect components, 

placing them as shown. 

5 Save and close all files.
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Exercise 56:
Gripe Grinder

Assemble this device by 

following the steps as 

shown.

This lab uses the following 

skills:

� Creating a New 

Assembly on page 406.

� Adding Components on 

page 411.

� Mating Components on 

page 413.

� Dynamic Assembly Motion on page 425.

Units: millimeters

Procedure Create a new assembly.

1 Add the component Base.
Create a new assembly. 

Drag the Base from the Grinder Assy 
folder into the assembly and fully 

constrain it to the assembly origin.

2 Add the Slider.
Add the Slider to the assembly. Mate it 

to one of the dovetail slots. A width and 

coincident mate are required.

3 Add a second copy of the Slider.
Mate it to the other dovetail slot. Both 

Sliders should be free to move back and 

forth in their respective slots.
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4 Crank assembly.

Open a new assembly using the 

Assembly_MM template. Build the 

Crank assembly as shown at the right. 

The Crank is shown in both exploded 
and collapsed states.

The Crank assembly consists of:

� Handle (1)
� Knob (1)
� Truss Head Screw (1)

[#8-32 (.5” long)] configuration

� RH Machine Screw (2)

[#4-40 (.625” long)] configuration

Note Both machine screws contain multiple 

configurations. Be sure you use the 

correct ones.

5 Insert the Crank assembly into the 

main assembly.

Tile the two assembly windows, and 

drag and drop the sub-assembly into the 

main assembly.

6 Mate the Crank assembly to the 
Sliders.
The two RH Machine Screws go 
into the holes in the Sliders. The 
underside of the Handle mates to the 

top face of one of the Sliders.

7 Turn the Crank.
The movement of the Knob follows 
an elliptical path. The movement of each Slider traces the major and 

minor axes of that ellipse.

8 Save and close the assembly and the part.
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Exercise 57:
Using Hide and 
Show 
Component

Create this assembly by using mates only. 

No dimensions are provided.

This lab uses the following skills:

� Creating a New Assembly on 

page 406.

� Adding Components on page 411.

� Mating Components on page 413.

� Component Hiding and Transparency 

on page 430.

� Smart Mates on page 434.

Units: millimeters

Procedure Create a new assembly.

1 Create assembly.

Open the Housing component found in the Gearbox Assy folder. Use 
Make Assembly from Part/Assembly to create a new assembly with 

the Assembly_MM template.

2 Add the components.

Drag or insert the remaining component parts into the assembly.

3 Mates.

Mate the Cover Plate and both 
Cover_Pl&Lug components to the 

Housing as shown. 

4 Hide. 
Hide the Cover Plate and one of the 
Cover_Pl&Lug components as shown. 

5 Add more components. 

Add the Worm Gear Shaft and Worm 

Gear components as shown. 
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Tip Mate the Worm Gear to the 
Housing using a Width mate. 

6 Detail.

Show the hidden components. Use Change Transparency to change 

the appearance of the Housing. 

Add the Offset Shaft component and mate it. 

Tip

A detail for mating the Offset 
Shaft to the Housing is 
shown at right. 

7 Save and close all files.
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Exercise 58:
Part 
Configurations 
in an Assembly

Using the parts included, complete this 

bottom up assembly. Use several con-

figurations of the same part in the 

assembly to create a set of allen 

wrenches. 

This lab reinforces the following skills:

� Adding Components on page 411.

� Mating Components on page 413.

� Using Part Configurations in Assemblies on page 425.

� Dynamic Assembly Motion on page 425.

� Opening a Component on page 427.

Procedure Open an existing assembly.

1 Existing assembly.

Open the assembly part 
configs found in the 
part configs folder. The 
assembly contains three 

components, two of 

which have multiple 

instances. One 

component, the Allen 
Wrench, uses a different 
configuration for each 

instance.

2 Open part.
Select any instance of the 

Allen Wrench component and 

open the part.
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3 Configuration. 

Edit the table LENGTH under the Tables folder. Change the values in 
the Length column.

4 Add and mate components.

Add and mate three more components, 

noting the configurations of the Allen 
Wrench parts. The sizes, positions and part 
names are detailed in the accompanying 

illustrations.

Hint With the part and the assembly both open, 

tile the windows. Switch to the 

ConfigurationManager in the part and drag 

in only the configurations that you need.

5 Save and close the assembly and the 
part.

Length

Size01 50

Size02 60

Size03 70

Size04 80

Size05 90

Size06 100

Size07 100

Size08 90

Size09 80

Size10 100
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Exercise 59:
U-Joint 
Changes

Make changes to the assembly created in the 

previous lesson.

This exercise uses the following skills:

� Insert Component on page 411.

� Mating Components on page 413.

� Opening a Component on page 427.

� Component Hiding and Transparency on 

page 430.

Procedure Open an existing assembly.

1 Open the assembly named Changes.
Open the assembly Changes found in 
the U-Joint Changes folder.

2 Open the bracket component.

From the FeatureManager design tree or 

the screen, open the component 

bracket<1> for editing.

3 Changes.

Double-click the first feature and 

change the dimensions that are shown 

as bold and underlined.

Rebuild the part.

4 Close and save.

Close the bracket part, saving the 
changes that you have made. Respond 

Yes to rebuilding the assembly.

5 Changes.
The changes made in the part also appear in the 

assembly.

6 Turn the crank.

The crank should turn freely, turning the two yokes, 

the spider, and the pins with it.

7 Delete mate.

Expand the mate group and delete the mate 

Parallel2.

bracket
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8 Turn the crank.

The crank should turn freely but it is no 

longer connected to the yokes and spider.

9 Insert a set screw.

Insert the existing component named 

set screw. Mate it to the small hole in the 

crank-shaft with a Concentric mate.

10 Hide component.

Hide the crank-shaft component. Add a 

Coincident mate between the flat faces of the 

set screw and the Yoke_Male.

11 Show component.

Show the crank-shaft component.

12 Turn the crank.

The crank should turn freely and once again, 

the two yokes, the spider and the pins should 
rotate with it.

13 Save and close the assembly.
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Lesson 13
Using Assemblies

Upon successful completion of this lesson, you will be able to:

� Perform mass properties calculations.

� Create an exploded view of an assembly.

� Add explode lines.

� Generate a bill of materials for an assembly.

� Copy a bill of materials to a drawing.
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Using 
Assemblies

This lesson will examine other aspects of assembly modeling using a 

version of the universal joint and other assemblies. The completed 

assembly will be analyzed, edited and shown in an exploded state.

Stages in the 
Process

Some key stages in the analysis process of this assembly are shown in 

the following list. Each of these topics comprises a section in the 

lesson.

� Analyzing the assembly

You can perform mass properties calculations on entire assemblies.

� Editing the assembly

Individual parts can be edited while in the assembly. This means you 

can make changes to the values of a part’s dimensions while active in 

the assembly.

� Exploded assemblies

Exploded views of the assembly can be created by selecting the 

components and the direction/distance of movement.

� Bill of Materials

A BOM table can be generated in the assembly and copied into the 

drawing sheet. Associated balloons can be added to identify the items.
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Analyzing the 
Assembly

There are several types of analysis you can perform on an assembly. 

These include calculating the mass properties of the assembly and 

checking for interferences.

Mass Properties 
Calculations

Mass properties calculations were introduced earlier in this course. 

When working with assemblies, the important thing to remember is that 

the material properties of each component are controlled individually 

via the Material feature in the part. The material properties can also be 

set through Edit Material.

1 Open existing assembly.

Open the existing assembly UJ_for_INT.

2 Mass properties.

Click Mass Properties  on the Tools toolbar.

3 Results.
The system performs the calculations and displays the results in a 

report window. The system also displays the Principal Axes as 

temporary graphics. Options can be used to change the units of the 

calculations. 

Click Close.

The symbols represent:

Output coordinate 
system

Principle Axes at 

the Center of Mass
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Checking for 
Interference

Finding interferences between static components in the assembly is the 

job of Interference Detection. This option takes a list of components 

and finds interferences between them. The interferences are listed by 

paired components including a graphic representation of the 

interference. Individual interferences can be ignored.

Introducing: 
Interference 
Detection

Interference Detection can be directed to check all components in the 

assembly, or just selected ones.

Where to Find It � Click Interference Detection  on the Assembly toolbar.

� From the Tools menu choose: Interference Detection....

4 Click Tools, Interference Detection....

The Interference Detection PropertyManager opens.

5 Interference detection.

Select the top level component UJ_for_INT to 
check all the components in the assembly. The 

assembly UJ_for_INT.SLDASM appears in the 

Selected Components list.

Click Calculate.

6 Interferences.

The analysis has found three interferences among 

the selected entities. The listings Interference1, 
Interference2 and Interference3 are shown in 
the Results listing followed by a volume of 

interference. The interference is marked in the 

graphics window using a volume displayed in red. 

By default, the interfering components are 

transparent and the other components remain 

opaque. Click OK. 

Interference1 Interference2 Interference3

bracket Yoke_male Yoke_male

crank-shaft crank-shaft crank-shaft
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Interference Options The Options group box selections are used to 

refine the detection criteria.

� Treat coincidence as interference includes 

all coincident faces as interferences.

� Selected interferences can be flagged to be 

ignored by the calculations using the Ignore 

button . They can be shown later using 

Show ignored interferences. 

� Clicking Treat sub-assemblies as 

components ignores any interferences within 

the sub-assembly itself and uses it as a single 

component. 

� Include multibody part interferences looks 

at body to body interferences within part components. 

� Using Make interfering parts transparent shows the interference 

volumes in a transparent state.

� Create fasteners folder generates a 

Fasteners folder to hold all the 
interferences that involve a fastener.

The Non-interfering Components group 

box is used to determine how the components 

that do not interfere are displayed.

7 Visual methods.

Areas of interference can sometimes be 

determined visually. Shaded (without edges) 

and Hidden Lines Visible displays can be 

used.

In this case, the crank-shaft volume 

overlaps that of the bracket.

8 Flip dimension. 

Right-click the Distance1 mate and 

choose Flip Dimension.

You can also right-click the mate and 

choose Edit Feature to edit options in 

the PropertyManager including Flip 

Dimension. 
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9 Recheck the interferences.

Select the bracket, crank-shaft and Yoke_male components and 

click Interference Detection. As expected, No Interference is the 
result.

Checking for 
Clearances

The actual clearance between 

components, like 

interferences, may be 

difficult to determine 

visually. Clearances between 

both parallel and concentric 

components can be checked. 

Introducing: 
Clearance 
Verification

Clearance Verification is used to determine the static clearance 

between component parts in an assembly. It can be directed to check 

the clearance between selected components in the assembly, or all 

components against each other. 

Where to Find It � Click Clearance Verification  on the Assembly toolbar.

� From the Tools menu choose: Clearance Verification....

10 Clearance verification. 

Click Clearance Verification  and select 

components Yoke_female and bracket. Set the 
Minimum Acceptable Clearance value to 10mm 

(larger than expected). Click Calculate and the 

clearance will appear as Clearance1 in the 
Results. Click OK. 
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Static vs. Dynamic 
Interference 
Detection

The problem with a static method of interference detection is that the 

components of an assembly may only interfere under certain 

conditions. What is needed is a way to detect collisions dynamically, 

while an assembly is moving.

Introducing: 
Collision Detection

Collision Detection analyzes selected components in the assembly 

during dynamic assembly motion, alerting you when faces clash or 

collide. You have the options of stopping the motion upon collision, 

highlighting the colliding faces, and generating a system sound.

Where to Find It � On the Move Component  or Rotate Component  

PropertyManagers, select Collision Detection.

11 Collision Detection.

Click Move Component  

and select Collision Detection.

Select All components and 

Stop at collision.

Turn the U-joint by dragging 

the crank handle. When the 

inner edges of the two yokes 
collide, the system alerts you by 

highlighting the faces and 

generating a system sound.

12 Narrow the selection.

The option All components means collisions with 

all assembly components are detected. This puts 

more demands on system resources, especially in a 

large assembly. If you choose These 

components, only collisions with a group of 

assembly components that you select are detected.

Click These components and select the 

Yoke_female and Yoke_male components.

Click Stop at collision and then Resume Drag.

13 Turn off Collision Detection.

Click OK to close the PropertyManager.
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Performance 
Considerations

The are a number of options and techniques you can use to improve 

system performance during Dynamic Collision Detection:

� Click These components, instead of All components. In general, 

performance can be improved if you minimize the number of 

components the system has to evaluate. However, be careful that 

you do not overlook a component that does, in fact, interfere.

� Make sure Dragged part only is selected. This means only 

collisions with the component you are dragging are detected. If 

unchecked, collisions are detected for both the moving component 

and any components that move as a result of mates to the moving 

component.

� If possible, use Ignore complex surfaces.

Note The Dynamic Clearance option can be used to 

display the actual clearance between components as 

they move. A dimension appears between the 

selected components, updating as the minimum 

distance between them changes.

Correcting the 
Interference

Filleting or chamfering the edges of the yokes will eliminate the 

interference.

14 Open part.

In the FeatureManager design tree, right-

click the Yoke_female and select Open 

Part .

Add a 2mm x 45 chamfer to the edges as 

shown. Save the changes.

15 Return to the assembly.

Click Window, UJ_for_INT.SLDASM or use Ctrl+Tab.

When the software detects the change in the part, you will be prompted 

with a message asking if you would like to rebuild the assembly.

Click No in response to the message until all changes have been made.

16 Correct the Yoke_male component. 

Open the Yoke_male using Open Part. Add 
a chamfer the same way as was done in the 

Yoke_female component. 

Save the changes and return to the assembly, 

clicking Yes on the Rebuild Assembly 

message.



SolidWorks 2011 Lesson 13
Using Assemblies

459

17 Check for interference.

Click Move Component. Click these options:

� Collision Detection
� All components
� Stop at collision

Test for interference by turning the crank. No collisions are detected.

18 Turn off the Move Component tool.

Changing the 
Values of 
Dimensions

Changing the value of a dimension in the assembly works exactly the 

same as changing that dimension in a part: double-click the feature and 

then double-click the dimension. SolidWorks uses the same part in the 

assembly or the drawing, so changing it in one place changes it in all.

The feature can be double-clicked from the FeatureManager design tree 

or the screen, but the dimension will always appear on the screen.

19 Edit the crank-arm.

Double-click on the graphics of the crank-
arm part to access its dimensions. These are 

the dimensions used to build the part.

Change the length to 100mm.

20 Edit the crank-shaft.
Change the value of the length to 65mm. 

Notice that not only are the parts rebuilt and 

the assembly updated, the mating 

relationships ensure that the crank-arm 

moves up when the crank-shaft gets taller 
and the crank-knob moves when the 

crank-arm gets longer.

21 Open crank-shaft.
Right-click the crank-shaft and select 
Open Part from the shortcut menu.
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22 Part level changes.

Changing a part at the assembly level changes it at the 

part level and vice-versa. That is because it is the same 

part, not a copy. 

Change the value back to 40mm and close the part, 

saving the changes.

23 Assembly update.

Changes have been made to a reference of the assembly, 

in this case the size of a part. Upon reentering the assembly, 

SolidWorks asks whether you want to rebuild. Click Yes.

24 Change values back.

Select and change the dimension of the crank-arm to 75mm and 

rebuild.

Exploded 
Assemblies

You can make Exploded Views of assemblies automatically or by 

exploding the assembly component by component. The assembly can 

then be toggled between normal and exploded view states. Once 

created, the Exploded View can be edited and also used within a 

drawing. Exploded Views are saved with the active configuration.

Setup for the 
Exploded View

Before adding the Exploded View, there are some setup steps that will 

make the exploded view easier to access. It is good practice to create a 

configuration for storing an Exploded View and also to add a mate that 

holds the assembly in a “starting position”.

1 Open an assembly.

Open the assembly Support_Frame.sldasm located in the 

Exploded_Views folder.

2 Add a new configuration.

Switch to the ConfigurationManager, right-click 

and select Add Configuration.

Type the name Exploded and add the configura-
tion.

The new configuration is the active one.

For more information on Assembly Configurations, see the Assembly 

Modeling training manual.



SolidWorks 2011 Lesson 13
Using Assemblies

461

Introducing:
Exploded View

Exploded View is used to move one or more components along an arm 

of the Move Manipulator  or triad. Each move direction and 

distance is stored as a step.

Where to Find It � From the Insert menu, pick Exploded View....

� Or, click Exploded View  on the Assembly toolbar.

3 Click Insert, Exploded View. 

The Exploded View 

PropertyManager appears. 

Explode Steps allows for 

individual movement of each 

component.

The Settings group box lists the 

components exploded in the 

current step along with direction 

and distance.

The Options group box includes 

the automation Auto-space and 

sub-assembly options.

Exploding a Single 
Component

One or more components can be moved in one or more directions. Each 

movement (one or more components) set by a distance and direction is 

considered one step.

4 Select component.

Use the magnifying glass to select 

the Flat Head Screw component. 

A Move Manipulator appears at the 

selection. The Move Manipulator is 

aligned with the axes of the 

component. 
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5 Drag explode.

Explode the component by dragging 

the green leg away from the assembly 

and using the ruler to set the distance. 

The Explode Step1 feature is added. 
The components are listed beneath it. 

Click off the component to complete 

the step.

Tip Selecting the step by name in the dialog displays the components in 

magenta with the blue arrow.

Move Manipulator If the Move Manipulator axes do not point in the desired directions, its 

orientation can be changed. Right-click the manipulator origin and 

choose Move to selection. Select an edge, axis, face or plane to 

reorient it.

Multiple 
Component 
Explode

Multiple components can be exploded along the same path or multiple 

paths. For multiple component selections, the last component selected 

determines the orientation of the Move Manipulator.

6 Selection.

Select all of the 

side_table_plank_wood 
components as shown. The last 

selection produces the move 

manipulator as shown.

Tip Making a multiple component selection can be made by clicking each 

one or using a drag-select window.
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7 Move multiple.

Move the components along the 

green leg as shown. 

Drag Arrow The Drag Arrow is used as a vector for the explode step. Once created, 

the step distance can be modified by clicking the step in the Explode 

Steps dialog and dragging the blue arrow along the explode line.

Edit Step Right-click a step and choose Edit Step to edit which components are 

used in the step or to set the distance to an exact numeric value. 

8 Adjust step. 

Click Explode Step1 in the 
Explode Steps dialog. Drag the blue 

arrow upwards to adjust the explode 

distance. Right-click the same step 

and choose Edit Step. Set the 

distance to 22in, then click Apply 

and Done. 

9 New steps. 

Select the 

Support_Leg<1> and 
explode it away from the 

center as shown. Do the 

same for the 

Support_Leg<2> in the 
opposite direction. 
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10 Hardware. 

Explode the binding head 
screw_ai <3> and square 
nut_61_ai <3> components 

as shown using separate 

steps. 

Sub-assembly 
Component 
Explode

Sub-assemblies can be treated in several ways. By default they are 

treated as single components and are moved as one. By clicking Select 

sub-assembly’s parts, they are treated as individual components, and 

each can be moved independently. 

Auto-spacing The Auto-space components after drag option is used to spread a 

series of components along a single axial step. The spacing can be set 

with a slider and changed after creation.

Note If an exploded view of a sub-assembly already exists, it can be added to 

the current exploded view by using Reuse Sub-assembly Explode.

11 Sub-assembly components.

Click Select sub-assembly’s parts. 

Select the binding head screw_ai 
<1> component and create a step as 

shown.

Repeat the procedure to create steps 

for the square nut_61_ai <1> and 
Brace_Cross_Bar <1> components. 

12 Complete explode. 
Click OK to complete the explode. Expand 

the ExplView1 folder to display the 
explode steps. 
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Explode Line 
Sketch

Create lines as paths for the exploded view using Explode Lines. A 

type of 3D sketch called an Explode Line Sketch is used to create and 

display the lines. The Explode Line Sketch and Jog Line tools can be 

used to create and modify the lines.

Explode Lines Explode Lines can be added to the explode line sketch to represent the 

explode path of the components.

Explode Line 
Selections

Typical selections, such as vertices, edges and faces, can be made to 

create explode lines. It is important to: 

� Select geometry in the order to define the explode line.

� Select geometry that is appropriate to start, end or pass through 

geometry.

Vertices and edges are typically suited start and end explode lines. 

Faces are typically used to “pass through”. These selections will be 

shown in the following steps. 

Introducing:
Explode Line Sketch

An Explode Line Sketch enables you to semi-automatically create 

explode lines. To do this, you select model geometry such as faces, 

edges, or vertices, and the system generates the explode lines.

Where to Find It � On the Insert menu, click Explode Line Sketch.

� Or, click Explode Line Sketch  on the Assembly toolbar.

13 Route line.

Click Explode Line Sketch  to start the 

3D sketch. Select the vertices as shown to 

create a route line between them. Various 

combinations of the Options can be used to 

get different results. 

Click OK.

14 Start explode line.

Select (in order) the circular edge of the binding 
head screw_ai <1> to start the line. Next, 
select the cylindrical face of the hole in the 

Brace_Cross_Bar <1> component to pass 

through. 

Click the grey arrow at the first selection to set 

the direction.
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15 End explode line.

Select the cylindrical face of the hole in the 

Brace_Corner <1> component to pass 

through. To end the line, select the circular 

edge of the square nut_61_ai <1>. 

Click OK.

16 Adjusting lines. 

Add another explode line as shown. The bend lines 

that are added can be modified by selecting and 

dragging. Double arrowheads appear on movable 

lines when they are selected. 

17 Save. 
Click OK to complete the process of adding 

explode lines. Save the changes. 

More lines can be added if desired.
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Animating 
Exploded Views

The Animation Controller can be used to animate the explode or 

collapse motion. 

Where to Find It � Right-click Animate Collapse from the ExplView1 feature in the 
ConfigurationManager.

� If the exploded view is collapsed, right-click Animate Explode 

from the ExplView1 feature.

Animation 
Controller

The Animation Controller is 

invoked by the Play  button on 

the Simulation toolbar.

Playback Options There are several options for replaying the simulation:

Start Rewind Play

Fast Forward End Pause

Stop Save as AVI Normal

Loop Reciprocate Slow Play

Fast Play

 Progress Bar

18 Animation toolbar.

Right-click on ExplView1 and choose Animate Collapse. The dialog 

uses standard VCR-like controls including  Play. 

19 Save.

Save the assembly after collapsing the exploded view. Do not close the 

assembly. 
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Bill of Materials In an assembly, a bill of materials report can be automatically created 

and edited. It can then be inserted onto the drawing sheet. The finished 

version of the BOM will appear in the assembly and later on the 

drawing sheet. 

Where to Find It � Click Bill of Materials  on the Table toolbar.

� Or from the Insert menu, select Tables, Bill of Materials....

20 BOM Settings. 

Click Insert, Tables, Bill of 

Materials.... 

Select bom-standard as the 
Table Template and Indented 

as the BOM Type. 

Click OK then click in the 

graphics window to place the 

BOM. 

21 BOM feature. 
Expand the Tables folder. The bill 
of materials feature, Bill of 
Materials1 <Exploded>, is stored 
there. 

The Exploded text in braces refer to 
the configuration of the assembly. 
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22 Show table in new window.

Right-click the table Bill of Materials1 <Exploded> and choose 
Show table in new window. Click Window, Tile Horizontally to 

show both windows. 

23 Moving a column. 

Click in the QTY. column and click the header cell D. Drag the column 

header cell to the left, dropping it at the position shown. Click in the 

table and drag vertical or horizontal lines to resize the cells.
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Assembly 
Drawings

Assemblies have several unique requirements when it comes to making 

detail drawings of them. In addition to specialized views, assemblies 

require a Bill of Material and Balloons to fully document the assembly. 

In this example, the Bill of Material table created in the assembly will 

be copied to the drawing. 

1 New drawing.

Use Make Drawing from Part/Assembly  to create a new drawing 

using the A-Scale1to2 template. 

2 Model View.

Drag and drop the *Isometric view from the View Palette. Set the 

Display Style to Shaded with Edges. 

Displaying Exploded 
Views

Views are normally created in their non-exploded state. To display their 

exploded state, the configuration that contains the exploded view must 

be selected with the Show in exploded state option.

Note The Show in exploded state option will be available only if there is an 

existing exploded view in the selected configuration.
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3 Exploded state. 

Right-click the view and click 

Properties. Click Use named 

configuration and select the 

Exploded configuration. 

Click Show in exploded state and click OK. 

Copying a BOM 
Table from the 
Assembly

If a bill of materials table has been created in the assembly, it can be 

copied to the drawing. 

The same option used to create the table is used to copy it. For more 

information, see Bill of Materials on page 468. 
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4 Copy table. 

Click Insert, Tables, Bill of Materials and 

click in the view. Click Copy existing table 

Bill of Materials1, click Linked and click 
OK. 

Move the Bill of Materials to the top left corner 

of the drawing format and click to place it. 

Note For more information about creating and editing Bill of Material tables, 

see the SolidWorks Drawings manual. 
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Adding Balloons The item numbers assigned by the bill of materials can be added to the 

drawing using Balloons. These balloons will assign the proper item 

number as they are inserted onto edges, vertices or faces.

Introducing: 
Balloons

The Balloon command is used to label the components of an assembly 

drawing by item number and optionally quantity. There are several 

different shapes of balloons.

Where to Find It � On the Annotations toolbar, click Balloon .

� Or, on the Insert menu, click Annotations, Balloon....

5 Insert balloons. 

Click on the Balloon tool  and select the 

Circular Split Line style with Item Number 

and Quantity. 

Click on an edge, vertex or face of the geometry 

then click to place the balloon. 

6 Save and close the drawing and any other open files. 
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Exercise 60:
Using Collision 
Detection

Using the assembly 

provided, determine the 

range of motion of the 

clamp handle.

This lab reinforces the 

following skills:

� Checking for 

Interference on 

page 454.

� Introducing: Collision 

Detection on page 457.

Procedure Open an existing assembly.

1 Existing assembly.

Open the existing assembly named Collision from 

the folder Collision.

2 Collision locations.

The link stops the motion of the assembly in two 

places. Move the assembly to the point of collision 

and measure the angle formed using Measure or 

dimensions on a drawing view.

ANGLE “A”- As the handle sub-assy is pulled 
back, the link hits it.

ANGLE “B”- As the handle sub-assy is pushed 
forward, the link hits the hold-down sub-assy.

Measurements: (rounded)

Angle “A” = 38° Angle “B” = 90°
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Exercise 61:
Checking for 
Interferences, 
Collisions and 
Clearances

Using the assembly provided, check for 

interferences, clearances and collisions. 

This lab reinforces the following skills:

� Checking for Interference on page 454.

� Checking for Clearances on page 456.

� Introducing: Collision Detection on page 457.

Procedure Open an existing assembly.

1 Existing assembly. 

Open the existing assembly named A_D_Support from the folder 

Clearances.

2 Static interference.

Check for static interferences using Interference Detection. 

3 Dynamic clearance. 

Drag the Internal sub-assembly. Collisions stop the motion in two 

places. Move the assembly to the point of collision (open) and measure 

the minimum distance between the End and the small collar using the 
Dynamic Clearance option. 

(225mm)

4 Sub-assembly clearances. 

Open the sub-assembly internal and make sure that there are 

clearances between: 

� Components small center_tube and small collar. 
� Components small center_tube and thin_collar. 

(0.13mm and 0.14mm)
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5 Top level assembly clearances. 

Return to the top level assembly A_D_Support and make sure that 

there are clearances between: 

� Components center_tube and small center_tube.
� Components center_tube and small collar.

(3.68mm and 0.10mm)

6 Save and close all files. 
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Exercise 62:
Exploded Views 
and Assembly 
Drawings 

Using the existing assemblies, add exploded views, explode lines and a 

BOM in the assembly. Use the exploded views to generate drawings 

with balloons and copy the BOM from the assembly. Use the A-
Scale1to2 template.

This lab reinforces the following skills:

� Exploded Assemblies on page 460.

� Explode Line Sketch on page 465.

� Assembly Drawings on page 470.

� Bill of Materials on page 468.

The files are found in the Exploded Views folder.

Assembly: 
part configs

Assembly: 
Gearbox 
Assembly
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Exercise 63:
Exploded Views

Using the existing assemblies, add exploded views and explode lines.

This lab reinforces the following skills:

� Exploded Assemblies on page 460.

� Explode Line Sketch on page 465.

Procedure Open an existing assembly.

1 Existing assembly.
Open the existing assembly named Flashlight from the folder 

Flashlight.

Tip Many of the components are 

positioned on an angle and 

require the Triad to be 

dragged and dropped to set 

the proper explode direction. 

The Triad can be dropped 

onto an edge or face.

Your explode line sketch may 

vary significantly based on 

explode distances and 

selected entities.

2 Create Exploded View.

Create exploded view and explode line sketch. 
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Appendix A
Templates

The material in this appendix supplements the material covered in the 

lessons. It was removed from the lessons to keep them of manageable 

length, and included here for your reference.

� Tools, Options settings used in this course.

� Creating a customized document template for parts.

� Organizing your document templates.
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Options 
Settings

The Tools, Options dialog is the means by which default SolidWorks 

settings are changed. It contains settings that apply to individual 

documents and that are saved with those documents, as well as settings 

that apply only to your system and your work environment.

The Tools, Options dialog contains two tabs that are labelled System 

Options and Document Properties. These are tabs within Options to 

make changes to the system or document properties. This enables you 

to control how the settings are applied. Your choices are:

� System Options

Changes to the system options customize your work environment. They 

are not saved with any specific document. Rather, any document 

opened on your system will reflect these settings. For example you 

might want your default spin box increment to be 0.25 inches. I might 

typically work on small parts and want a default spin box increment of 

only 0.0625 inches. System options let us each customize our work 

environment to our own needs.

� Document Properties

Changes will affect only the currently open document. The system’s 

default settings are not changed.

Changing the 
Default Options

To change the default Options, follow this procedure:

1. From the Tools menu, choose Options.

2. Select the tab for the settings you wish to change.

3. When finished, click OK.

Note You can only access document properties when a document is open.

Suggested 
Settings

For a complete listing of all the settings available through the Tools, 

Options dialog refer to the on-line help.

Important System Options that are used in this manual are:

� General

Input dimension value: Enabled.

Maximize document on open: Enabled.

� Sketch

Display plane when shaded: Disabled.

� Default Templates

Always use these default document templates: Enabled.

Document 
Templates

With a Document Template file (*.prtdot, *.asmdot, *.drwdot) you 
can save document properties for use in new documents. You can create 

a new template that contains just the settings that you want. When you 

want to create a new document, select the template you want and the 

document will inherit the template’s settings.
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How to Create a 
Part Template

Creating a customized template is a simple procedure. You open a new 

document using the existing default template. Next you use the Tools, 

Options dialog to modify the document’s settings. Then you save the 

document as a template file. You can set up folders to contain and 

organize your templates.

In this section we will create a customized part template.

1 Open a new part.

Open a part using the default part template. The part will be used to 

form the template and will be discarded afterwards.

2 Choose a template.

Click File, New and the Templates tab of the dialog. Click the 

template Part and OK.

Note Do not use the Novice settings on the dialog when saving a document 

template. The resulting template will not be seen.

3 Properties.

Verify, and if needed, set the following Document Properties:

� Drafting Standard

Overall drafting standard: ANSI.

� Dimensions, Font

Dimension: Century Gothic; Height = 12 points.

� Annotations, Font

Balloons: Century Gothic; Height = 12 points.

Notes: Century Gothic; Height = 12 points.

� Dimensions, Primary precision
Primary dimension, Value: 3.
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� Grid/Snap

Display Grid - Disabled.

� Units

Unit system - MMGS.

� Reference Geometry

The default names for the three system planes are not controlled by 

Tools, Options. They are controlled by the document template. 

Since most feature can be renamed, the planes can be renamed as 

well. When the part is saved as a template, the plane names will be 

saved in the template file. Then, any new parts created using this 

template will automatically inherit the plane names. If you wish to, 

rename the planes. For example, you might prefer XY, XZ, and YZ 
instead of the default names.

4 Save a template.

Click File, Save As....

For Save as type, select Part Templates. 

Name the template mm_part and navigate to the directory where you 
want to store your customized templates. In this example, we will 

simply save the template in the SolidWorks installation directory in the 

folder Data\Templates.

Click Save.
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5 Use the template.

Close the current part without saving it. Open a new part using the 

template mm_part that appears in the dialog under the Templates tab. 

Check to see that the settings have been carried over.

Drawing 
Templates and 
Sheet Formats

Drawing templates and sheet formats have many more options than 

part or assembly templates. A complete treatment of creating and 

customizing drawing templates and sheet formats is covered in the 

course SolidWorks Drawings.

Organizing Your 
Templates

As a general rule, it is not a good idea to store your customized 

templates in the SolidWorks installation directory. The reason for this is 

that when you install a new version of SolidWorks, the installation 

directory is overwritten. This would overwrite your customized 

templates.

A better strategy is to set up a separate directory for templates, just as 

you would for library features and standard parts libraries.

You can control where SolidWorks searches for the templates by means 

of Tools, Options, System Options, File Locations. The Show 

folders for box displays search paths for files of various types, 

including document templates. The folders are searched in the order 

they are listed. You can add new folders, delete existing folders, or 

move folders up or down to change the search order.
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Default Templates Certain operations in SolidWorks automatically create a new part, 

assembly, or drawing document. Some examples are:

� Insert, Mirror Part
� Insert, Component, New Part
� Insert, Component, New Assembly
� Form New Sub-assembly Here
� File, Derive Component Part

In these situations, you have the option of either specifying a template 

to use or having the system use a default template. This option is 

controlled by Tools, Options, System Options, Default Templates.

If you have selected Prompt user to select document template, the 

New SolidWorks Document dialog box will appear and you can 

choose the template you wish to use. If you have selected Always use 

these default document templates, the appropriate file will be 

automatically created using the default template. This section of the 

Tools, Options menu also enables you to define what template files the 

system should use by default.



487

Index

Numerics

3 point
arc slot 33
arcs 33
center rectangles 34
centerpoint straight slot 34
corner rectangles 34

3 point arcs 192
3 point center rectangle 69
3 point corner rectangle 69

A

add
components 407–408, 411
configurations 343
fixture 219
relations 46
restraint 219

align
flip mate alignment 415, 435
mates 414

analysis 217
angle mates 438
angular dimensions 51
animating exploded views 467
annotations 389
balloons 473
center marks 93
centerlines 393
datum feature symbols 390
geometric tolerance symbol 393
in assemblies 409
notes 389
surface finish symbol 391

appearance
color 86
hiding components 430
of dimensions 125
RealView graphics 206
transparency of components 430–

431
virtual sharps 196

appearances 22
arcs
3 point 192
autotransitioning between lines and 

arcs 73
centerpoint 33
dimensioning min/max 193
normal 72

tangent 72, 201
tangent intent zones 72

area fill patterns 167
area, See measure
See also section properties

array, See patterns
arrow key navigation 83
arrows, dimensions 125
assemblies 403–440, 451–473
adding components 407, 411, 423
adding sub-assemblies 433
analyze 453
animating exploded views 467
bottom-up design 404, 452
changing dimensions 459
collision detection 457
configurations 364, 370, 425, 428
copying components 430
creating new 406
dynamic motion 412
explode lines 465
exploded views 460–467
FeatureManager design tree 407
hiding components 430
interference detection 454, 457
make assembly from part/

assembly 406
mating components 413
moving components 412, 419, 425
opening a component 427
reordering objects 410
rollback 410
rotating components 412, 419, 425
showing components 431
transparency of components 431
using part configurations 364, 370, 

425, 428
assembly drawings 470–473
bill of materials 468–472
explode lines 465

assembly motion 412, 419, 425
associativity 8, 98–101
automatic draft 285
automatic fillet fixing 280
automatic filleting 281
automatic relations 8
automatic sketch fixing 313
axes 169
axes, temporary 169, 204, 316

B

balloon callouts 473
bevel, See chamfers
bill of materials 468–472
blends, See fillets
BOM, See bill of materials
boss, definition of 63
 See also features

browser
insert component 364, 411
saving your work 30

C

callouts 79, 473
center marks 93
center rectangle 69
centerlines 119, 192
centerpoint arcs 33
chamfers 205
changing dimensions
appearance 125, 139
in an assembly 459
of a part 99

changing the size of a plane 123
check sketch for feature 270
circles 124
circular patterns 174
clearance detection 458
coincident mates 419
coincident relation 44
collinear relation 45
collision detection 457
color
editing 86
inference lines 36
RealView graphics 206

Command Manager 21
commands, recent 80
components
adding 407, 411, 423
copying 430
hiding 430
instance number 408
mating 413
moving 412, 419, 425
opening 427
placing 413
properties 432
rotating 412, 419, 425
showing 431
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status 408
concentric mates 418
concentric relation 136
ConfigurationManager 344
configurations 342
adding 343
assembly considerations 364, 370, 

425, 428
changing (switching) 346, 360
ConfigurationManager 344
creating 343
editing parts that have 

configurations 365–369
modeling strategies for 364
of parts in assemblies 364, 370, 425, 

428
options 344
performance considerations 363
terminology 342
uses of 363
using in drawings 378

configure feature 359
confirmation corner 32
constraints, See geometric relations
construction geometry 119
contour select tool 319–320
convert entities 252
copy
components in an assembly 430
dimensions 96
feature 143–144
fillets 322

corner rectangle 69
counterbore, See hole wizard
countersink, See hole wizard
crosshatch 210
Ctrl key
copy (Ctrl+C) 143–144
copying dimensions 96
copying fillets 322
for view options 133
paste (Ctrl+V) 143–144
rebuild (Ctrl+B) 99
redraw (Ctrl+R) 99
selecting multiple objects 46, 75
switch documents (Ctrl+Tab) 91, 98
with middle mouse button 132

cursors 24
curve driven patterns 166
custom properties 213
customization 15–18, 26
cut
definition of 63
 See also features

D

dangling
dimensions 278–279
relations 145, 274
repairing 278–279

datum plane, See planes
degrees of freedom 408
delete
features 310

pattern instances 172
relations 43, 145, 316

density 209, 212
design intent 7–8, 40, 63, 117
definitions 8
examples of 9
modeling approaches 9

design library 23, 366
design table 11, 214, 343
detail views 385
detailing 88–101, 378, 470–473
See also drawings

dimensions
angular 51
arrows 125
automatic dimensioning of 

sketches 181
changing their appearance 125, 139
changing their value 99, 459
concentric circles 146
copying 96
dangling 278–279
diameter 193
dimension tool 48
drawings 96
driven 94
driving 7
font 89
hiding 96
linear 49
linking 352, 354
making several equal 352, 354
min/max arc conditions 193
modify tool 49
moving 96
point-to-point 48
preview 48
properties 139
radial 74
reattach 274, 278–279
renaming 354
revolved features 193
smart 48

display options 131
display relations 42, 119
distance mates 437
distance, See measure
document properties 26
document templates 26, 482–486
default 486
how to create 483
organizing 485

draft
analysis 241–243
feature 242
in extruded features 121
neutral plane 242
ways of creating 242

DraftXpert 285
drag and drop
configurations 428
copying dimensions 96
copying fillets 322
moving dimensions 96

reattach dimensions 278
reorder features 311, 321

drag handles, See sketch, dragging
See also drag and drop; dimensions, 

moving
drag ruler 52
Drawing 90
drawing views
alignment 380
break 383
detail 385
model 382
moving 92
projected 387
section 379
View Palette 90
view properties 388

drawings 88–101, 378, 470–473
alignment 380
break view 383
center marks 93
creating a new drawing 89
detail view 385
detail views 385
dimensioning 96
model view 382
projected view 387
section view 379
sheet formats 90
toolbars 89
tools, options 89
View Palette 90

drill, See hole wizard
driven dimensions 94
dynamic assembly motion 412, 419, 

425
dynamic clearance detection 458
dynamic collision detection 457
dynamic mirroring 119

E

edit
assemblies 459
color 86
definition 82, 311
dimension 49, 274, 278, 313, 315
explode view step 463
feature 82, 152, 173, 265, 302, 310
features 82, 311
material 209
sheet 386
sheet format 386
sketch 81, 196, 312
sketch plane 277
undo 15

editing parts 263, 299
ellipse 203
ellipse, partial 33
end conditions
blind 53
mid-plane 121
offset from surface 139
revolved features 195
through all 75
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up to next 126
up to surface 126

entities, sketch 33
equal relation 46
equations 354–358
erase, See delete
errors
highlighting problem areas 279
messages 266
rebuild 265
repairing 265–280
What’s Wrong? 265–269

Esc key 38
explode lines 465
exploded views of assemblies 460–467
extending geometry in a sketch 138
external references 409
extrude
boss 52, 71
cut 75
end conditions 70
thin feature 254
with draft 121

extrusion 63

F

factor of safety 222
feature-based modeling 6
FeatureManager design tree 6–7, 19
arrow key navigation 83
error markers 267
flyout 168
go to 301
hide and show items 19
in assemblies 407
splitting the window 346

features
applied 6
boss 71
chamfer 205
check sketch 270
copy and paste 143–144
cut 75
definition of 63
delete 310
draft 242
editing 82, 311
extrude 52
fillet 63, 78
holes 76–77
library 366
properties 342, 347
renaming 71
reorder 311, 321
revolved 191, 195
ribs 249–253
shell 243
sketched 6
statistics 309
suppress 342, 347
sweep 203
thin 254
unsuppress 342, 347
window 366

FeatureXpert 280
feedback, sketch 37
file
save 30
save as 30
save as copy 30

file explorer 22
file extensions
ASMDOT 482
DRWDOT 482
PRTDOT 482
SLDASM 407
SLDDRW 89
SLDPRT 30

file names 409
file properties 216
creating 214
uses 214

files
open 12
references 10
search 23
training 3

filing, See saving your work
fill patterns 167
fillets 78
constant radius 79
copying 322
definition of 63
edge propagation 81
full round 253
previews 79
rules 78

FilletXpert 281
fixing
components 407
parts 407
See also errors

flip dimension, distance mate 438
flyout FeatureManager design tree 168
flyout toolbar icons 15
font of text 89
full round fillets 253
fully defined sketch 38, 181

G

geometric relations 7–8, 42, 119
add 46
automatic 8, 36
coincident 44
collinear 45
concentric 136
dangling 145, 274
delete 43
display/delete 42, 119, 316
equal 46
examples, table of 44
horizontal 45
merge 44
midpoint 46
parallel 44
perpendicular 44
symmetric 119
tangent 312

vertical 45
geometry pattern 173
geometry, sketch 33
3 point arc 192
centerlines 119
centerpoint arcs 33
circles 124
ellipse, partial 33
lines 35
parabolas 33
parallelograms 69
points 179
polygons 34
rectangles 69
slots 198
splines 33
tangent arcs 72

global variables 357
graphics cards 4
grips, See sketch, dragging
See also drag and drop; dimensions, 

moving

H

heads-up view toolbar 14
hidden items, selecting 140
hidden line removal (HLR) 78, 131
hide
components 430
dimensions 96

hole wizard 76–77
counterbore hole 77
counterbore holes 85

holes
counterbore 77, 85
countersink 85
hole wizard 76
patterns 170
standard 85
tapered 85

hollowing a part, See shelling a part
horizontal relation 45

I

inference lines 36, 77, 201
insert
3D sketch 465
axes 169
boss, sweep 203
component 407, 411, 423
ellipse 203
explode lines 465

instance
copying in an assembly 430
number 408

instant 3D 325
live section plane 328

Instant3D 325
interference detection
dynamic 457
options 455
performance considerations 458
static 454

interrogating a part 301
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interrupt rebuild 308
isometric views, See standard views

K

keyboard shortcuts 15, 38, 40, 91, 98–
99, 133

L

library features 366
linear dimensions 49
linear patterns 170
lines 35
autotransitioning between lines and 

arcs 73
link values 352, 354
live section plane 328

M

magnifying glass 133, 271
make drawing from part 89
mass properties 211, 453
mate groups 410
materials 209
mates
adding 413
advanced 413
alignment 414, 437
coincident 419
concentric 418
definition 410
distance 437
drag and drop 434
entities that can be mated 416
flip mate alignment 415
mate groups 410
parallel 424, 436
pop-up toolbar 418
smart 434
standard 413
sub-assemblies 436
tangent 427
to reference planes 416
use for positioning only 438
width 420

measure 142
See also section properties

menus 14
merge relation 44
metadata 213
middle mouse button 132
midpoint relation 46
mirror
dynamic 119
sketch 119–120

mirror patterns 176
modify
configurations 359
dimensions 49
features 82

motion, assembly 412, 419, 425
mouse buttons 24
move
component 412, 419, 425
dimensions 96

drawing views 92
multibody solids 200

N

neutral plane draft 242
new
assemblies 406
drawings 89
parts 29

normal to view 124

O

object linking and embedding 10
offset sketch entities 135
OLE 10
open component 427
options 25, 89, 482, 484–485
orientation of model 65
origin 32, 65
orthographic views, See standard views
over defined sketch 38

P

pack and go 439
pan view 132
parabolas 33
parallel mates 424
parallel relation 44
parallelograms 69
parameters, See dimensions
parametric modeling 7
parent/child relationships 305, 363
parts
copying in an assembly 430
creating new 29, 69
editing 263, 299
interrogating 301
library 23, 366
repairing errors 265–280
saving 30
template 483
window 366

paste
feature 143–144

patterns 164–182
area fill 167
benefits 164
circular 174
curve driven 166
deleting instances 172
fill 167
geometry pattern 173
linear 170
mirror 176
options 167
pattern seed only 177
sketch driven 178
skipping instances 172
table driven 166
table of 164

performance considerations 363, 458
perimeter circles 124
perpendicular relation 44
perspective views 131

placing components 413
planes 245
creating 245–247
default 65
definition of 63
hide/show 123
mating to in assemblies 416
neutral 242
resizing 123
sketch 72

points 179
polygons 34
preferences, See options
projected views 91
properties
component 432
custom 213
dimension 139
feature 342, 347
file 216
mass 211, 453
material 209, 212
suppress 342, 347

PropertyManager 20

Q

querying a part 301
Quick Tips 18

R

radial dimensions 74
RAM resident 12
RealView Graphics 4
RealView graphics 206
rebuild 99, 197
errors 265
interrupting 308

recent commands 80
recent documents 429
rectangles 69
redo 40
redraw 99
reference plane, See planes
reference triad 32
references 10
refreshing the display 99
regenerate, See rebuild
relations, See geometric relations
relationships, parent/child 305, 363
renaming features 71
reorder 281, 285
features 311, 321
in assemblies 410

repaint, See redraw
repair dangling dimensions 278
resizing a plane 123
resources, SolidWorks 22
reuse of data 143
See also library features

revolved features 191, 195
dimensioning 193
end conditions 195
multiple centerlines 200
sketch rules 192
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ribs 249–253
roll view 132
rollback
in assemblies 410
in parts 83–84
to a feature 308
to a sketch 306

rotate
component 412, 419, 425
view 132, 205

rounds, See fillets
ruler 52

S

save 30
save as 30
save as copy 30
saving
your work 30

scenes 22
scroll view 132
search 23
search path 409
section views 131, 323–324
seed 177
select
box 269
box with Control key 269
box with Shift key 269
cross 269
other 72
selection filters 417
tool 38

select other 140
selecting items
contour selection 319–320
filters 417
hidden items 140
multiple objects 46, 75, 80
pre-selection 13

selection filters 417
shaded view 78, 131
shared sketches 320
sheet formats 90
shelling a part 243
show
component 431
planes 123

SimulationXpress 217
sketch 31
3 point arcs 192
arcs 33, 192
automatic dimensioning 181
autotransitioning between lines and 

arcs 73
centerlines 119
centerpoint arcs 33
check for feature 270
circles 124
conflicts 314
contours 319–320
convert entities 252
create new 31
definition of 63

dragging 40, 43
edit plane 277
editing 81, 312
ellipse 203
ellipse, partial 33
entities 33
explode lines 465
extending geometry 138
feedback 24, 37
geometry 33
indicator 32
inference lines 201
insert 31
introduction 31
lines 35
mechanics of 34
mirror 119–120
offset entities 135
parabolas 33
parallelograms 69
perimeter circles 124
planar face 72
points 179
polygons 34
rectangles 69
relations 42, 119
rules that govern 39, 192
shared sketches 320
slots 198
splines 33
status of 38
symmetry 119
tangent arc intent zones 72
tangent arcs 72
trimming 136
wake-up inferencing 77

sketch driven patterns 178
sketch plane 72
edit 277
how to choose 65

sketch relations 42, 119
SketchXpert 313
slots 198
Smart Mates 434
snap
See inference lines

solid models 7
SolidWorks Xpert tools
DraftXpert 285
FeatureXpert 280
FilletXpert 281
SketchXpert 313

splines 33
standard views
isometric 125
view orientation command 133

state of assembly components 408
statistics, features 309
stress analysis 217
stretch, See sketch, dragging
sub-assemblies 433
suppress feature 309, 342, 347
sweep 203
SWIFT Technology

DraftXpert 285
FeatureXpert 280
FilletXpert 281
SketchXpert 313

symbols
balloons 473
center marks 93

symmetric relation 119
system feedback 24
system options 26
system settings 482

T

table driven patterns 166
tangent
arcs 72, 201
geometric relations 312
intent zones 72
mates 427

tap, See hole wizard
task pane 22, 366
templates
default 486
document 482–486
how to create 483
organizing 485

templates, document 26
temporary axes 169, 316
text
embossed or engraved on a part 229
font 89

thin features 254
thin wall parts, See shelling a part
toolbars 15–18, 89
animation controller 467
arranging 18
flyouts 15
heads-up view toolbar 14
hiding and showing 16
mates 418

tools, options 25, 89, 482, 484–485
transparency 431
triad 32
trim, in a sketch 136

U

under defined sketch 38
undo 40
units
converting units in dialog boxes 438
in assemblies 406

unsuppress features 342, 347
user interface 13–26
callouts 79
cursors 24
feedback 24
keyboard shortcuts 15
menus 14
mouse buttons 24
toolbars 15

V

variables
dependent versus independent 354
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global 357
See also equations; link values

versions, See configurations
vertical relation 45
view
display options 78, 131
exploded 460–467
modify options 131
orientation 65, 133
isometric view 125

normal to 124, 196

pan 132
roll 132
rotate 132, 205
section 323–324
undo 431

views, drawing
detail 385
moving 92
projected 91

virtual sharps 196

W

wake-up inferencing 77
What’s Wrong? functionality 265–269
width mates 420
window
task pane 22, 366
types 13

Windows Desktop Search 23
wireframe view 78, 131
work plane, See planes

Z

zipping files 439
zoom 131




